RealView® Developer Suite
Version 2.1

AXD and armsd Debuggers Guide
RealView Developer Suite
AXD and armsd Debuggers Guide

Copyright © 1999-2004 ARM Limited. All rights reserved.

Release Information

The following changes have been made to this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Issue</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 1999</td>
<td>ARM DUI 0066A</td>
<td>ADS 1.0 Release</td>
</tr>
<tr>
<td>March 2000</td>
<td>ARM DUI 0066B</td>
<td>ADS 1.0.1 Release</td>
</tr>
<tr>
<td>November 2000</td>
<td>ARM DUI 0066C</td>
<td>ADS 1.1 Release</td>
</tr>
<tr>
<td>November 2001</td>
<td>ARM DUI 0066D</td>
<td>ADS 1.2 Release</td>
</tr>
<tr>
<td>January 2004</td>
<td>ARM DUI 0066E</td>
<td>RVDS 2.1 Release</td>
</tr>
</tbody>
</table>

Proprietary Notice

Words and logos marked with ® or ™ are registered trademarks or trademarks owned by ARM Limited. Other brands and names mentioned herein may be the trademarks of their respective owners.

Neither the whole nor any part of the information contained in, or the product described in, this document may be adapted or reproduced in any material form except with the prior written permission of the copyright holder.

The product described in this document is subject to continuous developments and improvements. All particulars of the product and its use contained in this document are given by ARM in good faith. However, all warranties implied or expressed, including but not limited to implied warranties of merchantability, or fitness for purpose, are excluded.

This document is intended only to assist the reader in the use of the product. ARM Limited shall not be liable for any loss or damage arising from the use of any information in this document, or any error or omission in such information, or any incorrect use of the product.

Confidentiality Status

This document is Open Access. This document has no restriction on distribution.

Product Status

The information in this document is final, that is for a developed product.

Web Address

http://www.arm.com
Contents
RealView Developer Suite AXD and armsd Debuggers Guide

Preface
About this book ................................................................. viii
Feedback .............................................................................. xii

Part A  AXD

Chapter 1  About AXD
1.1 Debugger concepts .......................................................... 1-2
1.2 Interfacing with targets ....................................................... 1-5
1.3 Debugging systems ............................................................ 1-8
1.4 Online help ...................................................................... 1-10

Chapter 2  Getting Started in AXD
2.1 License-managed software .................................................... 2-2
2.2 Starting and closing AXD .................................................... 2-3
2.3 Debugger target ................................................................. 2-6
2.4 AXD displays .................................................................... 2-9
2.5 AXD menus ...................................................................... 2-12
2.6 Tool icons, status bar, keys, and commands ........................ 2-14
## Contents

### Chapter 3 Working with AXD

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Running a demonstration program</td>
<td>3-2</td>
</tr>
<tr>
<td>3.2 Setting a breakpoint</td>
<td>3-4</td>
</tr>
<tr>
<td>3.3 Setting a watchpoint</td>
<td>3-6</td>
</tr>
<tr>
<td>3.4 Examining the contents of variables</td>
<td>3-8</td>
</tr>
<tr>
<td>3.5 Examining the contents of registers</td>
<td>3-12</td>
</tr>
<tr>
<td>3.6 Examining the contents of memory</td>
<td>3-14</td>
</tr>
<tr>
<td>3.7 Locating and changing memory values and verifying changes</td>
<td>3-16</td>
</tr>
</tbody>
</table>

### Chapter 4 AXD Facilities

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1 Stopping and stepping</td>
<td>4-2</td>
</tr>
<tr>
<td>4.2 Expressions</td>
<td>4-4</td>
</tr>
<tr>
<td>4.3 Viewing and editing</td>
<td>4-6</td>
</tr>
<tr>
<td>4.4 Entering addresses</td>
<td>4-12</td>
</tr>
<tr>
<td>4.5 Persistence</td>
<td>4-13</td>
</tr>
<tr>
<td>4.6 RealMonitor support</td>
<td>4-14</td>
</tr>
<tr>
<td>4.7 Data formatting</td>
<td>4-16</td>
</tr>
<tr>
<td>4.8 Profiling</td>
<td>4-27</td>
</tr>
</tbody>
</table>

### Chapter 5 AXD Desktop

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Menus, toolbars, and status bar</td>
<td>5-2</td>
</tr>
<tr>
<td>5.2 File menu</td>
<td>5-6</td>
</tr>
<tr>
<td>5.3 Search menu</td>
<td>5-16</td>
</tr>
<tr>
<td>5.4 Processor Views menu</td>
<td>5-18</td>
</tr>
<tr>
<td>5.5 System Views menu</td>
<td>5-48</td>
</tr>
<tr>
<td>5.6 Execute menu</td>
<td>5-75</td>
</tr>
<tr>
<td>5.7 Options menu</td>
<td>5-79</td>
</tr>
<tr>
<td>5.8 Window menu</td>
<td>5-98</td>
</tr>
<tr>
<td>5.9 Help menu</td>
<td>5-101</td>
</tr>
</tbody>
</table>

### Chapter 6 AXD Command-line Interface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Command Line Window</td>
<td>6-2</td>
</tr>
<tr>
<td>6.2 Parameters and prefixes</td>
<td>6-4</td>
</tr>
<tr>
<td>6.3 Commands with list support</td>
<td>6-5</td>
</tr>
<tr>
<td>6.4 Predefined command parameters</td>
<td>6-6</td>
</tr>
<tr>
<td>6.5 Definitions</td>
<td>6-9</td>
</tr>
<tr>
<td>6.6 Commands</td>
<td>6-13</td>
</tr>
</tbody>
</table>

### Part B armsd

#### Chapter 7 About armsd

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1 About armsd</td>
<td>7-2</td>
</tr>
<tr>
<td>7.2 Command syntax</td>
<td>7-3</td>
</tr>
</tbody>
</table>
Preface

This preface introduces the ARM eXtended Debugger (AXD) and the Arm Symbolic Debugger (armsd) and their documentation. It contains the following sections:

- *About this book* on page viii
- *Feedback* on page xii.
About this book

This book consists of two parts:

- Part A describes the graphical user interface components of AXD. Tutorial information is included to demonstrate the main features of AXD. If AXD is the only debugger you use, you can ignore Part B, but you might have to see the Appendixes, Glossary, and Index at the end of the book.
- Part B describes armsd.

Intended audience

This book is written for developers who are using AXD or armsd under Windows and Unix platforms. It assumes that you are an experienced software developer, and that you are familiar with the ARM development tools as described in the RealView Developer Suite Getting Started Guide (see ARM publications on page x).

Using this book

This book is organized into the following parts and chapters:

PART A

Chapter 1 About AXD

Chapter 1 explains some of the concepts of debugging and the terminology used. It also describes AXD and armsd, and how this book is complemented by online help.

Chapter 2 Getting Started in AXD

Chapter 2 explains how to set up a debugger target, and gives an overview of the AXD desktop.

Chapter 3 Working with AXD

Chapter 3 provides some examples with step-by-step instructions to demonstrate typical debugging sessions.

Chapter 4 AXD Facilities

Chapter 4 starts with an overview of the debugging facilities that you must have, and how they are provided by AXD. This is followed by information about expressions, viewing and editing data, and profiling.

Chapter 5 AXD Desktop

Chapter 5 describes the menus, views, dialogs, and tool and status bars provided by the AXD desktop.
Chapter 6 AXD Command-line Interface
Chapter 6 describes command-line operation of AXD.

PART B Part B covers the use of armsd.

Chapter 7 About armsd
Chapter 7 introduces armsd. This is an interactive, command-line debugger that provides source-level debugging for C and C++, and low-level support for ARM assembly language.

Chapter 8 Getting Started in armsd
Chapter 8 explains how to set up and start using armsd, and describes some necessary debugging concepts.

Chapter 9 Working with armsd
Chapter 9 provides detailed descriptions of the features of armsd, and instructions for their use.

Appendix A AXD and armsd Commands
Appendix A lists and compares all the commands available in both the armsd and AXD debugger.

Appendix B Coprocessor Registers
Appendix B describes the various available coprocessor registers.

Appendix C Supplementary Display Module Formats
Appendix C describes how supplementary display formats can be defined in files that can be read by AXD.

Appendix D Using the Flash Downloader
Appendix D describes how the Flash downloader can be used to write a binary file to the Flash memory on an ARM Integrator™ board, or an ARM Development (PID) board.

Glossary An alphabetically arranged glossary defines the special terms used.

Typographical conventions
The following typographical conventions are used in this book:

italic Highlights important notes, introduces special terminology, denotes internal cross-references, and citations.
Further reading

This section lists publications from ARM Limited that provide additional information on developing code for the ARM family of processors.

ARM periodically provides updates and corrections to its documentation. See http://www.arm.com for current information.

See also the ARM Frequently Asked Questions list at http://www.arm.com.

ARM publications

This book contains information specific to AXD and armsd. The RealView® Developer Suite documentation describes other components of RealView Developer Suite in the following books:

• RealView Developer Suite Getting Started Guide (ARM DUI 0255)
• RealView Compilation Tools v2.1 Essentials Guide (ARM DUI 0202)
• RealView Compilation Tools v2.1 Developer Guide (ARM DUI 0203).
• RealView Compilation Tools v2.1 Assembler Guide (ARM DUI 0204)
• RealView Compilation Tools v2.1 Compiler and Libraries Guide (ARM DUI 0205)
• RealView Compilation Tools v2.1 Linker and Utilities Guide (ARM DUI 0206)

The following additional documentation is provided with the RealView Developer Suite:

• ARM ELF specification (SWS ESPC 0003). This is supplied in PDF format in install_directory\PDF\specs\ARMELF.pdf.
• *TIS DWARF 2 specification*. This is supplied in PDF format in \texttt{install\_directory\PDF\specs\TIS-DWARF2.pdf}.

• *ARM/Thumb® Procedure Call Standard (ATPCS) Specification (SWS ESPC 0002)*. This is supplied in PDF format in \texttt{install\_directory\PDF\specs\ATPCS.pdf}.

In addition, see the following for specific information relating to ARM products:

• *ARM Reference Peripherals Specification* (ARM DDI 0062)

• *ARM Trace Debug Tools User Guide* (ARM DUI 0118)

• *ARM Multi-ICE Version 2.2 User Guide* (ARM DUI 0048)

• *ARM Agilent Debug Interface Version 1.0 User Guide* (ARM DUI 0158)

• the ARM datasheet or technical reference manual for your hardware device.

**Third party products**

More information on Agilent emulators and similar products is available from Agilent at \url{http://www.agilent.com}.
Feedback

ARM Limited welcomes feedback on both the RealView Developer Suite, and its documentation.

Feedback on the RealView Developer Suite

If you have any problems with the Realview Developer Suite, contact your supplier. To help us provide a rapid and useful response, please give:

- details of the release you are using
- details of the platform you are running on, such as the hardware platform, operating system type, and version
- a small stand-alone sample of code that reproduces the problem
- a clear explanation of what you expected to happen, and what actually happened
- the commands you used, including any command-line options
- sample output illustrating the problem
- the version string of the tool, including the version number and date.

Feedback on this book

If you have any problems with this book, send email to errata@arm.com giving:

- the document title
- the document number
- the page number(s) to which your comments apply
- a concise explanation of your comments.

General suggestions for additions and improvements are also welcome.
Part A
AXD
Chapter 1
About AXD

This chapter explains some of the concepts of debugging and the terminology used. It also describes the ARM eXtended Debugger (AXD) and the ARM Symbolic Debugger (armsd), and how this book is complemented by online help. It contains the following sections:

- Debugger concepts on page 1-2
- Interfacing with targets on page 1-5
- Debugging systems on page 1-8
- Online help on page 1-10.
1.1 Debugger concepts

This section introduces some of the concepts involved in debugging program images.

1.1.1 Debugger

A debugger is software that enables you to make use of a debug agent to examine and control the execution of software running on a debug target. This part of the book covers AXD, the *ARM eXtended Debugger*. The second part of this book covers armad, the *ARM Symbolic Debugger*.

1.1.2 Debug target

At an early stage of product development there might be no hardware. The expected behavior of the product is simulated by software. Even though you might run this software on the same computer as the debugger, it is useful to think of the target as a separate piece of hardware.

Alternatively, you can build a prototype product on a printed circuit board, including one or more processors on which you run and debug software.

You build the finished product only when you are satisfied with the performance, proved by hardware or software simulation.

The debugger issues instructions that can:

* load software into memory on the target
* start and stop execution of that software
* display the contents of memory, registers, and variables
* enable you to change stored values.

The form of the target is immaterial to the debugger as long as the target obeys these instructions in exactly the same way as the final product.

1.1.3 Debug agent

A debug agent performs the actions requested by the debugger, for example:

* setting breakpoints
* reading from memory
* writing to memory.

The debug agent is *not* the program being debugged, or the debugger itself.

Examples of debug agents include:

* Multi-ICE®
Multi-ICE is a separate product. It is not supplied with RealView Developer Suite.

1.1.4 Remote debug interface

The Remote Debug Interface (RDI) is an ARM standard procedural interface between a debugger and the debug agent (see Figure 1-1 on page 1-6).

RDI gives the debugger a uniform way to communicate with:

- a debug agent running on the host (for example, RealView ARMulator ISS)
- a debug monitor running on ARM-based hardware accessed through a communication link (for example, Angel)
- a debug agent controlling an ARM processor through hardware debug support (for example, Multi-ICE).

1.1.5 Single-processor hardware

In many cases, the target has only a single processor. All ARM debuggers can operate successfully on single-processor targets.

1.1.6 Multi-processor hardware

There is a growing requirement for multi-processor hardware:

- certain processors might be dedicated to particular tasks
- parallel processing might be appropriate and beneficial.

In these cases the debugger must enable you to examine and control the processes happening simultaneously in a number of processors. AXD does not fully support multi-core and mixed-processor debugging. You can connect AXD to multiprocessor hardware, but you can only connect one instance of AXD to each processor. However, you can connect multiple instances of AXD to multiple processors.

1.1.7 Contexts

Each processor in the target can have a process currently in execution. Each process uses values stored in variables, registers, and other memory locations. These values can change during the execution of the process.
The *context* of a process describes its current state, as defined principally by the call stack that lists all the currently active calls. When a function is called, and again when control is returned, the context changes.

Because variables can have class, local, or global scope, the context determines which variables are currently accessible.

Every process has its own context. When execution of a process stops, you can examine and change values in its current context.

### 1.1.8 Scope

The scope of a variable is determined by the point within a program at which it is defined. Variables can have values that are relevant within:

- a specific class only (*class*)
- a specific function only (*local*)
- a specific file only (*static global*)
- the entire process (*global*).
1.2 Interfacing with targets

AXD enables you to run and debug your ARM-targeted image using any of the debugging systems described in Debugging systems on page 1-8.

See the documentation supplied with your target board for specific information on setting up your system to work with the RealView Developer Suite components.

Most of this part of the book applies to both the Windows and the UNIX version of AXD. The term AXD refers to either version. If a section applies to one version only, this is indicated in the text or in the section heading.
1.2.1 Debugging an ARM application

AXD works in conjunction with either a hardware or a software target system, as shown in Figure 1-1.

![Figure 1-1 Debugger-target interface](image)

An ARM development board, communicating through Multi-ICE, or Angel, is an example of a hardware target system. RealView ARMulator ISS is an example of a software target system.

You debug your application using a number of windows giving you various views on the application you are debugging.

To debug your application you must choose:

- a debugging system, that can be either:
  - hardware-based on an ARM core
  - software that simulates an ARM core.
- a debugger, such as AXD, or armsd.

Figure 1-2 on page 1-7 shows a typical debugging arrangement of hardware and software.
Figure 1-2 A typical debugging set-up
1.3 Debugging systems

The following are debugging systems for applications developed to run on ARM cores:

- RealView ARMulator ISS
- Multi-ICE®
- Angel debug monitor on page 1-9
- ARM Agilent Debug Interface on page 1-9.

See Configure Target... on page 5-86 for information about the configuration of debugger target systems.

1.3.1 RealView ARMulator ISS

RealView ARMulator ISS is a collection of programs that simulate the instruction sets and architecture of various ARM processors. RealView ARMulator ISS:

- provides an environment for the development of ARM-targeted software on the supported host systems
- enables benchmarking of ARM-targeted software.

RealView ARMulator ISS is instruction-accurate, meaning that it models the instruction set without regard to the precise timing characteristics of the processor. It can report the number of cycles the hardware would take. See the RealView ARMulator ISS v1.4 User Guide for more information.

1.3.2 Multi-ICE®

Multi-ICE is a JTAG-based debugging system for ARM processors. It provides the interface between a debugger and an ARM core embedded within an Application Specific Integrated Circuit (ASIC).

Multi-ICE gives:

- real-time address-dependent and data-dependent breakpoints
- single stepping
- full access to, and control of the ARM core
- full access to the ASIC system
- full memory access (read and write)
- full I/O system access (read and write).

Multi-ICE can debug applications running in either ARM state or Thumb state on target hardware. See the Multi-ICE documentation for detailed information.
Multi-ICE and EmbeddedICE also enables the embedded microprocessor to access services of the host system, such as screen display, keyboard input, and disk drive storage, using semihosting.

1.3.3 Angel debug monitor

Angel is a debug monitor that enables rapid development and debugging of applications running on ARM-based hardware. Angel can debug applications running in either ARM state or Thumb state on target hardware. It runs alongside the application being debugged on the target platform.

Angel also enables the embedded microprocessor to access services of the host system, such as screen display, keyboard input, and disk drive storage, using semihosting.

You can use Angel to debug an application on an ARM Development Board or on your own custom hardware. See the RealView ARMulator ISS v1.4 User Guide for more information.

1.3.4 ARM Agilent Debug Interface

ARM Agilent Debug Interface (ARM ADI) is an extension to RealView Developer Suite, and enables AXD to communicate with an Agilent emulation probe or emulation module for debugging applications running on ARM cores.

The Agilent emulation probe is a standalone emulator whereas the emulation module is installed as part of an Agilent logic analyzer such as one of the 16700 series. However, both probe and module connect to a JTAG debug port on the target system through a Target Interface Module (TIM).

The emulator provides a variety of debug facilities such as run control and access to both memory and to CPU and coprocessor registers. AXD accesses these facilities across an Ethernet connection. More information on Agilent emulators and similar products is available from Agilent at http://www.agilent.com.

Note

For the ARM7 and ARM9 cores, you must use the Agilent E3459A emulation probe (or 16610A emulation module) and Agilent E3459-66501 TIM.

For technical information and support of the emulator, contact Agilent or one of its authorized agents.
1.4 Online help

Online help complements the information contained in this guide.

Information about the ARM debuggers appears in this book and online with the following differences:

- this book concentrates on overall concepts, tutorial material, and descriptions of facilities
- online help complements the information provided in this book, and provides finer details relating to such topics as individual data entry fields, check boxes, and buttons.

When you are running AXD, use online help to obtain information about your current situation. You can also navigate your way to any other pages of available online help.

1.4.1 Displaying online help

You can display online help in any of the following ways:

F1 key Press the F1 key on your keyboard to display online help on the currently active window.

Help button Many windows contain a Help button that you can click to display help relevant to that window.

Help menu The Help menu is shown in Figure 1-3.

![Figure 1-3 Help menu]

It contains the following options:

- Select Contents to display the first page of AXD online help. You can navigate from there to any available topic.
- Select Using Help to display a guide to the use of online help.
- Select Online Books to start running browser software that enables you to display online copies of the printed manuals that you received with AXD.
- Select About AXD... to display details of the version of AXD that you are running.
Query tools

Click on the Query tool in the Help toolbar as an alternative to selecting Contents from the Help menu.

Click on the Query and arrow tool in the Help toolbar to change the mouse pointer into a query and arrow, then click again on any item on the screen for which you want help.

Dialog help

Dialogs within AXD include a Query tool that you can use to display field level help. Clicking on this button changes the mouse pointer into a Query and arrow pointer which you can then click on any item for which you want help. You can also display a help pop-up box by placing the mouse pointer over an item and pressing F1.

Hypertext links

Most pages of online help include highlighted text that you click on to display related online help:

- highlighted plain text displays a pop-up box
- highlighted underscored text causes a jump to another page of help.

Related topics button

Many pages of online help include a Related topics button that you can click to display a new window containing links to related online help.

Browse buttons

Most pages of online help include a pair of browse buttons enabling you to display a sequence of related help pages.
Chapter 2
Getting Started in AXD

This chapter describes how to start running the ARM eXtended Debugger (AXD), set up your debugger target, and operate the AXD desktop. It contains the following sections:

- License-managed software on page 2-2
- Starting and closing AXD on page 2-3
- Debugger target on page 2-6
- AXD displays on page 2-9
- AXD menus on page 2-12
- Tool icons, status bar, keys, and commands on page 2-14.
2.1 License-managed software

Some software is locked, preventing you from running it, until you have been granted a license to use it. If you require a license you can obtain it quickly by applying for it by email.

You can use some license-managed software with a temporary license which places a time limit on your use of the software.

Details of license-managed software, how licensing works, and how to apply for a license are explained in the RealView Developer Suite Getting Started Guide.
2.2 Starting and closing AXD

This section describes:

- Starting AXD
- AXD arguments
- Closing AXD on page 2-5.

2.2.1 Starting AXD

Start AXD in any of the following ways:

- If you are running Windows, select Start → Programs → ARM → RealView Developer Suite v2.1 → AXD Debugger v1.3.
- launch AXD from MS-DOS or from a Command Prompt window, optionally with arguments (see AXD arguments)
- create a shortcut, optionally with arguments.

2.2.2 AXD arguments

The syntax for the command-line method of starting AXD is as follows (any arguments must be in lowercase):

```
```

where:

- `-logo` Displays the splash screen and is the default setting.
- `-nologo` Suppresses the display of the splash screen.
- `-session session_file_name` Specifies a file in which an earlier debug session was saved. You must give the full pathname to the required file and, if the filename includes spaces, you must enclose it in quotes. The earlier session is restored to the state it was in when it was saved. Any images in the session file are loaded, and connection to the target is established.
- `-debug` Loads the image and sets a breakpoint on main(). It does not take an argument. Use this after one or more of the following:
  - default session loaded
  - session explicitly loaded from command line using `-session`
  - image explicitly loaded from command line.
- `-exec` Starts execution of the loaded image with the entry point. It does not take an argument. Use this after one or more of the following:
  - default session loaded
Getting Started in AXD

- session explicitly loaded from command line using -session
- image explicitly loaded from command line.

-sql script script_name

Obey the commands in file script_name. This is the equivalent of typing obey script_name in the CLI system view as soon as the debugger starts up. Use this after one or more of the following:

- default session loaded
- session explicitly loaded from command line using -session
- image explicitly loaded from command line.

-halt

Connects AXD to the target and stops execution of the target.

-nohalt

Connects AXD to the target without stopping execution of the target. This is possible only with targets that support RealMonitor. If connection of AXD might stop execution of the target, then the attempt to connect is abandoned.

-attach

Connects AXD to the target. Execution of the target is not stopped if the target supports RealMonitor. Execution of other targets stops when the connection is made.

-restore_default

Starts AXD without reference to the default session file. AXD starts with default windows displayed in a default layout.

-clear_registry

Starts AXD without reference to the default session file. AXD starts with default windows displayed in a default layout. In addition, all existing target configuration information is deleted. The registry is cleared, but any automatically-detectable targets are re-detected and reappear in the registry.

-help

Displays text describing how to use the AXD command.

image_name

Specifies a file containing an image to be loaded. You must place this name, followed by any required parameters, at the end of the command, because the remainder of the command passes to the image, not to AXD.

parm1, parm2, ...

Any parameters required by image_name.

Examples

To restore a debug session saved in file friday.ses, type:

axd -session friday.ses

To launch AXD and load img01.axf with arguments 10, 3.14159, and ABC, type:

axd img01.axf 10 3.14159 'ABC'
2.2.3 Closing AXD

Close down AXD in any of the following ways:

- Select **Exit** from the **File** menu.
- Click the **X** button at the far right of the AXD title bar (not available in UNIX).
- Press **ALT-F4**.
- Double-click on the icon in the top left corner of the main window.
2.3 Debugger target

This section explains how to set up the target hardware, or simulator, which runs the software to be debugged, using:

- RealView ARMulator ISS
- Multi-ICE unit and target board on page 2-7
- Angel or EmbeddedICE on page 2-7.

The first time you run AXD, RealView® ARMulator® ISS is selected by default as the target, with default settings taken from a configuration file in the RealView ARMulator ISS install directory. Subsequently, AXD starts up with the last used target configuration by default. You can modify this behavior by starting AXD with arguments (see AXD arguments on page 2-3).

Note
In some of these procedures you use a browse dialog to locate and select a required file such as armulate.dll. Some files, including DLLs, are not listed by default, and you might have to configure Windows Explorer to view them.

2.3.1 RealView ARMulator ISS

To start a RealView ARMulator ISS debugging session:

1. Select Configure Target... from the AXD Options menu. You are prompted to choose a target, in a dialog similar to that shown in Figure 2-1.

![Figure 2-1 Selecting a target](image)

2. Select the ARMUL target. If ARMUL is not in the list of available target environments, click Add, locate and select armulate.dll, click Open, and ARMUL is added to the list and selected.
3. Click the **Configure** button to examine or change the RealView ARMulator ISS configuration settings. The resulting dialog is described in *Configure Target...* on page 5-86.

4. Click **OK** when you have selected ARMUL as the target, and configured it if necessary. You can now load an image onto the target and control its execution.

### 2.3.2 Multi-ICE unit and target board

To set up a hardware target of this kind for the first time, see the *ARM Multi-ICE User Guide*. When the hardware is correctly connected and configured, start a debugging session as follows:

1. Connect Multi-ICE to your target board with the JTAG connector. Switch on the power supply to your target board (for example, an ARM Integrator board). Multi-ICE is usually configured to get its power from the target board.
2. Run the Multi-ICE server software on the computer that has the Multi-ICE hardware unit connected to its parallel port.
3. Select **Auto-configure** from the **File** menu, and check that the software detects the processors that you expect to find on the target board.
4. Select **Configure Target...** from the **Options** menu. You are prompted to choose a target, in a dialog similar to that shown in Figure 2-1 on page 2-6.
5. In the **Choose Target** dialog select **Multi-ICE**. If Multi-ICE is not yet in the list of available target environments, click **Add**, locate and select **Multi-ICE.dll**, click **Open**, and Multi-ICE is added to the list and selected.
6. If this is the first time you have used this target, or the target configuration has changed since your last debugging session, click the **Configure** button. The resulting dialog is described in *Configure Target...* on page 5-86.
7. When you have selected Multi-ICE as the target, and configured it if necessary, click **OK**. You can now load an image onto the target and control its execution.

The debugger internal variable `$top_of_memory` has a default value of 0x80000. This is the required value when you are using an ARM Development (PID) board as the target. An ARM Integrator target requires `$top_of_memory` to have a value of 0x40000. Other targets might require different values. To change the value of `$top_of_memory`, see *Debugger Internals system view* on page 5-68.

### 2.3.3 Angel or EmbeddedICE

To start an Angel or EmbeddedICE debugging session:

1. Ensure your target board (for example, an ARM Integrator board) is correctly configured and connected to your computer, then switch on its power supply.
2. Select **Configure Target...** from the **Options** menu in AXD. You are prompted to choose a target, in a dialog similar to that shown in Figure 2-1 on page 2-6.
3. Select the Angel Debug Protocol (ADP) target. If ADP is not yet in the list of available target environments, click **Add**, locate and select `remote_a.dll` click **Open**, and ADP is added to the list and selected.

4. Click the **Configure** button if this is the first time you have used this target, or the target configuration has changed since your last debugging session. The resulting dialog is described in Configure Target... on page 5-86.

5. Click **OK** when you have selected ADP as the target, and configured it if necessary. You can now load an image onto the target and control its execution.
2.4 AXD displays

This section describes the various kinds of displays that you see when using AXD:

- Views
- Viewing structured data
- Multiple Document Interface on page 2-10
- Docked and floating windows on page 2-10
- Tabbed pages on page 2-10
- Dialogs on page 2-11.

2.4.1 Views

Various views enable you to examine and control the processes you are debugging.

In the main menu bar, two menus contain items that display views:

- The items in the Processor Views menu display views that apply to the current processor only, and are described in Processor Views menu on page 5-18.
- The items in the System Views menu display views that apply to the entire, possibly multiprocessor, target system and are described in System Views menu on page 5-48.

2.4.2 Viewing structured data

In Registers, Variables, and Watch views, you often see data displayed in a tree structure that you can expand or collapse. Generally, values that have changed since the previous break in execution are colored red, but that is not possible in the following situations:

- You might collapse a branch of displayed data in a Registers view, continue execution for one or more steps, and then expand the branch again. In this case the values displayed in red are those that have changed since the last time they were displayed, not since the previous break in execution. Also any value that changed and returned to its original value is not colored red.
- You might collapse a branch of displayed data in a Variables or Watch view, continue execution for one or more steps, and then expand the branch again. The old values are discarded if execution takes place with a collapsed branch, and recalculated when you later expand the display. In this case, therefore, it is impossible to know which values have changed, so no red coloring is possible.

If you try to expand a branch that has no elements, the string (Empty) is displayed.
The expansion dialog imposes limits. Any single expansion is restricted to a maximum of 4000 elements, and you normally request far fewer than that. The total number of elements supported in a single view is 32,000.

2.4.3 Multiple Document Interface

AXD uses the Windows Multiple Document Interface (MDI) so that you can display several windows at the same time. This enables you to view a wide range of information at the same time, such as registers, variables, and execution context. You can arrange the debugger windows in different ways so that, for example, some are docked, some are free-floating, and the remainder are cascaded or tiled.

2.4.4 Docked and floating windows

Source and disassembly views appear as floating windows, but most views that you display appear first as docked windows. Right-click anywhere within a window to display its pop-up menu. The pop-up menu of every view that you can dock has an Allow docking item. This is initially checked showing that it is selected.

A docked window is attached to one edge of the main window, with a width and height dependent on any other docked windows that are sharing the same screen edge.

If you click the Allow docking item of the pop-up menu so that it is unchecked, the window floats. Another pop-up menu item, Float within main window, enables you to specify whether a floating window is restricted to the main window or can float anywhere on the screen.

Windows that are floating within the main window are the only ones that you can reposition and resize by selecting Cascade or Tile from the Window menu.

2.4.5 Tabbed pages

Several AXD dialogs and property sheets use tabbed pages. These enable displays that contain a large number of data entry fields, control buttons, check boxes, and radio buttons to be presented in parts.

Although you view only one page at a time, the tabs of all the pages are visible. Click on any tab to bring its page to the front of the display. You can switch between tabbed pages as often as you like while making settings or entering data.

You can consider all the tabbed pages in a display to be parts of a single large display.

Any changes you make become effective only when you click the OK button or the Apply button. Click the Cancel button (or its equivalent) to abandon any changes made on all tabbed pages in the display.
2.4.6 Dialogs

AXD uses dialogs frequently. A dialog is a convenient way of grouping together a number of fields, lists, check boxes, and buttons, enabling you to make changes to several related fields or values at the same time.

When you select a menu item that operates in this way, a suitable dialog appears. Enter values, select from lists, select and deselect check boxes until you are satisfied with all the settings. The new settings become effective only when you click the OK button or the Apply button. You can click the Cancel button (or its equivalent) to abandon any changes you have made and leave all settings unchanged. The dialog disappears automatically when you finish using it.

The AXD dialogs are shown and described in Chapter 5 AXD Desktop.
2.5 AXD menus

To invoke the main features of AXD, you select menu items in one of the following ways:

- use the mouse to pull down a menu from the main menu bar near the top of the screen and highlight the required item, then click to select the item
- press the Alt key, use the arrow keys to select the required menu and highlight the required item, then press the Return or Enter key to select the item
- hold down the Alt key while you press the key of the underlined character in the required menu name, then press the key of the underlined character of the required item to select it.

Other menus are the pop-up menus associated with each view, as described in *Pop-up menus* on page 2-13.

2.5.1 Menu bar menus

The menus available from the menu bar are:

**File**
Enables you to transfer data between the target system and disk files, or to exit from AXD.

**Search**
Enables you to search for a specified character string, either in the memory of a process or in a specified disk file.

**Processor Views**
Enables you to select a view to open on the currently selected processor.

**System Views**
Enables you to select a system-wide view to open.

**Execute**
Enables you to control execution of a program image, or to set or toggle watchpoints, or to toggle or delete all breakpoints.

**Options**
Enables you to:
- set the disassembly mode
- configure the debugger user interface, target system, and processor properties
- maintain a list of directories that are searched to find source files
- enable or disable the display of the status bar
- enable or disable the collection of profiling information.

**Window**
Enables you to control how MDI windows and icons are displayed, and to set refresh options.

**Help**
Enables you to display online help on the use of AXD, or identify the version of AXD that you are running.
Each of these main menus is described in detail in Chapter 5 AXD Desktop.

2.5.2 Pop-up menus

In addition to the menus listed in the main menu bar, each view has one or more pop-up context menus offering additional items.

You generally display pop-up menus by right-clicking anywhere within a view. However, the pop-up menu items that are enabled can depend on the window item currently selected, if any, or on the position of the mouse pointer when you right-click.

Each pop-up menu is described and shown in Chapter 5 AXD Desktop as part of the description of each view. Online help gives more information.
2.6 Tool icons, status bar, keys, and commands

This section introduces:
- Toolbars
- Tooltips
- Status bar
- Keyboard shortcuts
- In-place editing on page 2-15
- Command-line interface on page 2-16.

2.6.1 Toolbars

Most of the main menus have corresponding toolbars with icons representing most of their items. To choose which menus are duplicated as toolbars, or to hide toolbars:

1. Select Configure Interface from the Options menu.
2. Click the check boxes under Toolbars so that the toolbars you want are checked.
3. Click the OK button.

To alter the order in which the toolbars are displayed, or reposition them on the screen, place the mouse pointer in a toolbar but not on an icon, then drag it to its new position.

When a toolbar is docked at one of the edges of the screen, it is only one icon high (or wide), but when it is floating and you change its shape, its icons automatically regroup.

2.6.2 Tooltips

If you leave the mouse pointer positioned on a toolbar icon for a few seconds without clicking, a tooltip appears informing you of the purpose of the icon. In addition, in disassembly and source views, you can leave the mouse pointer positioned over a variable or register to display the value of the variable or register as a tooltip.

2.6.3 Status bar

The status bar is a single line in which AXD can display several items of relevant information at the bottom of the debugger screen when appropriate (see Status bar contents on page 5-5).

You can display or hide the status bar (see Status Bar display control on page 5-97).

2.6.4 Keyboard shortcuts

Several kinds of keyboard shortcuts are described in AXD menus on page 2-12.
In addition, most items in three main menus (Processor Views, System Views, and Execute), and many items in pop-up menus, also show keys or key combinations that enable you to select that item directly, without first pulling down the menu. For example, pressing:

- Ctrl+R displays a Registers processor view
- Alt+O displays an Output system view
- F9 toggles a breakpoint on or off.

You can expand list views with the + and - keys. Look at the menus to see all the available keyboard shortcuts.

### 2.6.5 In-place editing

In-place editing enables you to see most clearly what you are doing when you change a stored value. It is used whenever possible. For example, when you are displaying the contents of memory or registers, and want to change a stored value:

1. Double-click on the value you want to change, or press Enter if the item is already selected. The value is enclosed in a box with the characters highlighted to show they are selected.
2. Either enter data to overwrite the highlighted data, or press the left or right arrow keys to deselect the existing data and position the insertion point where you want to amend the existing data.
3. Press Enter or Return to store the new value in the selected location.

If you press Escape or move the focus elsewhere instead of pressing Enter or Return, then any changes you made in the highlighted field are ignored.

In-place editing is not appropriate for:

- editing complex data where some prompting is helpful
- editing groups of related items
- selecting values from predefined lists.

In these cases an appropriate dialog is displayed.

See Data formatting on page 4-16 for details on editing data formats.

### In-place editing under UNIX

AXD can appear to hang when using in-place editing under Solaris. This might happen if the focus is changed, for example, if you double-click on a register to change its contents and then double-click on a different register.

To correct this, you must modify the X-Windows configuration file located in your $HOME directory. The file needs to contain the following line:
Dtwm-secondariesOnTop: True

The case is important so enter the line exactly as shown. If the .Xdefaults file does not exist then you must create it.

2.6.6 Command-line interface

The Command Line Interface (CLI) window is an alternative to the graphical user interface. In the CLI window you can:

• enter commands in response to prompts
• view data that you have requested
• submit a file in which you have set up a sequence of commands.

See Chapter 6 AXD Command-line Interface for details.
Chapter 3
Working with AXD

This chapter gives step-by-step instructions to perform a variety of debugging tasks. You might find it useful to follow all the instructions, as a tutorial. Chapter 5 AXD Desktop gives further details of specific features.

This chapter contains the following sections:

- Running a demonstration program on page 3-2
- Setting a breakpoint on page 3-4
- Setting a watchpoint on page 3-6
- Examining the contents of variables on page 3-8
- Examining the contents of registers on page 3-12
- Examining the contents of memory on page 3-14
- Locating and changing memory values and verifying changes on page 3-16.
3.1 Running a demonstration program

Various demonstration projects are supplied, with programs in the form of ARM assembly language, C, or C++ source code files. These projects are stored in subdirectories of Examples in the main examples directory (install_directory\RVDS\Examples). See the RealView Developer Suite Getting Started Guide for descriptions of these examples.

The examples given in this chapter have all been tested and shown to work as described. Your hardware and software might not be the same as those used for testing these examples, so it is possible that certain addresses or values might vary slightly from those shown, and some of the examples might not apply to you. In these cases you might need to modify the instructions to suit your own circumstances.

You are likely to be using software such as RealView® ARMulator® ISS to simulate a debugger target. Alternatively, your target might consist of a Multi-ICE® unit and an ARM Integrator board. If so, you must have set up the hardware and the software as described in Multi-ICE unit and target board on page 2-7. In all cases, you must have selected the target you intend to use and configured it, as described in Configure Target... on page 5-86.

The following instructions show you how to build, load, and execute a demonstration program that runs the dhrystone test software:

1. Create an executable image by running the dhr. bat batch file, located in the Examples directory.

2. Start the ARM eXtended Debugger (AXD).

3. Select Load Image... from the File menu to display the Load Image dialog, navigate to the directory of the dhrystone.axf image file, select the file, and click Open. The image loads into memory on the target, so the selected processor can execute it.

   A Disassembly processor view of the image is displayed as shown in Figure 3-1 on page 3-3. A blue arrow indicates the current execution point.
4. Select **Go** from the **Execute** menu (or press F5) to begin execution on the target processor. Execution stops at the beginning of function `main()`, where a breakpoint is set by default. A red disc and a marker indicate the line where a breakpoint is set.

5. A Source processor view of the relevant few lines of the relevant file is displayed. If it is not, right-click in the Disassembly view and select **Source** from the pop-up menu. Again, a red disc and marker indicate the line where a breakpoint is set, and a blue arrow indicates the current execution point.

6. Select **Go** from the **Execute** menu (or press F5) again to continue execution. You are prompted, in the Console processor view, for the number of runs through the benchmark that you want performed. Enter 8000. The program runs for a few seconds, displays some diagnostic messages, and shows the test results.

7. To repeat the execution of the program, select **Reload Current Image** from the **File** menu, then repeat steps 4 and 5. You do not have to open the Source process view again. When opened, it remains displayed.

If you are running AXD on a very fast machine, you might have to increase the number of runs through the benchmark (to 25000 or more, perhaps), to make the process last long enough to time accurately.
3.2 Setting a breakpoint

This example runs the same program again, this time with a breakpoint that stops execution a few times. You can examine values when execution stops.

1. Select **Reload Current Image** from the **File** menu.
2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function `main()` and indicated by a red disc. In the Source view, you can see the source file `dhry_1.c` with a breakpoint and the current position indicated by a red marker at line number 78.
3. Scroll down through the source file until line number 150 is visible. This is a call to `Proc_4()`, and is inside the loop to be executed the number of times you specify.
4. Right-click on line 150 to position the cursor there and display the pop-up menu, and select **Toggle Breakpoint** (or left-click on the line and press F9, or double-click in the margin next to the line). Another red disc and marker indicate that you have set a second breakpoint, as shown in Figure 3-2.

![Figure 3-2 Breakpoint set inside loop](image)

5. Select **Breakpoints** from the **System Views** menu to edit the details of the new breakpoint. The breakpoints pane is displayed.

Double-click on the line in the breakpoints pane that describes the new breakpoint, or right-click on it and select **Properties**..., to display the Breakpoint Properties dialog.

Enter 750 in the out of... field in the Condition group, as shown in Figure 3-3 on page 3-5. This is the number of times execution has to arrive at the breakpoint to trigger it.
6. Click OK.

7. Press F5 to resume execution, and enter the smaller number of 5000 this time for the number of runs required. Execution stops the 750th time your new breakpoint is reached.

8. Select Variables from the Processor Views menu to check progress. Reposition or resize the window if necessary. Click the Local tab and look for the Run_Index variable. Its value is shown as 2EE (hexadecimal). Right-click on the variable so that it is selected and a pop-up menu appears. Select Format → Decimal and the value is now displayed as 750 (decimal).

9. Press F5 to resume execution, and the value of the Run_Index local variable changes to 1500. It is now colored red to show that its value has changed since the previous display.

10. Press F5 repeatedly until the value of Run_Index reaches the highest multiple of 750 before exceeding your specified number of runs, then once more to allow the program to complete execution. (This time the dhrystone test results are meaningless, because of the interruptions to the timing measurements, but the use of a breakpoint has been demonstrated.)

11. Close down the Breakpoints system view, either by right-clicking and selecting Close or by clicking on the Close button in the title bar if the view is not docked.
3.3 Setting a watchpoint

This example runs the same program again, this time with a watchpoint that stops execution a few times. You can examine values when execution stops.

1. Select **Reload Current Image** from the **File** menu.

2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function `main()` and indicated by a red disc and marker. You can see the source file `dhry_1.c` with a breakpoint and the current position indicated at line number 78.

3. Select **Go** from the **Execute** menu (or press F5) to continue execution.

4. Enter 770 when you are prompted for the number of runs to execute. Execution continues until it reaches the breakpoint at line 150 for the 750th time. This is the breakpoint you defined in *Setting a breakpoint* on page 3-4.

5. Select **Watchpoints** from the **System Views** menu, right-click in the Watchpoints system view, and select **Add** to display the Watchpoint Properties dialog (shown in Figure 3-4). For this example you specify that execution stops every sixth time the value of `Run_Index` changes.

![Figure 3-4 Setting a watchpoint](image)

Enter `Run_Index` in the Item field in the Watch group.
Set the out of... field in the Condition group to a value of 6. This is the number of times the watched value has to change to trigger the watchpoint action.

Click the OK button.

6. Select Variables from the Processor Views menu if the Variables processor view is not already displayed. Reposition or resize the window if necessary. Click the Local tab and look for the Run_Index variable.

The value of Run_Index is currently 750. If it is displayed in hexadecimal notation, right-click on the value and select Format → Decimal to change the display format to decimal.

7. Press F5 to resume execution. The value of the Run_Index local variable changes to 756. It is now displayed in red to show that its value has changed since the previous display. Execution stops.

8. Examine any displayed values, then press F5 again to resume execution and perform six more runs. When the value of Run_Index becomes greater than the number of runs you specified, the test results are displayed and execution terminates. (Again, the dhrystone test results are meaningless, because of the interruptions to the timing measurements, but the use of a watchpoint has been demonstrated.)

9. Delete the watchpoint you set up for this example, by right-clicking on its line in the Watchpoints window and selecting Delete from the pop-up menu, then close down the Watchpoints system view.
3.4 Examining the contents of variables

Two methods of examining the contents of variables are described:

- **Contents of variables.**
  
  This method is simpler and shows only the contents of the specified variables.

- **Addresses and contents of variables** on page 3-9.
  
  This method shows the addresses of the variables in addition to their contents.

3.4.1 Contents of variables

To examine the contents of variables, use the Variables processor view. In this example you start by reloading and starting the current program, then stopping it:

1. Select **Reload Current Image** from the **File** menu.
2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function main().
3. Select **Go** from the **Execute** menu (or press F5) to continue execution.
4. Enter 760 when you are prompted for the number of runs to execute. Execution continues until it reaches the breakpoint at line 150 for the 750th time. This is the breakpoint you defined in *Setting a breakpoint* on page 3-4.
5. Select **Variables** from the **Processor Views** menu if the Variables processor view is not already displayed. Reposition or resize the window if necessary. On the **Local** tab look for the Run_Index variable. Other variables that you can see include Enum_Loc, Int_1_Loc, Int_2_Loc, and Int_3_Loc.

Right-click in the window, select **Properties...** to open the Default Display Options dialog. Select **dec** from the list of formats and click **OK**. The display is now similar to that shown in Figure 3-5.

![Figure 3-5 Examining the contents of variables](image)
6. Press F10. This is equivalent to selecting Step from the Execute menu. The program executes a single instruction and stops. Any values that have changed in the Variables processor view are displayed in red.

7. Press F10 repeatedly. As you execute the program, one instruction at a time, the values of several of the variables change. After you have allowed approximately 30 program instructions to execute, the value of Run_Index increases by 1. The program has now completed one further execution of the Dhrystone test.

8. Explore the various display options available from the pop-up menu. Try settings in both the Format submenu and the Default Display Options dialog displayed when you select Properties....

For a description of the display formats available, see Data formatting on page 4-16.

9. Press F5 to allow the program to complete its execution, then close down the Variables processor view.

Note

In the Variables processor view, sub-function results are shown in the form test_func{1} where 1 is the result returned by calling test_func for the first time in this function.

3.4.2 Addresses and contents of variables

An alternative method of examining a variable is to use a Watch processor view. This enables you to see the memory address of the variable in addition to its value. In this example you start by reloading and starting the current program, then stopping it:

1. Select Reload Current Image from the File menu.

2. Select Go from the Execute menu (or press F5) to reach the first breakpoint, set by default at the beginning of function main().

3. Select Go from the Execute menu (or press F5) to continue execution.

4. Enter 760 when you are prompted for the number of runs to execute. Execution continues until it reaches the breakpoint at line 150 for the 750th time. This is the breakpoint you defined in Setting a breakpoint on page 3-4.

5. Select Watch from the Processor Views menu and reposition or resize the window if necessary. You can specify items to watch on several tabbed pages. In this example you examine a few variables using the first tab only.
6. Right-click in the window, and select Add Watch from the pop-up menu. A Watch dialog appears, prompting you to enter an expression. For this example you enter some valid variable names, most of them preceded by an ampersand (&). See Figure 3-6.

Enter the first expression in the Expression field by typing:

```
&Enum_Loc
```

Enum_Loc is a global variable, so it is stored in RAM at the address &Enum_Loc (these names are case-sensitive).

**Note**

You can also add a variable to the Watch processor view by selecting it in the source view and using the Add Watch pop-up menu command.

7. Press the Return key or click on the Evaluate button.

The expression you entered appears in the Expression column, and its value, being the address of the variable, appears in the Value column.

Click on the + symbol to expand the display. Another line appears, showing the contents of the variable in the Value column.

Enter, in a similar way:

```
&Int_1_Loc
&Int_3_Loc
Run_Index
```

Expand these lines by clicking on the + symbol.
The \texttt{Run\_Index} variable name is not preceded by an ampersand because, in this program, the variable is stored in a processor register. Having no memory address, it is inappropriate to ask for it to be displayed. Specifying the variable name without the ampersand shows its contents but not its address.

8. In the \textbf{View} section of the Add Watch dialog, select \textbf{Proc}. In the \textbf{Tab} section of the Add Watch dialog, select \textbf{Tab 1}.

9. Select all the lines you have entered, as shown in Figure 3-6 on page 3-10. Click \textbf{Add To View} and then \textbf{Close}.

10. The variables you have specified are now displayed in the Watch processor view. Expand each entry to see both the addresses and the contents of the variables. Move the mouse pointer to the value displayed for the \texttt{Run\_Index} variable and right-click to display the pop-up menu. Select \textbf{Format} $\rightarrow$ \textbf{Decimal} so that the value of \texttt{run\_Index} is displayed as a decimal number.

11. Press F10. This is equivalent to selecting \textbf{Step} from the \textbf{Execute} menu. The program executes a single instruction and stops. Any values that have changed in the Watch processor view are displayed in color.

12. Press F10 repeatedly. As you execute the program, one instruction at a time, the values of several of the variables change. After you have allowed approximately 30 program instructions to execute, the value of \texttt{Run\_Index} increases by 1. The program has now completed one further execution of the Dhrystone test.

13. Explore the various display options available from the pop-up menu. Try settings in both the \textbf{Format} submenu and the Default Display Options dialog displayed when you select \textbf{Properties}... For a description of the display formats available, see \textit{Data formatting} on page 4-16.

14. Press F5 to allow the program to complete its execution, then close down the Watch processor view.
3.5 Examining the contents of registers

To examine the contents of registers used by the currently loaded program:

1. Select **Reload Current Image** from the **File** menu.
2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function `main()`.
3. Select **Registers** from the **Processor Views** menu and reposition or resize the window if necessary.

The registers are arranged in groups, with only the group names visible at first. Click on the + symbol of any group name to see the registers of that group displayed, as shown in Figure 3-7.

4. Press F10. This is equivalent to selecting **Step** from the **Execute** menu. The program executes a single instruction and stops. Any values that have changed in the Registers processor view are displayed in red.
5. Press F10 a few more times. As you execute the program, one instruction at a time, you can see the values of several of the registers change.
You soon reach the point when you are prompted, in the Console processor view, for the number of runs to perform. A very small number, such as 100, is sufficient this time.

6. Explore the format options available from the Registers processor view pop-up menu.

   If you position the mouse pointer on a selectable line when you right-click, the line is selected. You can change the display format of selected lines only.

   You can select multiple lines by holding down the Shift or Ctrl keys while you click on the relevant lines, in the usual way.

   For a description of the display formats available, see Data formatting on page 4-16.

   If you select Add to System from the pop-up menu, the currently selected register is added to those that are displayed in the Registers system view. This is particularly useful when your target has multiple processors and you want to examine the contents of some registers of each processor. Collecting the registers of interest into a single Registers system view avoids having to display many separate processor views.

   You can also select Add Register from the pop-up menu of the Registers system view. This enables you to select registers from any processor to add to those being displayed in the Registers system view.

7. Press F5 to allow the program to complete its execution, then close down the Registers processor view.
3.6 Examining the contents of memory

To examine the contents of memory used by the currently loaded program:

1. Select **Reload Current Image** from the **File** menu.
2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function `main()`.
3. Select **Go** from the **Execute** menu (or press F5) to continue execution.
4. Enter 760 when you are prompted for the number of runs to execute. Execution continues until it reaches the breakpoint at line 150 for the 750th time. This is the breakpoint you defined in *Setting a breakpoint* on page 3-4.
5. Select **Memory** from the **Processor Views** menu and move or resize the window if necessary. Figure 3-8 shows a typical memory processor view.

![Memory Processor View](image)

**Figure 3-8 Examining contents of memory**

Addresses and contents of variables on page 3-9 shows that addresses of interest are in the region of 0x07FFFFD0, so set the Start address value to, say, 0x07FFFF00. To do this, enter the required value into the **Start address** text box, and press **Enter**.

6. Press F10. This is equivalent to selecting **Step** from the **Execute** menu. The program executes a single instruction and stops. Any values that have changed in the Memory processor view are displayed in red.

7. Press F10 a few more times. As you execute the program, one instruction at a time, you can see the values stored in several of the memory addresses change.
8. Explore the format options available in the Memory processor view pop-up menu. Size settings appear both on the pop-up menu and in the dialog displayed when you select Properties... from the pop-up menu. For more information about these options see Chapter 5 AXD Desktop.
3.7 Locating and changing memory values and verifying changes

To locate a value (of a variable or string, for example) in memory and change it:

1. Select **Reload Current Image** from the **File** menu.
2. Select **Go** from the **Execute** menu (or press F5) to reach the first breakpoint, set by default at the beginning of function `main()`.
3. Select **Memory** from the **Search** menu to display the Search Memory dialog.
4. Enter `2'ND` in the **Search for** field, set the **In range** and **to** addresses to `0x0` and `0xFFFF`, and select **ASCII** for the Search string type, as shown in Figure 3-9.

5. Click the **Find** button. The Memory processor view opens, and shows the contents of an area of memory, with the string you specified highlighted.
6. Click the **Cancel** button to close the Search Memory dialog. Reposition and resize the Memory window if necessary, to see a display similar to that in Figure 3-10.

7. The four hexadecimal values highlighted are `32 27 4E 44`.

![Figure 3-9 Searching for a string in memory](image)

![Figure 3-10 Changing contents of memory](image)
Double-click on the value 32 and, as an example of entering a hexadecimal value, type \(0x4E\) and press Return.

Double-click on the value 27 and, as an example of entering an ASCII value, type \"o\" (a double quote followed by a lowercase letter o) and press Return.

Double-click on the value 4E and, as an example of entering a decimal value, type 46 and press Return.

Double-click on the value 44 and, as an example of entering an octal value, type \(062\) and press Return.

8. Press F5 to continue execution, and enter a value of, say, 100 when you are prompted in the Console processor view for the number of runs to perform.

When the program displays its messages after completing its tests you can see that one of the lines that in earlier examples included the text '2'ND STRING' now has 'No.2 STRING' instead because of the change you made.

In this example, the change you made was not permanent, because you did not alter the source code or the executable image stored in a disk file. You altered only the temporary copy of the image in the target memory.
Chapter 4
AXD Facilities

This chapter gives a brief overview of the debugging facilities that the ARM eXtended Debugger (AXD) provides and contains references to sources of more information. It contains the following sections:

- Stopping and stepping on page 4-2
- Expressions on page 4-4
- Viewing and editing on page 4-6
- Entering addresses on page 4-12
- Persistence on page 4-13
- RealMonitor support on page 4-14
- Data formatting on page 4-16
- Profiling on page 4-27.
4.1 Stopping and stepping

Ease of debugging depends on your ability to stop execution of a program at a specified point, or when specific conditions are encountered. You must then be able to examine the contents of memory, registers, or variables, possibly continue execution one instruction at a time, or specify other actions.

This section contains an overview of:

- Breakpoints
- Watchpoints
- Stepping through a program on page 4-3.

Detailed descriptions of how to use these facilities are given in Execute menu on page 5-75, and in the online help.

4.1.1 Breakpoints

Setting a breakpoint is the simplest way to interrupt normal execution of a program at a specific point. A breakpoint is always related to a particular memory address, regardless of what might be stored there. You set a breakpoint by specifying:

- a memory address
- a line in a listing of the executable image
- a line in the program source code that generated a program instruction
- a statement in a multi-statement line of source code
- an object, such as a low-level symbol, that indirectly specifies an address.

When execution reaches the breakpoint, normal execution stops before any instruction stored there is performed. You can then choose to examine the contents of memory, registers, or variables, or you might have specified other actions to be taken before execution resumes. In addition, any existing displays are updated to reflect the current state of the processor.

Breakpoint setting is described in Breakpoints system view on page 5-58, and toggling (switching on and off) in Toggle Breakpoint on page 5-77. You can also set breakpoints in some processor views (see Source... processor view on page 5-44, Disassembly processor view on page 5-40, and Memory processor view on page 5-31).

4.1.2 Watchpoints

A watchpoint is similar to a breakpoint, but it is the content of a watchpoint that is tested, not its address. You specify a register or a memory address to identify a location that is to have its contents tested. Watchpoints are sometimes known as data breakpoints, emphasizing that they are data dependent.
Normal execution stops if the value stored in a watchpoint changes. You might then choose to examine the contents of memory, registers, or variables, or you can specify other actions to be taken before execution resumes. In addition, any existing displays are updated to reflect the current state of the processor.

Watchpoint setting is described in Watchpoints system view on page 5-60.

4.1.3 Stepping through a program

When execution has stopped at a breakpoint or watchpoint, and you have completed your examination, you can:

- continue to the next breakpoint or watchpoint
- continue to a specific address indicated by the position of the cursor in a listing of the program image
- execute a single instruction.

If you are continuing from a call to a function, you can stop next at one of the following:
- the first executable instruction of that function
- the instruction in the calling program at which control returns from the function.

The various stepping options are described in Execute menu on page 5-75.

If you want to step though assembly language code you must ensure that you use frame directives in your assembly language code to describe stack usage.
4.2 Expressions

This section describes:

- Using expressions
- Expression rules
- Expression examples on page 4-5.

4.2.1 Using expressions

You use expressions when you define watches in a Watch processor view or a Watch system view. An expression might be the name of a variable, but can, for example, involve the calculation of a memory address from the contents of various registers or variables.

Expressions are also accepted in commands you enter in the Command Line Interface view.

4.2.2 Expression rules

Expressions are combinations of symbols, values, unary and binary operators, and parentheses. There is a strict order of precedence in their evaluation:

1. Expressions in parentheses are evaluated first.
2. Operators are applied in precedence order.
3. Adjacent unary operators are evaluated from right to left.
4. Binary operators of equal precedence are evaluated from left to right.

AXD includes an extensive set of operators for use in expressions. Many of the operators resemble their counterparts in high-level languages such as C. There are, however, some restrictions, described in Expression guidelines.

Expression guidelines

The following rules apply to expression evaluation in AXD:

- You cannot use functions in expressions.
- You can only use C operators in constructing expressions. Any operators defined in a C++ class that also have a meaning in C (such as []) do not work correctly because AXD uses the C operator instead. Specific C++ operators, such as the scope operator ::, are not recognized.
- You cannot access base classes in standard C++ notation, for example:
class Base
{
    char *name;
    char *A;
};

class Derived : public class Base
{
    char *name;
    char *B;
    void do_sth();
};

If you are in method do_sth() you can access the member variables A, name, and B through the this pointer. For example, this->name returns the name defined in class Derived.

To access name in class Base, the standard C++ notation is:

```cpp
void Derived::do_sth()
{
    Base::name="value"; // sets name in the base class
    // to "value"
}
```

However, expression evaluation does not accept this->Base::name because AXD does not understand the scope operator. You can access this value with:

```cpp
this->::Base.name
```

- You cannot call member functions in the form Class::Member(...). This displays an error message showing that this is not a variable.
- `private`, `public`, and `protected` attributes are not recognized in AXD expression evaluation. This means that you can use private and protected member variables during expression evaluation because AXD treats them as public.

### 4.2.3 Expression examples

Examples of expressions that are valid in a Watch view are:

- r3
- Run_Index
- r3 + 2 * Ch_Index
- Run_Index - 3 * r4
4.3 Viewing and editing

When execution stops, typically at a breakpoint or watchpoint, you can view, and in some cases edit, the following types of data:

- **Control**
- **Source files**
- **Disassembled code** on page 4-7
- **Registers** on page 4-7
- **Watch** on page 4-7
- **Variables** on page 4-8
- **Memory** on page 4-8
- **Remote debug information** on page 4-10
- **High-level and low-level symbols** on page 4-10
- **Debugger internals** on page 4-10
- **Backtrace** on page 4-10
- **Debug Communications Channel** on page 4-11
- **Semihosting** on page 4-11.

The data values to be displayed are compared with the corresponding values displayed at the previous interruption of execution. Any values that have changed are displayed in color.

4.3.1 Control

The main Control system view provides you with information about all the objects in the current debugging session and how they interrelate. You have access to all these objects. There are four tabbed pages:

- Target
- Image
- Files
- Class.

For more information, see *Control system view* on page 5-49.

4.3.2 Source files

To display the source code that generated the executable code in a program image:

1. Select the **Files** tab of the Control view.
2. Expand the display of the executable image details to see the names of the source files.
3. Right-click on the file that you want to view, to display the pop-up menu.
4. Select Source.

5. Right-click in the resulting view of the source file to display another pop-up menu that includes the ability to interleave disassembled code in the listing of the source file.

For further details see *Source... processor view* on page 5-44.

### 4.3.3 Disassembled code

To display disassembled code that represents a part of an executable image:

1. Select either the Target or the Image tab of the Control view.
2. Expand the display (because an image can be loaded on multiple processors), and right-click on the processor you want to examine.
3. Select Disassembly from the Views submenu of the pop-up menu.
4. Scroll to the area of code you want to examine if it is close, otherwise right-click in the Disassembly view, select Goto... from the pop-up menu, and specify an address in the required area.

For further details see *Disassembly processor view* on page 5-40.

### 4.3.4 Registers

To examine the registers of the current processor, select Registers from the Processor Views menu on the main menu bar.

To examine the registers in any of the target processors:

1. Select the Target tab of the Control view.
2. Right-click on the processor that you want to view, to display the pop-up menu.
3. Select Registers from the Views submenu.

To display a separate Registers view for each target processor, see *Registers processor view* on page 5-19. To select registers from various Registers processor views to display together in a single Registers system view, see *Registers system view* on page 5-54.

To change the value stored in any register that is displayed, double-click on its current value. In-place editing enables you to update the value.

### 4.3.5 Watch

To examine the values of specific variables or expressions related to the current processor, select Watch from the Processor Views menu on the main menu bar.

To examine specific variables or expressions related to any of the target processors:

1. Select the Target tab of the Control view.
2. Right-click on the processor that you want to view, to display the pop-up menu.
3. Select **Watch** from the **Views** submenu.

You can display a separate Watch view for each available processor.

A Watch view enables you to specify expressions based on variables (from a single process) that you want to examine whenever program execution stops. This differs from a Variables view, in which only the context variables of a process are displayed.

Each Watch view has four tabbed pages for you to display expressions and their values.

Because a Watch view displays only what you have specified, the first time you open a Watch view it is empty. Right-click to display the pop-up menu. Select **Add Watch**. In the resulting Watch dialog, shown in both **Watch processor view** on page 5-23 and **Watch system view** on page 5-55, you choose which tabbed page to use and whether you are adding the new watch to a Watch processor view or a Watch system view.

You can specify expressions to be watched, but a variable name alone is often sufficient.

### 4.3.6 Variables

To examine the context variables of the current processor, select **Variables** from the **Processor Views** menu on the main menu bar.

To examine the variables in any of the available target processors:
1. Select the **Target** tab of the Control view.
2. Right-click on the processor that you want to view, to display the pop-up menu.
3. Select **Variables** from the **Views** submenu.

You can display a separate Variables view for each available processor.

Variables are defined in the executable image that you load into the memory of a target so that it can be executed by a processor. You must load an image, specifying a processor, before you can examine variables.

To change the value stored in any variable that is being displayed, double-click on its current value. In-place editing enables you to update the value.

For further details, see **Variables processor view** on page 5-26.

### 4.3.7 Memory

To examine the memory of the current processor, select **Memory** from the **Processor Views** menu on the main menu bar.
To examine the memory in any of the available target processors:
1. Select the **Target** tab of the Control view.
2. Right-click on the processor that you want to view, to display the pop-up menu.
3. Select **Memory** from the **Views** submenu.

You can display multiple Memory views.

The four tabbed screens enable you to specify up to four areas of memory in each view. Click on a tab to bring its area of memory to the front of the display.

To change the value stored in a memory address that is being displayed, double-click on its current value. In-place editing enables you to update the value.

For further details, see **Memory processor view** on page 5-31.

**Locate using value**

This provides another way for you to specify an area of memory to display. The **Locate Using Value** item is available in the pop-up menu of the following:

- registers views
- watch views
- variables views
- memory views.

In any of these views, if you select a data item that contains a memory address, then select **Locate Using Value** from the pop-up menu, a Memory view displays an area of memory that includes the specified address. For further details, see **Watch processor view** on page 5-23.

**Locate using address**

This provides another way for you to specify an area of memory to display. The **Locate Using Address** item is available in the pop-up menu of the following:

- watch views
- variables views
- backtrace views
- low level symbols views.

In any of these views, if you select a data item that can be interpreted as a memory address, then select **Locate Using Address** from the pop-up menu, a Memory view displays an area of memory that includes the specified address. For further details, see **Watch processor view** on page 5-23.
4.3.8 Remote debug information

To view low-level communication messages between the debugger and the target processor, use the RDI Log tab of the Output system view.

For more information, see Output system view on page 5-63.

4.3.9 High-level and low-level symbols

A high-level symbol for a procedure refers to the address of the first instruction that has been generated within the procedure, and is denoted by a function name. To see all the function names contained in an executable image, select the Class tab in the Control view, and expand the Globals list under the required image. Functions are marked with a colored square, and variables with a colored disc.

A low-level symbol for a procedure refers to the address that is the target for a branch instruction when execution of the procedure is required. The low-level and high-level symbols often refer to the same address.

To display a list of the low-level symbols in your program, use the Low Level Symbols processor view.

To use a low-level symbol as an expression when you define a watch, precede the symbol with @.

For more information, see Entering addresses on page 4-12 and Low Level Symbols processor view on page 5-35.

4.3.10 Debugger internals

Various internal variables contain information relevant to the current debugging session. Also, when you use RealView® ARMulator® ISS to simulate a target, statistics are accumulated during execution of the program being debugged. You can examine these statistics and information in the Debugger Internals system view which has two tabbed pages:

- Internal Variables
- Statistics (available when using a simulated target only).

For more information, see Debugger Internals system view on page 5-68.

4.3.11 Backtrace

A call stack is maintained for each processor in the target, and the Backtrace processor view enables you to examine the current state of any call stack. This shows you the path that leads from the main entry point to the currently executing function.
All called functions are added to the stack, but those that complete execution and return control normally are removed. The stack therefore contains details of all functions that have been called but have not yet completed execution.

For more information, see Backtrace processor view on page 5-29.

4.3.12 Debug Communications Channel

The Comms Channel processor view enables you to communicate with a processor through its Debug Communications Channel (DCC). DCC is implemented in ARM cores containing EmbeddedICE logic. This enables low-level input and output of 32-bit words to the target. There are also facilities in the debugger to read input from a file and log output to a file.

You cannot use the Comms Channel view if DCC semihosting is being used.

For more information, see Comms Channel processor view on page 5-37.

4.3.13 Semihosting

The Console view enables you to enter data from your keyboard to the program being debugged, when it might normally receive data from some other device. You can also display on your screen output that might normally be sent elsewhere.

For more information, see Console processor view on page 5-39 and Configure Processor.. on page 5-95.

If you are using Multi-ICE® to connect the debugger to a target, you can select either Standard Semihosting or DCC Semihosting. You do this by setting the variable semihosting_enabled to a suitable value (see Definitions on page 6-9).

If you select DCC Semihosting, the DCC semihosting SWI handler is installed in target memory at the address specified by the semihosting_dcchandler_address variable. It is essential that a region of memory starting at this address is available in target memory and is unused. The default address stored in this variable is 0x70000. You might have to change this to a lower value to suit the target memory.

——— Note ————

The AXD debug architecture does not currently support attaching and re-attaching while using either Standard Semihosting or DCC Semihosting.
4.4 Entering addresses

When you are prompted to enter an address in a field you can use:

- any of the following forms of low-level address:
  - hexadecimal, for example:
    \( 0x8248 \) or \( 0x008248 \)
  - decimal, for example:
    32768
  - address low-level symbol such as a function name, for example:
    @Func_2
  - hexadecimal address or low-level symbol, plus or minus an offset, for example:
    @Func_2 + 0x20
- the predefined low-level debugging symbols available in AXD, for example:
  #pc
- one of the following forms of high-level address:
  - Function name, for example:
    %Func_2
  - Function name and line number, for example:
    %Func_2:164
  - Function name and the special symbol $END to signify the address one beyond the end of the function:
    %Func_2:$END
    The address of the last instruction in %Func_2 can be calculated as:
    %Func_2:$END - instructionsize
    Where instructionsize is 2 for Thumb code and 4 for ARM code.
  - A global variable, for example:
    Int_Glob
  - A member of a global array, for example:
    Arr_1_Glob[10]
4.5 Persistence

You have considerable control over settings that persist from one debug session to another. By default, each debug session starts up in a state as close as possible to the final state of the previous debug session. The settings that can persist include the:

- target that was in use
- processor that was selected
- image that was loaded
- views that were open, including the size, shape, and position of each on the screen
- list of most recently used files
- list of most recently used session files
- list of most recently used images
- default display font
- tab size, specifying how tabs characters are expanded in source views
- printf formatting strings for several display formats
- array expansion threshold
- toolbar layout.

For a complete list of all the settings than can persist, see Configure Interface... on page 5-79.

You can also choose to restart any previous session that was saved in a session file (see Load Session... on page 5-12 or the -session argument in AXD arguments on page 2-3).

The current session settings are stored in the registry of your computer. The settings are also written to a file that you specify if you choose to save the current session so that you can restart it at any later time. AXD session files have the filename extension .ses. See Save Session... on page 5-13. You can create any number of session files. To restart an earlier session, see Load Session... on page 5-12.

If you start a debug session from the command line, specifying a session file (see AXD arguments on page 2-3), then that session is restarted.

If you start up AXD without specifying a session file, then the setting of the Save and load session files check box determines what happens. This check box is on the General tab of the Configure Interface dialog (see Configure Interface... on page 5-79). If checked, the previous session is restarted. If unchecked, system default settings are used and no earlier session is restarted.
4.6 RealMonitor support

RealMonitor is a software solution developed by ARM that enables you to debug a target application without stopping the processor, and without interrupting time-critical parts of the application, such as interrupt handlers.

Targets that do not incorporate RealMonitor support must stop execution when a debugger is connected, and restart when instructed to do so. The displayed views are updated each time the target execution stops. All views therefore show consistent data.

You can trace and query a RealMonitor target without interrupting its execution. This means that values of variable data displayed in AXD views might not be current. When debugging a RealMonitor target, AXD places a timestamp in the title bar of a view indicating when the contents of the view were last updated. The following restrictions apply to the timestamp value:

- The value of the timestamp is the time when the debugger makes the request to update data and does not accurately reflect (in terms of milliseconds) the time when the data are evaluated. The timestamp does indicate the order in which the views were updated.

- Views that display variable data, such as the watch, variable, and debugger internals views, often contain hierarchical data. Because these views enable unrestricted in-place expansion, they do not evaluate the child items of a structure when the structure is added to the view. This means that when a hierarchical item is expanded the child items are evaluated at the time of expansion. The values of child items might not be consistent with the timestamp.

- Evaluation of dereferenced pointers is performed when the pointer is dereferenced, not when it is added to the view. This means that the value of the dereferenced data might not be consistent with the timestamp, or with the current value of the pointer.

- Views that support dynamic addition of entries, such as the register and watch views, evaluate new entries when they are added. The existing entries and the timestamp are not updated when new entries are added. This means that the values of new entries are not consistent with the timestamp.

See Configure Interface... on page 5-79 for information on how to connect AXD to a RealMonitor target.

Where required, AXD views provide a Refresh item in their context menus that enables you to refresh the view manually. Right-click in the view to display its context menu, and select Refresh to update and recalculate displayed values.
If you select **Properties...** from the Memory or Backtrace processor view, you can select or deselect an **Automatic refresh** check box. Selecting this causes the view to be refreshed automatically whenever required. This avoids you having to refresh the view manually but can impose a significant processing overhead.

--- **Note** ---

In the Variables processor view, only the currently selected tab is refreshed by the **Refresh** command. In addition, changing tabs causes the new tab to be automatically refreshed. When a tab is updated, it is marked as clean until the next step.
4.7 Data formatting

You can enter and edit data in a variety of formats, and the debugger can display data in a variety of formats. When you enter or edit data, or view displayed data, the correct recognition of the format is vital to the interpretation of a value. It is important either to prefix a value with an indicator of the format or to be sure that the correct format is otherwise assumed.

You can select any format for displaying selected data in many places, including:
- registers views
- watch views
- variables views
- debugger internals views
- memory views.

Values are displayed in a default format for the data type unless you specify otherwise.

The **Format** item that appears on many pop-up menus leads to a number of submenus. Figure 4-1 shows a few examples.

![Figure 4-1 Example format submenus](image-url)
The first format listed in a format submenu is the default format for the currently selected data item. The checked format is the current format and normally appears second in the list. If the current format is the default format, then the first format is checked and is not repeated.

The format submenus enable you to select any valid data storage size and format for displaying a selected item. You might replace it with a value that you enter in yet another format.

When you enter or change data, you are offered in-place editing whenever possible, otherwise a suitable dialog is displayed. When you use in-place data editing, the whole string that you enter is interpreted and checked for validity when you press Return. If you attempt to move the focus away from the field without pressing Return, the edit is discarded and no validation occurs. Individual characters are not checked as you enter them. You can enter data in any appropriate format, not necessarily the current display format. You can enter addresses in a variety of formats, as described in Entering addresses on page 4-12.

If you enter a value that is larger than the available field size, the least significant bits of your value are stored and the most significant bits are ignored.

Note

The format of a value is often indicated by a prefix, such as 0x meaning hexadecimal. So, to change a displayed value from 0x21 to 0x20, for example, you must update the entry to read 0x20. An entry of 20 is interpreted as decimal and the wrong value of 0x14 is stored.

Formats supported include:

- Hex on page 4-18
- Decimal on page 4-18
- Octal on page 4-18
- Binary on page 4-19
- ASCII on page 4-19
- Printf... on page 4-19
- Floating point on page 4-20
- Registers on page 4-21
- Q-format on page 4-24
- Other on page 4-25.
4.7.1 Hex

A 2-character prefix of a figure 0 and an uppercase or lowercase letter x indicates a hex (hexadecimal) format. Hexadecimal digits (0-9, A-F) specify the value. The letters can be uppercase or lowercase. Examples are:

0xffff
0x000369CF
0x0

4.7.2 Decimal

A value in decimal format has no prefix. The digits 0 to 9 are allowed, and the first character can be a minus sign (-) or a plus sign (+). This format is intended for the display or entry of integer values only.

Two types of decimal format are supported:

**U Decimal**  
In U Decimal (unsigned decimal) format the numerical value can range from zero up to the highest value that can be stored in the number of bits available. For example, an 8-bit byte can hold values from 0 to 255.

**Decimal**  
In Decimal (signed decimal) format the numerical value can be negative or positive, with the maximum absolute value being half the maximum unsigned decimal value. For example, an 8-bit byte can hold values from -128 to +127 and a 16-bit halfword can hold values from -32768 to +32767.

--- Note  
If you enter the value -1 this sets all the bits of the displayed, or available, format.

4.7.3 Octal

Octal format is generally denoted by a leading lowercase letter o. In this format each group of three bits in the stored value is represented by a digit in the range 0-7. The grouping of bits into three starts from the least significant bit, so if the data item does not contain an exact multiple of three bits it is the most significant group that takes one or two leading zero bits for the purpose of evaluating its octal digit.

For example, you can enter or display a 16-bit halfword in octal format as, say, o170761. That same value is represented in binary format as b1111000111110001 or in hexadecimal format as 0xF1F1.
4.7.4 Binary

Binary format uses one digit, either 0 or 1, to represent each bit of a value. When you display a value in binary format, there is no leading-character indicator of the format, but the format is generally easy to recognize because it contains 0s and 1s only and is typically 8, 16, or 32 binary digits long. You can display a binary value with a space after each 4-bit nibble (see Printf...).

To enter a value in binary format, enter a letter b, in uppercase or lowercase, as the first character. You do not need to enter leading binary 0s. They are added automatically if necessary. Any spaces you enter are ignored. You can enter, for example, a space after every 4 bits to see the value of each nibble entered more clearly.

4.7.5 ASCII

ASCII format displays the selected data item as a fixed length string of characters. Each character represents 8 bits of storage, starting from the least significant bit. Any residual bits are padded with zeros to create a full 8 bits. The ASCII format is useful if, for example, you are examining the copying of strings and character arrays by transfer in and out of registers.

Characters displayed in ASCII format have no introductory character to indicate the format. Any non-printable value is represented by a full stop (.)

If you edit an ASCII character string that contains a non-printable value, the string is presented for editing in hexadecimal format.

To enter an ASCII value, prefix it with a single quotation mark (') or double quotation mark ("). This quotation mark is not stored, it only indicates that what follows is a string of ASCII characters. Each character you enter is stored in the least significant 8 bits of the data item. Any previously entered characters shift by 8 bits to accommodate the new character. If you enter more characters than the data item can hold, the earliest characters are lost and the latest ones are stored.

4.7.6 Printf...

This displays a dialog enabling you to use an extended set of C formats to specify the format used for displaying the currently selected data. Examples are:

%d
%g
%b
%B
%f
"Hello %d world"
If you specify a binary display format using a lowercase b, the displayed value has all its binary digits in one continuous string. Using an uppercase B in the format specification results in a display with a space after each nibble.

The last example displays a value of, say, 6 as Hello 6 world. If you double-click on the value to edit it, you can change the numeric value. Changing the value from 6 to, say, 345 leads to a display of Hello 345 world.

For a simply-formatted value, the default printf format shown in the dialog is the format currently used to display that value.

### 4.7.7 Floating point

Most floating point formats allow you to display or enter very small and very large numerical values without having to use long strings of zeros.

You can enter very precise values by using sufficient significant digits, but the precision that can be stored depends on the number of bits allocated. Generally, if you enter too many significant digits the value is rounded to the nearest value that can be stored.

Four kinds of floating point format are supported:

**Floating point**

- The first character can be a minus sign (-) or a plus sign (+). Remaining characters are decimal digits (0-9) and one decimal point that can be placed at any position among the digits.
- A precision of up to about 6 significant figures can be stored. A value stored in this format occupies 32 bits.

**Scientific (single precision)**

- A dialog helps you enter or edit data in this format. You are prompted for the sign and value of the mantissa and the exponent.
- A value displayed in this format always has its decimal point after the first significant figure.
- This format offers a precision of up to about 6 significant figures. The exponent value must be in the range -38 to +38. This format occupies 32 bits of storage.

**Scientific (double precision)**

- A dialog helps you enter or edit data in this format. You are prompted for the sign and value of the mantissa and the exponent.
- A value displayed in this format always has its decimal point after the first significant figure.
This format offers a precision of up to about 15 significant figures. The exponent value must be in the range -308 to +308. This format occupies 64 bits of storage.

**Raw floating point**

This format enables you to view values in the 80-bit format used in a Floating Point Accelerator (FPA) coprocessor.

### 4.7.8 Registers

Certain registers contain collections of settings that can be represented by very few bits, often a single bit. Formats appropriate to these registers display the contents in meaningful ways. For example, a flag that might be on or off is displayed as a letter. The letter indicates which flag, uppercase meaning set and lowercase meaning cleared.

A dialog helps you to change the contents of this kind of register.

When you display the contents of a register, the required register format is used automatically. The following register formats are supported:

**PSR (Program Status Register)**

A typical display of a Program Status Register might show \( nZCvIFtSVC \), giving information about:

- 4 condition code flags (NZCV)
- 2 interrupt enable flags (IF)
- 1 state indicator (T)
- 1 processor mode name (SVC).

**E-PSR (Enhanced Program Status Register)**

This format applies to processors, such as the ARM 9E, that support the enhanced DSP instructions in E variants of ARM Architecture version 5 and above. See *Registers processor view* on page 5-19 for more information.

A typical display of an Enhanced Program Status Register might show \( nZCvqIFtSVC \), giving information about:

- 5 condition code flags (NZCVQ)
- 2 interrupt enable flags (IF)
- 1 state indicator (T)
- 1 processor mode name (SVC).
JPSR (Jazelle Program Status Register)
This format applies to processors, such as the ARM926EJ-S, that support ARM’s Jazelle™ technology for Java applications. See Registers processor view on page 5-19 for more information.

A typical display of a Jazelle Program Status Register might show nZCvIFtJSVC, giving information about:
- 5 condition code flags (NZCVQ)
- 2 interrupt enable flags (IF)
- 2 state indicators (TJ)
- 1 processor mode name (SVC).

FPSR (Floating Point Status Register)
This format applies if you are using a Floating Point Accelerator (FPA) coprocessor, or the Floating Point Emulator (FPE). A typical display of a Floating Point Status Register might show xu02I_xu02i. Five letters are displayed twice. Each letter represents a floating point exception, as follows:
X Inexact
U Underflow
0 Overflow
Z Divide by zero
I Invalid operation.

The first set of letters represent the current settings of the five Exception Trap Enables, also known as the Exception Mask. These settings define which of the exceptions, if they occur, are intercepted by the debugger. The second set of letters represent the Cumulative Exception Flags and show the exceptions that have occurred.

Bits 20:16 of the 32-bit FPSR are the Exception Trap Enables, and bits 4:0 are the Cumulative Exception Flags.

FPSCR (Floating Point Status and Control Register)
This format applies to 32-bit registers containing bits that have the following meanings:

31:28 Condition Flags. These bits represent the condition flags that contain the results of the most recent floating point comparison, as follows:
N the comparison produced a less than result
Z the comparison produced an equal result
the comparison produced an equal, greater than or unordered result.

V the comparison produced an unordered result.

27:25 Reserved. Do not use.

24 Mode. This bit represents the flush-to-zero mode. If the bit is unset (=0) flush-to-zero is disabled.

23:22 Rounding mode:
RN Round to Nearest
RP Round towards Plus Infinity
RM Round towards Minus Infinity
RZ Round towards Zero.

21:20 Stride part of the current vector length/stride control. The allowed combinations are given in the drop-down list.

19 Reserved. Do not use.

18:16 Length part of the current vector length/stride control. The allowed combinations are given in the drop-down list.

15:13 Reserved. Do not use.

12:8 Exception Mask. Each bit corresponds to one type of floating point exception, as defined for Cumulative Flags.

7:5 Reserved. Do not use.

4:0 Cumulative Flags. Each bit corresponds to one type of floating point exception. If a bit is set (=1), the exception flag has been set as a result of executing a floating point instruction.

The flags are defined as follows:
X Inexact result, that is, non-zero rounding
U Underflow has occurred
0 Overflow has occurred
Z Divide by zero has been attempted
I Invalid operation.

In views, set bits are represented by uppercase identifiers, unset bits are represented by lowercase identifiers.

Other register formats

Other register formats might be available, depending on your target system.
4.7.9 Q-format

Q-formats are bit-level formats for storing numeric values. A Q-format enables you to specify:

- the number of bits used to represent values
- the numeric range within which all values fall.

**Precision**

The total number of bits you allow for storing a value determines the maximum precision with which a value can be defined. You can also regard it as determining the resolution, or smallest difference that can be distinguished between values.

**Numeric range**

In a Q-format you specify how many bits represent an integer value, and how many further bits represent subdivisions within each integer value. You can in effect specify ranges. For example:

- -1024 to (almost) +1024, where the most significant 11 bits represent a signed integer value
- 0 to (almost) +64, where the most significant 6 bits represent an unsigned integer value
- -1 to (almost) +1, where the most significant bit represents the sign.

In each case, all the remaining bits represent fractions between each integer value, and (almost) means a value one least-significant-bit less than the value given.

**Notation**

The form of a Q-format is Qn.m, where n is the number of bits before a notional binary point, and m is the number of bits that follow it. You can choose signed Q-format for ranges of values divided equally either side of zero, or unsigned Q-format for values that range upwards from zero.

For example, a 16-bit halfword can hold values in a signed Q4.12 format. This covers the range -8 to (almost) +8, with 65,536 unique values available in that range.

U Q15 is shorthand for unsigned Q1.15. This is a format for 16-bit values that gives 65,536 unique values in the range 0 to (almost) +2.

Q31 is shorthand for signed Q1.31. This is a format for 32-bit values that gives 4,294,967,296 unique values in the range -1 to (almost) +1.
4.7.10 Other

This submenu includes all the remaining available formats that do not appear on other submenus. It also enables you to specify the number of bits of storage space you want allocated to a data item. The items on this submenu are:

**U Decimal**  See *Decimal* on page 4-18.

**String**  This format treats the value as an array of characters.

If you attempt to edit a character array formatted as a string, a String dialog is displayed, as shown in Figure 4-2.

![String dialog](image)

Figure 4-2 String dialog

You can choose whether to edit the string as ASCII or ASCIIZ. If you select ASCII, all characters up to the size of the array are replaced by the input characters. If you select ASCIIZ, a trailing character zero is always added as the final character of the array.

The dialog always opens with ASCIIZ set by default.

Type your character string in the edit box. If you enclose the string in quotes, AXD interprets it as a C++ escape string and the read-only box below the edit box shows how the string would be displayed. For example, if your input contains a null character, only the characters before the null are displayed. If you omit the quotes, all characters are treated as part of the string and it is passed directly to the display.

The current value of the string is displayed, together with its hexadecimal representation.
Hex - no prefix

Select this format to display a value in hexadecimal format without the usual leading 0x characters. If you replace the displayed value your entry must still begin with 0x to avoid being mistaken for a decimal value.

Octal - no prefix

Select this format to display a value in an octal format without the usual leading 0 character. If you replace the displayed value your entry must still begin with 0 to avoid being mistaken for a decimal value.

In addition there are size menus for other sized values. These menus do not indicate the current size of the data item. This part of the submenu shows:

**Size 8**
Select this to display a further submenu containing all the formats that you can use with 8-bit data items.

**Size 16**
Select this to display a further submenu containing all the formats that you can use with 16-bit data items.

**Size 32**
Select this to display a further submenu containing all the formats that you can use with 32-bit data items.

**Size 40**
Select this to display a further submenu containing all the formats that you can use with 40-bit data items.

**Size 64**
Select this to display a further submenu containing all the formats that you can use with 64-bit data items.

**Size 80**
Select this to display a further submenu containing all the formats that you can use with 80-bit data items.
4.8 Profiling

Profiling involves sampling the program counter at specific time intervals. The resulting information is used to build up a picture of the percentage of time spent in each procedure. By using the armprof command-line tool on the data generated by AXD, you can see how to make the program more efficient.

--- Note ---

Profiling is supported by RealView ARMulator ISS, RealMonitor, and Angel, but not by EmbeddedICE or Multi-ICE.

---

To collect profiling information when executing an image, you must specify profiling settings when you first load the image (see Load Image... on page 5-7) or before reloading the image (see Image pop-up menu on page 5-51):

**Flat profiling**

Flat profiling accumulates limited information without altering the image.

**Call graph profiling**

Call graph profiling accumulates more detailed information but has to add extra code to the image.

To collect profiling information:

1. Load your image file, having made the appropriate profiling settings.
2. Select Options → Profiling → Toggle Profiling if necessary to ensure that Toggle Profiling is checked in the Profiling submenu of the Options menu.
3. Execute your program.
4. Select Options → Profiling → Write to File when the image terminates.
5. A Save dialog appears. Enter a file name and a directory as necessary.
6. Click the Save button.

--- Note ---

You cannot display profiling information in AXD. Use the Profiling functions on the Options menu to capture profiling information, then use the armprof command-line tool to analyze it.

---

To collect information on a specific part of the execution:

1. Load (or reload) the program with profiling enabled.
2. Set a breakpoint at the beginning of the region of interest, and another at the end.
3. Execute the program as far as the beginning of the region of interest.
4. Clear any profiling information already collected by selecting **Options → Profiling → Clear Collected**, and ensure that **Toggle Profiling** is checked.

5. Execute the program as far as the breakpoint at the end of the region of interest.

6. Select **Options → Profiling → Write to File** and specify the name of a file in which to save the profiling information.

You can profile both C and assembler language functions. To profile assembler language functions you must mark the functions with **FUNCTION** and **ENDFUNC** directives.
Chapter 5
AXD Desktop

This chapter describes the menus, views, dialogs, tool and status bars that the ARM eXtended Debugger (AXD) desktop provides. Chapter 2 Getting Started in AXD gives an overview of some of these facilities. This chapter systematically describes all the available facilities. It contains the following sections:

- Menus, toolbars, and status bar on page 5-2
- File menu on page 5-6
- Search menu on page 5-16
- Processor Views menu on page 5-18
- System Views menu on page 5-48
- Execute menu on page 5-75
- Options menu on page 5-79
- Window menu on page 5-98
- Help menu on page 5-101.
5.1 Menus, toolbars, and status bar

This section introduces the AXD menus, and describes the available toolbars and the status bar.

The first screen that AXD displays is similar to that shown in Figure 5-1. Subsequent debug sessions might start up differently (see Persistence on page 4-13).

The main AXD features are described in this chapter under the headings:

- Menus
- Toolbars on page 5-3
- Status bar contents on page 5-5.

5.1.1 Menus

You can pull down the main menus from the menu bar near the top of the screen. Each menu in the menu bar is described in a separate section of this chapter.

Other menus, called pop-up menus, are also available when you have views displayed. Some items are duplicated in menu bar menus and pop-up menus. Some pop-up menus offer additional items. The descriptions of views in Processor Views menu on page 5-18 and System Views menu on page 5-48 include details of pop-up menus.
5.1.2 Toolbars

Toolbars are available that correspond to most menus in the menu bar. You can display none, any, or all of these toolbars (see Configure Interface... on page 5-79). Clicking on an icon in a toolbar is equivalent to selecting a menu item.

**File toolbar**

File toolbar icons correspond to most File menu items, as shown in Figure 5-2.

![Figure 5-2 File toolbar](image)

These tools are described as menu items in File menu on page 5-6.

**Search toolbar**

Search toolbar icons correspond to most Search menu items, as shown in Figure 5-3.

![Figure 5-3 Search toolbar](image)

These tools are described as menu items in Search menu on page 5-16.

**Processor Views toolbar**

Processor Views toolbar icons correspond to most Processor Views menu items, as shown in Figure 5-4.

![Figure 5-4 Processor Views toolbar](image)

These tools are described as menu items in Processor Views menu on page 5-18.

**System Views toolbar**

System Views toolbar icons correspond to most System Views menu items, as shown in Figure 5-5 on page 5-4.
These tools are described as menu items in *System Views menu* on page 5-48.

**Execute toolbar**

Execute toolbar icons correspond to most **Execute** menu items, as shown in Figure 5-6.

These tools, with the exception of the timed refresh tool, are described as menu items in *Execute menu* on page 5-75. For details of the timed refresh tool, see *Window menu* on page 5-98 and *Configure Interface...* on page 5-79.

**Help toolbar**

Help toolbar icons provide two ways of accessing AXD online help items, as shown in Figure 5-7.

These tools are described in *Help menu* on page 5-101.
5.1.3 Status bar contents

If you choose to display the status bar (see Status Bar display control on page 5-97) it appears at the bottom of the AXD screen, as shown in Figure 5-8.

![Figure 5-8 Status bar](image)

Help text is displayed at the left of the status bar. This either reminds you how to display information relevant to your current situation or, when you pull down a menu from the menu bar and point to an item on it, explains the purpose of that menu item.

At the right, the current debug agent, processor, and image are shown (these are not always the same as the selected debug agent, processor, and image). Also, when a source or disassembly view has the focus, the current cursor line and column are shown.

A progress indicator shows the current operation being performed by the debugger.
5.2 File menu

File menu items enable you to transfer data between the debugger and various disk files, and to close down the debugger. Figure 5-9 shows the File menu.

<table>
<thead>
<tr>
<th>File menu items</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Image...</td>
<td>on page 5-7</td>
</tr>
<tr>
<td>Load Debug Symbols...</td>
<td>on page 5-8</td>
</tr>
<tr>
<td>Reload Current Image</td>
<td></td>
</tr>
<tr>
<td>Open File...</td>
<td>on page 5-9</td>
</tr>
<tr>
<td>Load Memory From File...</td>
<td>on page 5-10</td>
</tr>
<tr>
<td>Save Memory To File...</td>
<td></td>
</tr>
<tr>
<td>Flash Download...</td>
<td>on page 5-11</td>
</tr>
<tr>
<td>Load Session...</td>
<td>on page 5-12</td>
</tr>
<tr>
<td>Save Session...</td>
<td>on page 5-13</td>
</tr>
<tr>
<td>Recent Files</td>
<td>on page 5-14</td>
</tr>
<tr>
<td>Recent Images</td>
<td>on page 5-14</td>
</tr>
<tr>
<td>Recent Symbols</td>
<td>on page 5-14</td>
</tr>
<tr>
<td>Recent Sessions</td>
<td>on page 5-14</td>
</tr>
<tr>
<td>Unload Current Image</td>
<td>on page 5-15</td>
</tr>
<tr>
<td>Import Formats...</td>
<td>on page 5-15</td>
</tr>
<tr>
<td>Exit</td>
<td>on page 5-15</td>
</tr>
</tbody>
</table>

Figure 5-9 File menu

The File menu items are described under the following headings:

- Load Image... on page 5-7
- Load Debug Symbols... on page 5-8
- Reload Current Image on page 5-9
- Open File... on page 5-9
- Load Memory From File... on page 5-10
- Save Memory To File... on page 5-10
- Flash Download... on page 5-11
- Load Session... on page 5-12
- Save Session... on page 5-13
- Recent Files on page 5-14
- Recent Images on page 5-14
- Recent Symbols on page 5-14
- Recent Sessions on page 5-14
- Unload Current Image on page 5-15
- Import Formats... on page 5-15
- Exit on page 5-15.
5.2.1 Load Image...

To select a file containing an image to load into the target memory, select **Load Image...** from the **File** menu. The resulting dialog is shown in Figure 5-10.

![Figure 5-10 Selecting an image file to load](image)

Navigate to the directory where the file is stored. You can specify that only files with a particular filename extension are offered for selection. The directory that you specify in this dialog becomes the current directory.

Your target might have more than one processor. The Processors list in the dialog identifies them and enables you to select those onto which you want to load the image.

Leave the **Profile** check box unchecked if you do not intend to collect any profiling information from this image. If you do want to perform profiling, then you must check the **Profile** check box and set the other profiling details in this dialog before loading the image:

- **Call graph profiling**
  
  Call graph profiling accumulates more detailed information than flat profiling but has to add extra code to the image.

- **Flat profiling**
  
  Flat profiling accumulates limited information without altering the image.
When you enable profiling at load time, you are then able to start and stop the collection of profiling information during execution of the image (see Profiling on page 4-27).

**Note**
Profiling is supported by RealView® ARMulator® ISS, RealMonitor, and Angel, but not by EmbeddedICE or Multi-ICE®.

An image loaded from the Load Image dialog or by a CLI command has a breakpoint set by default at main().

If the image you are loading uses floating point data, the $target_fpu debugger internal variable must match the image. See Debugger Internals system view on page 5-68.

### 5.2.2 Load Debug Symbols...

To load only the symbols of an image onto one or more processors, select **Load Debug Symbols...** from the **File** menu. The resulting dialog is shown in Figure 5-11.

![Figure 5-11 Load Debug Symbols dialog](image)

Use this if the debug information is separate from the image, for example after using **Load Image From File** to load an image or if you are debugging an image in ROM.
Leave the **Enable flat profiling** check box unchecked if you do not intend to collect any profiling information from this image. When you enable profiling at load time, you are then able to start and stop the collection of profiling information during execution of the image (see *Profiling* on page 4-27).

### 5.2.3 Reload Current Image

Having finished executing an image, the simplest way of preparing it for re-execution is to reload it.

To reload the current image file, select **Reload Current Image** from the **File** menu.

You can change the profiling settings for the next execution from the Image Properties dialog (see Figure 5-65 on page 5-52).

### 5.2.4 Open File...

To examine the contents of a source file, select **Open File...** from the **File** menu. The resulting dialog is shown in Figure 5-12.

Navigate to the directory where the file is stored. You can specify that only files with a particular filename extension are offered for selection.

You can examine any source file by this means, but it does not form part of the current debugging context. Access permission is read-only, so you cannot change the contents of a source file.
5.2.5 Load Memory From File...

To load the contents of a file into memory, select **Load Memory From File...** from the **File** menu. The resulting dialog is similar to the one shown in Figure 5-13.

![Figure 5-13 Loading memory from file](image)

Specify in the Address field the memory address at which to start loading the contents of the selected file. You can enter addresses in a variety of formats, as described in *Entering addresses* on page 4-12.

5.2.6 Save Memory To File...

To save the contents of an area of memory to a disk file, select **Save Memory To File...** from the **File** menu. The resulting dialog is shown in Figure 5-14 on page 5-11. This dialog enables you to specify the:

- starting address of the area of memory to save
- number of bytes of memory to save
- name of a file in which to save it.

You can enter addresses in a variety of formats, as described in *Entering addresses* on page 4-12.

If more than one processor is available the Processors list identifies them and enables you to select which one is to have part of its memory saved.
Select the directory where you want to store the file containing the saved data. You can either select an existing filename or specify a new one. You also select a file type, which determines the filename extension given to any new file. If you select an existing file, the data you save overwrites the current contents of the file.

![Figure 5-14 Saving memory contents in a file](image)

No data conversion or formatting takes place. The file contains an exact copy of the contents of the specified memory range.

There is a limit of 16MB on the amount of memory you can specify for saving in a single file. An error message appears if the Length value you enter is too great, and you can enter a smaller value.

### 5.2.7 Flash Download...

To write an image to the Flash memory chip on an ARM Development Board or other suitably equipped hardware:

1. Select **Flash Download** from the **File** menu. The resulting dialog is shown in Figure 5-15 on page 5-12.
2. In the Processor field, select the processor that has the Flash memory into which you want to load an image.

3. In the Action group you choose either to set an Ethernet address or to download an image. Select **Download** to make a copy in Flash memory of an image stored in a file.

4. Specify in the Image To Load data entry field the file that holds the image. You can use the **Browse** button to select an image file.

5. In the Loader Options field, you can specify command-line options for the loader program.

6. When you are satisfied with all the settings, click **OK** to start the download.

If you are using Angel with Ethernet support, you can also set its Ethernet address. After writing an image to Flash memory, select **Set Ethernet Address**, click **OK**, and you are prompted for the IP address and netmask, for example 193.145.156.78. You do not have to do this if you have built your own Angel port with a fixed Ethernet address.

See Appendix D *Using the Flash Downloader* for more information on Flash downloading.

### 5.2.8 Load Session...

Select **Load Session**... from the **File** menu to load a previously saved session file. The session file contains information about the state of the debugger at the time it was saved. The resulting dialog is shown in Figure 5-16 on page 5-13.
Locate the directory that holds the required .ses file, select it, and click the Open button.

If the session you want to resume was a recent session, the session file you require might still be in the most recently used list. See Recent Sessions on page 5-14.

5.2.9 Save Session...

To save the current debug session so that you can reuse it at a later time, select Save Session... from the File menu. The resulting dialog is shown in Figure 5-17.

Change to the directory where you want to store the session file, and specify the name of the file to be written. It is usual for session files to have a .ses filename extension. If the file you specify already exists, you are given the choice of overwriting it or specifying another file.
5.2.10 Recent Files

If you have opened any files by selecting **Open File**... from the **File** menu and using the resulting browse dialog, you can reopen any of the few most recently opened more easily by selecting **Recent Files**.

A submenu lists the files you have already opened and you can click on any filename in the list to open that file again.

To change the number of files that can appear in the list, select **Options** → **Configure Interface** → **General**, set a new value for Recent File List size, and click **OK**.

5.2.11 Recent Images

If you have loaded any images from disk files, using the Load Image dialog, then the filenames most recently used are available to you.

To display a list of recently loaded image files, select **Recent Images**. A submenu lists the filenames and you can click on any filename in the list to load that image again.

If your target has multiple processors, a dialog is displayed, enabling you to select one or more processors on which you want to load the image.

To change the number of files that can appear in the list, select **Options** → **Configure Interface** → **General**, set a new value for Recent Image List size, and click **OK**.

5.2.12 Recent Symbols

If you have opened any symbols files by selecting **Load Debug Symbols**... from the **File** menu and using the resulting browse dialog, you can reopen any of the few most recently opened more easily by selecting **Recent Symbols**.

A submenu lists the files you have already opened and you can click on any filename in the list to open that file again.

To change the number of files that can appear in the list, select **Options** → **Configure Interface** → **General**, set a new value for Recent Symbols List size, and click **OK**.

5.2.13 Recent Sessions

If you have saved any earlier sessions, using the Save Session dialog, then the session files most recently used are available to you.

To display a list of recently loaded session files, select **Recent Sessions**. A submenu lists the filenames and you can click on any filename in the list to restore that session to the state it was in when it was saved.
To change the number of files that can appear in the list, select **Options → Configure Interface → General**, set a new value for Recent Session List size, and click **OK**.

### 5.2.14 Unload Current Image

To remove the current image from the target, select **Unload Current Image** from the **File** menu.

As an example, when you are debugging an image loaded in one area of memory you might want to load another image into a disjoint area of memory. The second load does not unload the first image because they can both coexist. You have to unload the first image manually.

### 5.2.15 Import Formats...

To import your own format definitions, select **Import Formats** from the **File** menu. The resulting Import Formats browse dialog enables you to locate and select a `.sdm` file. This is a supplementary display module that can include format definitions. Supplementary display modules are usually supplied by ARM Limited if required.

### 5.2.16 Exit

To close all files and stop execution of AXD, select **Exit** from the **File** menu.
5.3  Search menu

The Search menu, shown in Figure 5-18, enables you to search for specific contents, either in a source file related to a current process or in memory.

![Figure 5-18 Search menu](image)

The Search menu items are described under the following headings:

- **Source...**
- **Memory...**

5.3.1  Source...

To search for a given character string in a source file, select **Source...** from the Search menu. A dialog, shown in Figure 5-19, enables you to specify the target character string, and the file to be searched.

![Figure 5-19 Searching for a string in a source file](image)

You can search upwards or downwards, and specify case sensitivity, whether whole words only must be considered, and whether after reaching one end of the file the search continues from the other end.

When you start the search, a listing of the source file shows the lines surrounding the first occurrence of the target string, with the characters highlighted. The **Find Next** button enables you to search for the next occurrence.

5.3.2  Memory...

To search for a given value in memory, select **Memory...** from the Search menu. A dialog, shown in Figure 5-20 on page 5-17, enables you to specify what to search for and where to search.
Specify the processor associated with the memory you want to search in the Processor field. The drop-down list identifies all the processors on the target and you select the one you want. Specify the first and last addresses of the area of memory you want to search in the In range and to fields. You can enter addresses in a variety of formats, as described in *Entering addresses* on page 4-12.

Specify the target value you are searching for in the Search for field. You can search for any string of up to 200 characters, using either ASCII or hexadecimal notation. Make sure you select the correct **Search string type** radio button to indicate which format you are using. The drop-down selection list contains recent search strings, making it easy for you to search again for a string you have already specified.

When you start the search, a display of the contents of memory shows the area surrounding the first occurrence of the target string, with that string highlighted. The **Find Next** button enables you to search for the next occurrence.

The value searched for is the string of bytes that you specify, in either ASCII or hexadecimal notation, and can be of any number of bytes in length. The contents of consecutive bytes of memory are compared with the target string.

**Note**

The byte order that you set (by selecting **Properties**... from the **Memory** pop-up menu) can affect the order in which bytes are displayed. This means that bytes can be displayed in a different order from that in which they are stored.
5.4 Processor Views menu

The Processor Views menu, shown in Figure 5-21, enables you to examine and change information relating to specific processors.

![Processor Views menu](image)

If you are licensed to use the Trace Debug Tools (TDT) and your target processor supports trace, the Processor Views menu also shows the Trace option (see Trace processor view on page 5-47).

All data you display and any changes you make are on the processor currently selected in the Control system view (see Control system view on page 5-49). The title bar of each processor view identifies the processor being viewed.

When you select a Processor Views menu item, a new processor view opens on the currently selected processor. If you select a processor view that is already open and displayed, it does not change. If you select a processor view that is already open and hidden, it is displayed.

You can examine one processor with any number of the available processor views. You can open a particular processor view as many times as necessary to examine all available processors. A separate viewing window appears on the screen for each view of each processor.

If you are displaying a number of processor views of the same type, with each one related to a different processor, consider using a corresponding system view instead (see System Views menu on page 5-48).

You can display a pop-up menu by right-clicking when the mouse pointer is inside any processor view. If the mouse pointer is on a selectable item in the view when you right-click, then that item is selected. Certain pop-up menu items are enabled only when a view item is selected, and apply to that item only.

The description of each processor view includes a reproduction of its pop-up menu. Online help gives further details.
The Processor Views menu items are described under the following headings:

- Registers processor view
- Watch processor view on page 5-23
- Variables processor view on page 5-26
- Backtrace processor view on page 5-29
- Memory processor view on page 5-31
- Low Level Symbols processor view on page 5-35
- Comms Channel processor view on page 5-37
- Console processor view on page 5-39
- Disassembly processor view on page 5-40
- Source... processor view on page 5-44
- Trace processor view on page 5-47.

5.4.1 Registers processor view

The Registers processor view enables you to examine the value of any of the registers in a specific processor. It also enables you to change any of these values, unless you are debugging an Angel target when you can change the registers of the current mode only.

Ensure that the required processor is selected in the Control processor view before you display a Registers processor view. Each Registers processor view shows its processor name near the top left corner.

A typical Registers processor view is shown in Figure 5-22.

Figure 5-22 Registers processor view
The registers are shown in named groups, to reflect the typical grouping of registers into banks. Click on the + or – boxes to expand or collapse each level of the displayed tree structure, but see Viewing structured data on page 2-9.

The crossed-out eye symbol is not usually present. It is displayed if you try to refresh the display of register values while the program is running, with timed refresh enabled for example, and reminds you that this is not possible. Only the Memory processor view can show values changing while the program is running.

Double-click on the value of any register that you want to change. In-place editing is invoked whenever possible, otherwise a dialog is displayed. Double-clicking on the value of a Program Status Register (PSR), for example, displays the dialog shown in Figure 5-23.

![Figure 5-23 Program Status Register dialog](image)

ARM processors that have an extra bit (Q, signifying saturation) in the program status register require an Enhanced PSR (EPSR) format. This displays the extra bit in the Registers processor view, and editing the value of that register displays the dialog shown in Figure 5-24.

![Figure 5-24 Enhanced Program Status Register dialog](image)

ARM processors that are Jazelle-capable have an extra bit (J, signifying Jazelle state) in the program status register and require a Jazelle PSR (JPSR) format. This displays the extra bit in the Registers processor view, and editing the value of that register displays the dialog shown in Figure 5-25 on page 5-21.
Whenever AXD can determine the most suitable format for displaying a program status register, it does so automatically. If AXD is unable to determine the most suitable format, EPSR is used by default. To change the display format for a program status register, select one from the Registers submenu of the Format menu item in the Registers processor view pop-up menu.

For more information about data display formats and data entry formats, see Data formatting on page 4-16.

To add one of the registers displayed in a Registers processor view to the Registers system view (see Registers system view on page 5-54), right-click on the required register to select it and display the pop-up menu, then select Add to System (see Registers processor view pop-up menu).

**Registers processor view pop-up menu**

To display the Registers pop-up menu, shown in Figure 5-26, right-click within the Registers processor view.
The Add To System, Format, and Locate Using Value menu items are enabled only when you right-click on a selectable item in the processor view, and then they apply to the selected item only.

**Format**  
Select Format to see a list of all the available formats in which you can display the item currently selected in the Registers processor view, as shown in Figure 5-27.

![Figure 5-27 Formats available for displaying registers](image)

See Data formatting on page 4-16 for details of the formats available.

**Locate Using Value**  
The Locate Using Value menu item functions as described in Watch processor view pop-up menu on page 5-24.

**Refresh**  
Select Refresh to update and recalculate the displayed data values. A Registers processor view cannot be refreshed while an image is executing. This item is useful if the target supports RealMonitor. See also Refresh All on page 5-99.

**Properties...**  
Select Properties... to display the Default Display Options dialog shown in Figure 5-28 on page 5-23.
Figure 5-28 Default Display Options dialog

With this dialog you control the default display format, and choose whether any change you make applies to all the displayed data items or to only those that currently use the default format. Click the Help button in the dialog to display more information.

If you hide a Registers processor view then later select it again, it reappears in the state it was in when you hid it.

If you close a Registers processor view then later select it again, it is displayed as though you are selecting it for the first time.

5.4.2 Watch processor view

The Watch processor view enables you to examine the value of variables, or of expressions dependent on variables, in an image being executed by a specific processor.

Select the required processor in the Control system view before you display a Watch processor view. Each Watch processor view shows its processor name near the top left corner.

A Watch processor view is initially empty. You choose what is to be listed and have its value shown. One way to add lines to a Watch processor view is to select one or more items in a Variables processor view, then right-click and select Add to Processor Watch from the resulting pop-up menu.

Another way to add a line is to select Add Watch from the pop-up menu (see Figure 5-30 on page 5-24). Your specification of what is to be watched is shown in the first column, and its value is evaluated and shown in the second column each time program execution in the relevant processor stops. (When using certain processors, execution does not have to stop. See RealMonitor support on page 4-14.)
To define what is to be watched, you enter an expression. An expression can be the name of a variable, and that is often all you require. More complex expressions are allowed, however, and might include logical and arithmetic operators, in addition to the names of variables and constants.

If the displayed data has a tree structure, click on the + or – boxes to expand or collapse each level of the structure, but see Viewing structured data on page 2-9.

A typical Watch processor view is shown in Figure 5-29. For more information about data display formats and data entry formats, see Data formatting on page 4-16.

```
<table>
<thead>
<tr>
<th>Watch</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inst_2_Loc</td>
<td>0x00000000</td>
</tr>
<tr>
<td>Run_Index</td>
<td>0x00000000</td>
</tr>
<tr>
<td>2 * Inst_2_Loc - Run_Index</td>
<td>0xffffffff</td>
</tr>
</tbody>
</table>
```

Figure 5-29 Watch processor view

The four tabbed pages enable you to define up to four lists of expressions to watch in any one processor. Click on the tab of the page you want to view.

**Watch processor view pop-up menu**

To display the Watch pop-up menu, shown in Figure 5-30, right-click within the Watch processor view.

```
Add To System Watch
Edit Watch...
Format
Locate Using Value
Locate Using Address
Any Expression...
Refresh
Properties...
```

Figure 5-30 Watch processor view pop-up menu

If you have selected an item in the Watch processor view, you can click on Add to System Watch to add that item to those displayed in a Watch system view (see Watch system view on page 5-55).
One way of defining a new watch for the Watch processor view is to select **Add Watch** from the pop-up menu. The resulting dialog is shown in Figure 5-31.

![Add Watch dialog](image)

**Figure 5-31 Add Watch dialog**

Enter a new expression to watch. Specify the processor, whether the new watch must be added to the Watch processor view or system view (see **Watch system view** on page 5-55), and on which tabbed page it must appear. Figure 5-31 shows **Tab 1** of the Watch processor view as the chosen destination. By default, the **Tab** radio button selected reflects the current tabbed page in the Watch processor view.

Click the **Evaluate** button to evaluate the expression. Either the result of the evaluation or an error message appears in the main pane of the dialog. You can build up a list of expressions and their values. Select any one of the displayed expressions and click the **Add To View** button to add that expression to the specified view (Watch processor view or Watch system view). To see the address of a variable in addition to its value, enter & in front of its name.

From the Watch processor view (as shown in Figure 5-29 on page 5-24) you can select a data item and use the Watch processor view pop-up menu to examine it in more detail.

**Locate Using Value**

Select **Locate Using Value** or **Locate Using Address** if you want to examine an area of memory. Selecting this option means that only the 32 least significant bits of the value of the selected item are used as the required memory address. A Memory Locate view is displayed, very similar in appearance to the view described in **Memory processor view** on page 5-31, with the selected memory address in view. If an existing tabbed page in a Memory processor view already includes the required
address (and is not the page from which the request originates), that page is displayed. If no existing tabbed page is suitable, the least recently selected tabbed page is used to display the required region of memory.

**Locate Using Address**

Selecting this option is similar to **Locate Using Value** and enables you to examine an area of memory in a Memory Locate view. Selecting this option, however, uses the address of the selected item as the required memory address.

**Array Expansion...**

Select **Array Expansion...** to display an Array Expansion dialog, either when you are about to expand an array or when you want to display a different range of elements in an array that is already expanded. This dialog enables you to choose either to display all elements or to specify the first and last element numbers to display. Array elements are numbered from zero. A 50-element array, for example, contains elements numbered 0 to 49. By default, elements 0 to 15 (the first 16 elements) only are displayed when you expand any array with more than 16 elements.

**Refresh**

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.

**Properties...**

Select **Properties...** to display the Default Display Options dialog shown in Figure 5-28 on page 5-23. With this dialog you control the default display format, and choose whether any change you make applies to all the displayed data items or to only those that currently use the default format. Click the **Help** button in the dialog to display more information.

If you hide a Watch processor view then later select it again, it reappears in the state it was in when you hid it.

If you close a Watch processor view then later select it again, it is displayed empty, as though you are selecting it for the first time.

### 5.4.3 Variables processor view

The Variables processor view enables you to examine and change the value of any of the listed variables.
Click on the appropriate tab to display:

- **Local** variables, those with scope within the current function
- **Global** variables, those with scope over all parts of the program
- **Class** variables, those with scope within the current class only.

A Variables processor view is shown in Figure 5-32, with its **Local** tab selected.

![Variables processor view](image)

Click on the + or – boxes to expand or collapse each level of the displayed tree structure, see **Viewing structured data** on page 2-9.

Double-click on the value of any variable that you want to change. In-place editing is invoked whenever possible, otherwise a dialog is displayed. For more information about data display formats and data entry formats, see **Data formatting** on page 4-16.

**Variables processor view pop-up menu**

To display the Variables pop-up menu, shown in Figure 5-33 on page 5-28, right-click within the Variables processor view.
If the mouse pointer is on a selectable line when you right-click, then that line is selected. The items in the top group of the pop-up menu apply to the selected line only. If no line is selected, those items are disabled.

You can select more than one displayed item by left-clicking while holding down the Shift or Ctrl key. A right-click on one of the selected items then displays the pop-up menu and any resulting actions apply to all the selected items.

The Locate Using Value, Locate Using Address, and Array Expansion... menu items function as described in Watch processor view pop-up menu on page 5-24.

**Add To Processor Watch**

Select Add To Processor Watch to add the selected variable(s) to a Watch processor view (see Watch processor view on page 5-23).

**Add To System Watch**

Select Add To System Watch to add the selected variable(s) to a Watch system view (see Watch system view on page 5-55).

**Refresh**

Select Refresh to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also Refresh All on page 5-99.

**Properties...**

Select Properties... to display the Default Display Options dialog shown in Figure 5-28 on page 5-23. With this dialog you control the default display format, and choose whether any change you make applies to all the displayed data items or to only those that currently use the default format. Click the Help button in the dialog to display more information.

If you hide a Variables processor view then later select it again, it reappears if possible with the same tab selected and the same levels expanded as when you hid it. The content depends on the current execution context (the address stored in the program counter).
If you close a Variables processor view then later select it again, it is displayed as though you are selecting it for the first time.

5.4.4 Backtrace processor view

The Backtrace processor view enables you to examine the call stack of the current image in a specific processor.

Select the required processor in the Control system view before you display a Backtrace processor view. Each Backtrace processor view shows its processor name near the top left corner.

A typical Backtrace processor view is shown in Figure 5-34.

![Figure 5-34 Backtrace processor view](image)

Each entry in the displayed list shows the function context of a single stack frame. The entries are ordered with the current stack frame at the top. An entry contains the address or the name of a function, and the types of the parameters with which it was called. An address is displayed instead of a name if the address is not in a range described by a symbol table or image.

It is possible for an application program to overwrite and damage the call stack. A line showing \(--\)\(--\)\(--\)\(--\)\(--\)\(--\) indicates that an inconsistency has been detected and the call stack is considered broken. This might be due, for example, to the use of inline calls.

A stack discontinuity can also result from a call to another image if the debug symbol table of the called image is not available to the debugger. A call to an operating system function is an example. You can display a complete call stack if you first load the debug symbol tables of all the images your program calls. See *Load Debug Symbols...* on page 5-8.

When the selected processor is in Jazelle state, the Backtrace processor view contains only a single entry, shown in Figure 5-35 on page 5-30. This entry is given as an offset from the nearest previous low-level symbol.
Backtrace processor view pop-up menu

To display the Backtrace pop-up menu, shown in Figure 5-36, right-click within the Backtrace processor view.

If the mouse pointer is on a selectable line when you right-click, then the line is selected. The items in the top group of the pop-up menu apply to the selected line only. If no line is selected, those items are disabled.

The Locate Using Address menu item functions as described in Watch processor view pop-up menu on page 5-24.

Select Refresh to refresh the call stack. This is necessary only when Automatic Refresh is unselected in the Backtrace Properties dialog. If Automatic Refresh is selected, the call stack is refreshed automatically but this can impose a significant processing overhead.

To display the dialog shown in Figure 5-37 on page 5-31, select Properties... from the pop-up menu.
5.4.5 Memory processor view

The Memory processor view enables you to examine and change the contents of specific memory addresses.

Memory is made available to you in pages. The default size of a page is 1024 bytes, but you can change this value by selecting Properties... from the Memory pop-up menu.

The area of memory visible depends on the size that you make the processor view window. If less than one page of memory is visible, scroll bars enable you to view other parts of the current page. A typical view of an area of memory is shown in Figure 5-38.

You can specify the Start address in a variety of formats, as described in Entering addresses on page 4-12.

Generally, each line represents 16 bytes of memory. The address of the first byte is shown at the left. Using Properties... from the Memory pop-up menu, you can set this to be either the absolute address or the zero-based offset from the beginning of the
current page. The contents of the 16 bytes of memory occupy most of each line. You can
display these as four 32-bit words, eight 16-bit half-words, or sixteen 8-bit bytes. In the
last case, the ASCII characters corresponding to the 16 bytes are shown at the right of
the line.

The four tabbed pages enable you to define up to four memory areas of interest and to
switch easily from one to another. The memory area covered by each tabbed page is one
page long, and starts at the address you specify in the Start Address field near the top of
the view. The areas you define can overlap, or be contiguous, or be separate.

The size of the displayed words and their display format are among the settings you can
change using the Memory processor view pop-up menu. You can use different settings
on each of the four tabbed pages of the view. The column widths change automatically
to suit the format you select. If you specify a printf format without specifying a width
parameter, then the display uses a column width of 10 characters plus any decoration
characters you specify.

A breakpoint is highlighted in red, or in gray-red if it is disabled. A watchpoint is
highlighted in green, or gray-green if it is disabled.

The Memory processor view also enables you to examine memory on a processor
running in Jazelle state, shown in Figure 5-39 on page 5-33. You can set the display
format for the first tabbed page to ByteCode using the Memory pop-up menu.

You can open multiple memory views, even on a single processor, if you want more than
four tabbed pages. For more information about data display formats and data entry
formats, see Data formatting on page 4-16.
Figure 5-39 Memory processor view in Jazelle state

Memory processor view pop-up menu

To display the Memory pop-up menu, shown in Figure 5-40, right-click within the Memory processor view.

Figure 5-40 Memory processor view pop-up menu
The **Locate Using Value** menu item functions as described in *Watch processor view pop-up menu* on page 5-24.

**Format**  
Select **Format** from the Memory processor view pop-up menu to display the submenu, shown in Figure 5-41, to set the display format. You can use different settings on each of the four tabbed pages of the view.

![Figure 5-41 Memory processor view formats](image)

**Toggle Breakpoint**

Select **Toggle Breakpoint** to toggle a breakpoint at the address defined by the current cursor position. If a breakpoint already exists at this address it is deleted. If no breakpoint exists at this address a default breakpoint is created here.

**Toggle Watchpoint**

Select **Toggle Watchpoint** to toggle a watchpoint at the address defined by the current cursor position. If a watchpoint already exists at this address it is deleted. If no watchpoint exists at this address a default watchpoint is created here.

A new watchpoint set in this way from the Memory processor view can watch for changes in the value stored in one or more bytes of memory. If the tabbed page of the Memory processor view is configured to display 8-bit, 16-bit, or 32-bit values, then 1, 2, or 4 bytes respectively are watched. If a block of memory locations is selected when you create a new watchpoint with **Toggle Watchpoint**, then all the highlighted locations are watched.

**Refresh**

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also *Refresh All* on page 5-99.

See AXD online help for details of the other Memory pop-up menu items, including the Memory Properties dialog, shown in Figure 5-42 on page 5-35.
Data width for memory reads and writes

The Target Access group of radio buttons in the Memory Properties dialog enables you to specify the width of data read from or written to memory. Unless you have a particular requirement, use the **Def** setting to indicate that you want the debugger to decide.

### 5.4.6 Low Level Symbols processor view

The Low Level Symbols processor view enables you to examine the low-level symbols of the current image in a specific processor.

Select the required processor in the Control system view before you display a Low Level Symbols processor view. Each Low Level Symbols processor view shows its processor name near the top left corner.

A typical Low Level Symbols processor view is shown in Figure 5-43 on page 5-36.
The left column shows addresses and the right column shows symbol strings. Use the pop-up menu, or click on the column heading, to sort the list by address order or by symbol name order.

If you hide a Low Level Symbols processor view then later select it again, it reappears in the state it was in when you hid it.

If you close a Low Level Symbols processor view then later select it again, it is displayed as though you are selecting it for the first time.

**Low Level symbols processor view pop-up menu**

To display the Low Level Symbols pop-up menu, shown in Figure 5-44, right-click within the Low Level Symbols processor view.

If the mouse pointer is on a selectable line when you right-click, then that line is selected. The items in the top group of the pop-up menu apply to the selected line only. If no line is selected, those items are disabled.

The **Locate Using Address** menu item functions as described in **Watch processor view pop-up menu** on page 5-24.
See AXD online help for more details of these menu items.

5.4.7 Comms Channel processor view

The Comms Channel processor view enables you to examine data that passes to and from the debugger target along the Debug Communications Channel (DCC), and to send data of your own. AXD has its own built-in DCC viewer. If your target offers, for example, the file ThumbCV.dll as a DCC viewer, do not select it.

The Comms Channel Viewer processor view is shown in Figure 5-45. You can enable or disable the debug communications channel by checking or clearing a check box on the Comms Channel Properties dialog available from the Comms Channel Viewer pop-up menu (see Comms Channel Viewer pop-up menu on page 5-38) or on the Processor Properties dialog (see Configure Processor... on page 5-95 or Control system view pop-up menus on page 5-50).

![Figure 5-45 Comms Channel Viewer processor view](image)

Use the Send group of this window to send information down the channel. Type information in the edit box and click the Send button to store the information in a buffer. The information is sent when requested by the target, in ASCII character codes. The Left to send counter displays the number of bytes that are left in the buffer.

By default, the information received by the Comms Channel Viewer is displayed using the Auto-Toggle format. This converts the information into ASCII character codes and displays it in the Receive pane, if the channel viewer is active.

However, if 0xFFFFFFFF is received, the Auto-Toggle format displays the following words as a hexadecimal number. On the next occurrence of 0xFFFFFFFF the Auto-Toggle format switches and information is again converted into ASCII character codes. In this way, 0xFFFFFFFF is used to toggle between the different formats.
You can display received information in other formats, as described in Comms Channel Viewer pop-up menu.

**Comms Channel Viewer pop-up menu**

To display the Comms Channel Viewer pop-up menu (see Figure 5-46), right-click anywhere in the Comms Channel processor view except in the Send edit area or the Receive pane.

Receive log file...
Select this option to specify a file where data received from the target is stored.

Send from file...
Select this option to specify a text file where data is stored ready to be sent to the target.

Clear Send Buffer
Select this option to flush the send buffer and to close an input file if used.

Format
Select this option to display the submenu shown in Figure 5-47.

![Figure 5-46 Comms Channel Viewer pop-up menu](image-url)

![Figure 5-47 Comms Channel Viewer formats](image-url)
When you select any format except Auto-Toggle (the default), information received is shown in columns. Your choice of format determines the initial column width, but you can change the column widths by using the mouse to drag the column header dividers to the left or right.

Properties... Select Properties... from the Comms Channel Viewer pop-up menu to display the dialog shown in Figure 5-48.

Properties dialog

The Comms Channel Properties dialog is used to enable the Comms Channel Viewer and to specify how information from the Comms Channel is displayed.

AXD online help describes this and all the Comms Channel Viewer pop-up menu items.

5.4.8 Console processor view

You might want to debug an image that is intended to receive input from, or write output to, devices that are not yet available. The Console processor view provides the semihosting facility that enables you to do so.

Output from an executing image is displayed, and you can respond by entering data from your keyboard or from a file to provide input for the image.

A typical Console processor view is shown in Figure 5-49.

Console processor view
Console processor view pop-up menu

To display the Console processor view pop-up menu, shown in Figure 5-50, right-click within the Console processor view.

See AXD online help for more details of these menu items.

5.4.9 Disassembly processor view

The Disassembly processor view displays not only the contents of regions of memory but also the assembler code instructions that correspond to those contents.

A typical Disassembly processor view is shown in Figure 5-51. This is the display format you see if you have both Show margin and Show addresses selected on the Properties dialog obtained from the pop-up menu (see Figure 5-55 on page 5-43).

You can see the low-level symbols in the margin and a blue arrow shows the current execution point. Any breakpoints are marked with a red disc.
A Disassembly processor view for a Jazelle-capable processor is shown in Figure 5-52. This is the display format you see if you select **ByteCode** from the **Disassembly Mode** option on the pop-up menu (see Figure 5-54 on page 5-43).

![Figure 5-52 Disassembly processor view in Jazelle state](image)

When running your image on a Jazelle-capable processor, there are circumstances that might result in erroneous disassembly. This is because, unlike ARM or Thumb code, bytecodes are of variable length and so disassembly can become unsynchronized. In this case low-level symbols might not be displayed correctly where the disassembly is out of synch.

--- **Note** ---

If an area of erroneous disassembly includes the execution address then the blue arrow indicator is not shown in the Disassembly processor view.

---

**Disassembly processor view pop-up menu**

To display the Disassembly pop-up menu, shown in Figure 5-53 on page 5-42, right-click within the Disassembly processor view.
To display a submenu duplicating the items you are most likely to want from the **Execute** main menu, select **Execute** on the pop-up menu. See **Execute menu** on page 5-75 for details of all but one of these items.

**Set Next Statement** is the item that appears on the **Execute** submenu and not in the **Execute** main menu. To resume execution at a specific statement, without executing any intervening statements, right-click on the required statement in the Disassembly processor view, select **Execute** in the pop-up menu, and select **Set Next Statement**.

To display a submenu enabling you to change the setting of the stepping mode, select **Stepping Mode** on the pop-up menu. The stepping modes available are:

- **Disassembly**
  - This steps always in disassembly instructions.
- **Strong Source**
  - This steps always in source code statements.
- **Weak Source**
  - This steps in source code statements if possible. This is the default setting.
    - If the image contains no debug information, stepping is by disassembly instructions.
    - If the image contains debug information, but the source files are not accessible, stepping is by instructions corresponding to source lines.

To display a submenu enabling you to change the setting of the code used for disassembly, select **Disassembly Mode** on the pop-up menu, shown in Figure 5-54 on page 5-43. This enables you to display the disassembled code in ARM/Thumb, or ARM, or Thumb, or ByteCode format. If you choose ARM/Thumb then AXD displays the code depending on what the image contains.
Figure 5-54 Disassembly Mode formats submenu

**Toggle Breakpoint**

Select this option to set or delete a breakpoint at the current cursor position.

**Toggle Watchpoint**

Select this option to set or delete a watchpoint at the current cursor position.

**Set PC**

Select this option to reset the program counter so that the instruction at the current cursor position is the next instruction to be executed.

**Refresh**

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.

**Properties...**

Select this option to display the View Properties dialog shown in Figure 5-55.

See AXD online help for more details of all the items on the pop-up menu.
5.4.10 Source... processor view

The Source... processor view first displays a file selection dialog, similar to that shown in Figure 5-56.

![Figure 5-56 Source file selection](image)

This lists all source files that have contributed debug information to the current image (not necessarily all source files used to build the image). Select a filename and click the OK button to display the file. If the file is not in the expected place, another dialog enables you to specify where it is or browse to find it.

The Source... processor view displays the source file as specified. To display the Source... processor view pop-up menu, shown in Figure 5-58 on page 5-45, right-click within the view.

Figure 5-57 on page 5-45 shows the kind of source file listing you see if you select Interleave disassembly from the pop-up menu.

You can set a breakpoint by double-clicking on a line number or address at the left side of the display, or by right-clicking in a line and selecting Toggle Breakpoint from the pop-up menu. You can set a breakpoint on a procedure exit by double-clicking on the line number of the line containing the closing bracket of the procedure.
Interleaved disassembly code sometimes includes lines containing six dots (......). These lines indicate breaks in the sequence of execution because of inline code expansion and compiler optimization settings. The memory address displayed at the beginning of each line helps you to see how your source code is compiled.

**Source... processor view pop-up menu**

To display the pop-up menu shown in Figure 5-58, right-click within the Source... processor view.
To display a submenu duplicating the items you are most likely to require from the Execute main menu, select Execute on the pop-up menu. See Execute menu on page 5-75 for details of all items except Set Next Statement.

Set Next Statement is the item that appears on the Execute submenu and not in the Execute main menu. To resume execution at a specific statement, without executing any intervening statements, right-click on the required statement in the Source... processor view, select Execute in the pop-up menu, and select Set Next Statement.

To display a submenu enabling you to change the setting of the stepping mode, select Stepping Mode on the pop-up menu. The stepping modes available are:

- **Disassembly**: This steps always in disassembly instructions.
- **Strong Source**: This steps always in source code statements.
- **Weak Source**: This steps in source code statements if possible. This is the default setting.
  - If the image contains no debug information, stepping is by disassembly instructions.
  - If the image contains debug information, but the source files are not accessible, stepping is by instructions corresponding to source lines.

To activate or deactivate a breakpoint at the current cursor position, select Toggle Breakpoint from the pop-up menu. To set or replace a watchpoint on a currently selected item, select Set Watchpoint from the pop-up menu.

To display the dialog shown in Figure 5-59, select Properties... from the pop-up menu.

![Figure 5-59 Source View Properties dialog](image)

See AXD online help for more details of all the items on this pop-up menu.
5.4.11 Trace processor view

The *Trace Debug Tools* (TDT) is part of the ARM Real Time Trace solution for debugging. If you are licensed to use this product, and your target processor supports trace, the Trace option is also available on the Processor Views menu.
5.5 System Views menu

System views are not specific to any processor. Some show information about the whole system. Others help you reduce the number of views you need to display.

A Registers system view, for example, can show registers that are associated with several processors. You can examine in a single system view registers that otherwise require multiple processor views. In a system view, the processor to which each line is related is identified in the display.

Selecting a System Views menu item generally toggles that view. That is, the selected system view is opened if it is currently closed or hidden, or hidden if it is currently open. System views that are open are checked on the menu. Figure 5-60 shows an example of a System Views menu.

![Figure 5-60 System Views menu](image)

Each system view has a pop-up menu you can display by right-clicking when the mouse pointer is inside the system view. If the mouse pointer is on a selectable line in the system view when you right-click, then that line is selected. Certain pop-up menu items are enabled only when a line is selected, and apply to that line only.

The description of each system view includes a reproduction of its pop-up menu. Online help gives further details.

The System Views menu items are described under the following headings:

- Control system view on page 5-49
- Registers system view on page 5-54
- Watch system view on page 5-55
- Breakpoints system view on page 5-58
- Watchpoints system view on page 5-60
- Output system view on page 5-63
- Command Line Interface system view on page 5-64
- Debugger Internals system view on page 5-68.
5.5.1 Control system view

The Control system view shows details of all current processors, and enables you to examine this information in several ways. Tabbed pages available are:

- Target
- Image
- Files
- Class.

Figure 5-61 shows a Control system view with its Files tab selected.

Expand or collapse each level of the displayed tree structure by clicking on the + or – boxes.

The tabbed pages contain the following information:

- **Target**: Lists the processors on the target. Where a processor has an associated module, such as a coprocessor or ETM, the processor entry is expanded and the module is shown as a child. You cannot expand a child entry any further.
  
  One processor can be designated the current processor. If so, it is indicated by a green arrow in the display. Commands you issue apply by default to the current processor. For example, when you select an item from a menu in the main menu bar it applies to the current processor.
  
  One processor can be designated the selected processor. If so it is indicated by being highlighted in blue in the display. You select a processor by clicking on its name. When you select a menu item from a pop-up menu it applies to the selected processor.
  
  Whenever possible, the current processor is the selected processor.

- **Image**: Lists the images loaded in the memory of the target. Expand an image node to show the processor with which the image is associated.
One image can be designated the current image. If so, it is indicated by a green arrow in the display. Commands you issue apply by default to the current image. For example, when you select an item from a menu in the main menu bar it applies to the current image.

One processor can be designated the selected image. If so it is indicated by being highlighted in blue in the display. You select an image by clicking on its name. When you select a menu item from a pop-up menu it applies to the selected image.

**Files**
Lists the files associated with all the images on the target. Expand an image node to show the files associated with that image.

**Class**
Lists the classes associated with all the images on the target. Expand an image node to show a globals node, and a class node if the image contains any class information. Expand the globals node to show a list of global functions and global variables. Expand a class node to show a list of classes contained in the image. Expand a class to show a list of member functions and member variables.

**Control system view pop-up menus**

When you right-click in a Control system view, the pop-up menu that appears depends on which tabbed page is currently selected and which item on that page is currently selected.

The items you can select on each tabbed page are as follows:
- on the **Target** tab, you can select a processor
- on the **Image** tab, you can select an image or a processor
- on the **Files** tab, you can select an image or a file
- on the **Class** tab, you can select an image, a function, or a variable.

If the mouse pointer is on a selectable line when you right-click, then that line is selected. Any pop-up menu items that do not apply to the selected line are disabled. Some of the pop-up menu items are equivalent to menu items from the menu bar.

Brief details follow of the Control pop-up menus. AXD online help gives more details.

**Processor pop-up menu**

With a processor selected, the pop-up menu is as shown in Figure 5-62 on page 5-51.
Figure 5-62 Pop-up menu when a processor is selected

Select Properties... from this pop-up menu to display the dialog shown in Figure 5-63.

Figure 5-63 Processor Properties dialog

For a description of this dialog, see Configure Processor... on page 5-95.

Image pop-up menu

With an image selected, the pop-up menu is as shown in Figure 5-64 on page 5-52.
If you select Properties... from this pop-up menu, the dialog shown in Figure 5-65 is displayed.

The Image Properties dialog enables you to specify Command-line arguments. These are the arguments you supply if you start execution of the image by entering a command at a command-line prompt. They are supplied to the program when you load, or reload, and execute it in AXD.

The Image Properties dialog also shows the Profiling settings that become effective the next time you load or reload an image. You can change these settings to be those you want when the next image execution begins. The settings shown are not necessarily those currently in force, because you might have changed them since the last load or reload operation.

**File pop-up menu**

With a file selected, the pop-up menu is as shown in Figure 5-66.

Select Source from this pop-up menu to display a Source processor view, showing the source code associated with the selected file.
**Function pop-up menu**

With a function selected, the pop-up menu is as shown in Figure 5-67.

![Figure 5-67 Pop-up menu when a function is selected](image)

Select **Properties...** from this pop-up menu to display the dialog shown in Figure 5-68.

![Figure 5-68 Function Properties dialog](image)

The Function Properties dialog shows the name and type of the function, and the parameters that it takes.

**Variable pop-up menu**

With a variable selected, the pop-up menu is as shown in Figure 5-69.

![Figure 5-69 Pop-up menu when a variable is selected](image)

If you select **Properties...** from this pop-up menu, the dialog shown in Figure 5-70 on page 5-54 is displayed.
The Variable Properties dialog shows the name and type of the variable.

### 5.5.2 Registers system view

The Registers system view can display registers from more than one processor. It also enables you to change any of these values, unless you are debugging an Angel target when you can change the registers of the current mode only.

If you want to see the values of a few registers in various processors change as your program executes, you can display the registers in a single Registers system view. This can avoid displaying a number of Registers processor views.

The registers are displayed in groups, under processor names and register bank names. Click on the + or – boxes to expand or collapse each level of the displayed tree structure, but see Viewing structured data on page 2-9.

Figure 5-71 shows a typical Registers system view.

Double-click on the value of any register that you want to change. In-place editing is invoked whenever possible, otherwise a dialog is displayed.

The crossed-out eye symbol is not usually present. It is displayed if you try to refresh the display of register values while the program is running, with timed refresh enabled for example, and reminds you that this is not possible. Only the Memory processor view can show values changing while the program is running.
Registers system view pop-up menu

To display the Registers pop-up menu, shown in Figure 5-72, right-click within the Registers system view.

![Figure 5-72 Registers system view pop-up menu](image)

Add Register

To add a register from any processor to those displayed in a Registers system view, select **Add Register** from the pop-up menu.

Format

If you right-click on a register line, it is selected. The **Format** menu item is enabled when a register line is selected, and applies to the selected line only.

*See Data formatting on page 4-16 for details of the formats available, and to AXD online help for other details of the Registers pop-up menu items.*

Locate Using Value

The **Locate Using Value** menu item functions as described in *Watch processor view pop-up menu* on page 5-24.

Refresh

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.

If you hide a Registers system view then select it, it reappears in the state it was in when you hid it.

If you close a Registers system view then select it, it is displayed empty, as though you are selecting it for the first time.

5.5.3 Watch system view

The Watch system view enables you to examine the value of variables, or of expressions depending on variables, in the images associated with various processors. You might require several processor views to see what you can display in a single system view.
A Watch system view is initially empty. You specify expressions. These expressions are evaluated each time program execution stops, and the values displayed. One way to add lines to this view is to select one or more items in a Variables processor view, then right-click and select **Add to System View** from the resulting pop-up menu.

Another way to add a line to the Watch system view is to select **Add Watch** from its pop-up menu to display an Add Watch dialog (see Figure 5-75 on page 5-57).

An expression can be the name of a variable. Expressions can also include logical and arithmetic operators in addition to the names of variables and constants. If the displayed data has a tree structure, click on the + or – boxes to expand or collapse each level of the structure, but see *Viewing structured data* on page 2-9.

A typical Watch system view is shown in Figure 5-73.

![Figure 5-73 Watch system view](image)

You can define lists of expressions to watch on up to four tabbed pages. Click the tab of a page to display it.

If you hide a Watch system view then select it, the view reappears in the state it was in when you hid it.

If you close a Watch system view then select it, the view is displayed empty, as though you are selecting it for the first time.

**Watch system view pop-up menu**

When you right-click in a Watch system view, the pop-up menu that appears depends on which item on that page is currently selected.

If the mouse pointer is on a selectable line when you right-click, then that line is selected. Any pop-up menu items that do not apply to the selected line are disabled.

To display the Watch pop-up menu, shown in Figure 5-74 on page 5-57, right-click within the Watch system view.
Figure 5-74 Watch system view pop-up menu

To display the dialog shown in Figure 5-75, select Add Watch from the pop-up menu.

![Add Watch dialog](image)

Figure 5-75 Add Watch dialog

Enter a new expression to watch. Specify the processor, whether the new watch must be added to the Watch processor view or system view, and on which tabbed page it must appear. Figure 5-75 shows Tab 1 of the Watch system view as the chosen destination. By default, the Tab radio button selected reflects the current tabbed page in the Watch system view. Select an expression and click the Evaluate button to see the result of its evaluation.

To add the selected expression to the chosen view, click the Add To View button.

The Locate Using Value, Locate Using Address, and Array Expansion... menu items function as described in Watch processor view pop-up menu on page 5-24.

Select Refresh to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also Refresh All on page 5-99.
To display the dialog shown in Figure 5-76, select **Properties**... from the pop-up menu.

![Default Display Options dialog](image)

**Figure 5-76 Default Display Options dialog**

See AXD online help for full details.

### 5.5.4 Breakpoints system view

The Breakpoints system view, shown in Figure 5-77, enables you to set, modify, or remove breakpoints. You can change the column widths by dragging the dividing lines between the column headings to the left or right.

![Breakpoints system view](image)

**Figure 5-77 Breakpoints system view**

You can see details of any breakpoints that are currently set. To disable an existing breakpoint, click the red disc at the left of its line. The center of the disc becomes gray. Click the disc again to restore normal operation.

To add a new breakpoint, right-click anywhere within the Breakpoints system view to display the pop-up menu shown in Figure 5-78 on page 5-59 and select **Add**.

To modify a breakpoint, do either of the following:

- double-click on its line
- right-click on its line to display the pop-up menu and select **Properties**.
The **Locate Using Address** menu item functions as described in *Watch processor view pop-up menu* on page 5-24.

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also *Refresh All* on page 5-99.

Whether you are adding a new breakpoint or modifying an existing breakpoint, you use the **Breakpoint Properties** dialog shown in Figure 5-79.

![Figure 5-79 Breakpoint Properties dialog](image)
The fields in the Break At group specify the location of the breakpoint. Select one processor if your target has multiple processors. You can specify a line number in a selected source file that contributes to a selected image, or you can select the Address radio button and specify a memory address.

The fields in the Condition group enable you to specify when arrival at the breakpoint must be ignored and when it must trigger the breakpoint. You can specify in the out of field the number of times execution must arrive at the specified location to trigger the breakpoint. Also, if you specify an expression in the when field, the count of arrivals at the breakpoint increments only if the expression evaluates to True.

--- Note ---
If you specify an expression that cannot be evaluated, a result of True is assumed.

---

Under Status, you can see whether the breakpoint is currently enabled, and change this setting if required. You can also see whether it is a software or hardware breakpoint. A hardware breakpoint can have a hardware resource identifier.

You are recommended to leave the Size set to Automatic, but you can change this to ARM (32-bit) or Thumb (16-bit) if necessary. For example, the debugger might not be able to determine whether it is debugging ARM code or Thumb code if:

- the project was built without debugging information (-g- switches off debugging)
- you are debugging a ROM image.

--- Note ---
In the current version of RealView Developer Suite it is not possible to set a bytecode-based breakpoint. If you specify a breakpoint on Jazelle instructions this creates an invalid breakpoint and might display an error message.

---

The setting in the Action group is normally Break, to stop execution when the specified conditions are met. The alternative, Log, adds a record in a log of events. If you select Log, whatever you enter in the Text field is output each time the conditions are met. To examine the log of events, select Output from the System Views menu (see Output system view on page 5-63). The pop-up menu of the Output system view enables you to save subsequent records in a disk file and to clear the current entries from the log.

### 5.5.5 Watchpoints system view

The Watchpoints system view, shown in Figure 5-80 on page 5-61, enables you to set, modify, or remove watchpoints. You can change the column widths by dragging the dividing lines between the column headings to the left or right.
You can see details of any watchpoints that are currently set. To disable an existing watchpoint, click the green disc at the left of its line. The center of the disc becomes gray. Click the disc again to restore normal operation. A disc has a red cross through it if the watchpoint is currently out of scope.

To add a new watchpoint, right-click anywhere within the Watchpoints system view to display the pop-up menu shown in Figure 5-81 and select **Add**.

To modify a watchpoint, do either of the following:
- double-click on its line
- right-click on its line to display the pop-up menu and select **Properties**.

The **Locate Using Address** menu item functions as described in *Watch processor view pop-up menu* on page 5-24.

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.

Whether you are adding a new watchpoint or modifying an existing watchpoint, you use the Watchpoint Properties dialog shown in Figure 5-82 on page 5-62.
The fields in the Watch group specify the location of the watched value. The Processor field enables you to select one processor if your target has multiple processors. Specify in the Item field what to watch by giving the name of a variable or register, or an expression that evaluates to an address. The Watching field is read-only.

**Note**

In the current version of RealView Developer Suite it is not possible to set a bytecode-based watchpoint. If you specify a watchpoint on Jazelle instructions this creates an invalid watchpoint and might display an error message.

The fields in the Condition group enable you to specify when a change in the watched value must be ignored and when it must trigger the watchpoint. You can specify in the Value field a numeric constant, in which case the watchpoint is triggered only if the watched value changes to the specified value. You can specify in the out of field the number of times the watched value must change to trigger the watchpoint. Also, if you specify an expression in the when field, changes in value are counted only if the expression evaluates to True. You can concatenate conditions by using the C language && and || syntax.
Note

If you specify an expression that cannot be evaluated, a result of True is assumed.

Under Status, you can see whether the watchpoint is currently enabled, and change this setting if required. You can also see whether it is a software or hardware watchpoint. A hardware watchpoint can have a hardware resource identifier.

Under Size, you are recommended to leave Force Size unchecked. The area of memory watched is then the size of the variable if you are watching a variable, or a 4-byte word if you are watching a memory location. If you force the size of the watched area of memory you can select 8, 16, or 32 bits.

The setting in the Action group is normally Break, to stop execution when the specified conditions are met. The alternative, Log, adds a record in a log of events. If you select Log, whatever you enter in the Text field is output each time the conditions are met. To examine the log of events, select Output from the System Views menu (see Output system view). The pop-up menu of the Output system view enables you to save subsequent records in a disk file and to clear the current entries from the log.

5.5.6 Output system view

The Output system view enables you to examine both a list of function calls made to the Remote Debug Interface (RDI) and a list of log messages. These can help you determine which program statements have and have not been executed.

Select Output from the System Views menu to display a window, shown in Figure 5-83, containing two tabbed pages, labeled RDI Log and Debug Log.

Click on the RDI Log tab to see the page that contains a list of function calls made to the RDI. This requires the $rdi_log debugger internal variable to be set to 1.
Click on the **Debug Log** tab to see a list of messages recorded when execution passed through any trace points in the program (execution does not stop at an action point if you specify a trace message to be logged). The messages displayed are those specified when you defined each trace point (see *Breakpoints system view* on page 5-58). The debug log also contains any other general debugger output such as error messages.

**Output system view pop-up menu**

To display the Output pop-up menu, shown in Figure 5-84, right-click on either the *RDI Log* tab or the *Debug Log* tab.

![Figure 5-84 Output system view pop-up menu](image)

To specify a file in which to store the lines that appear in the Output view, select **Log to file**…. You can select an existing file, or specify a new file. If you do save this information in a file, the name of the file is shown in the Output system view.

Select **Clear** to remove any lines currently displayed in the Output view.

**5.5.7 Command Line Interface system view**

The *Command Line Interface* (CLI) system view provides you with an alternative method of issuing commands and viewing data. You enter commands in response to CLI prompts, as shown in Figure 5-85 on page 5-65. Any data that you request is displayed in the CLI system view.
Figure 5-85 Command Line Interface system view

Details of all the commands you can issue and data you can display are given in
Chapter 6 AXD Command-line Interface.

Command Line Interface system view pop-up menu

To display the CLI system view pop-up menu, shown in Figure 5-86, right-click within
the Command Line Interface system view.

Figure 5-86 CLI system view pop-up menu

Log to file… enables you to start or stop recording in a disk file everything that appears
in the CLI system view.
**Record Input**... enables you to start or stop recording in a disk file every command that you enter in the CLI system view.

**Clear** enables you to clear the current contents of the CLI system view.

See AXD online help for details of all the pop-up menu items.

Select **Properties...** from the pop-up menu to change the CLI system view properties. This displays the CLI Properties dialog which contains three tabbed pages entitled:

- **General**, shown in Figure 5-87
- **Format**, shown in Figure 5-88 on page 5-67
- **Files**, shown in Figure 5-89 on page 5-68.

When you have made changes on any of the tabbed pages, click:

- **OK** To accept all the current settings on all the tabbed pages, and close the dialog.
- **Cancel** To ignore any changes made since the dialog was opened or since the **Apply** button was last clicked, and close the dialog.
- **Apply** To accept all the current settings on all the tabbed pages, and leave the dialog open for further changes.
- **Help** To display relevant online help.

Figure 5-87 shows the CLI Properties dialog with the default **General** tab selected.

![Figure 5-87 Command Line Interface Properties dialog, General tab](image_url)
Leave Parse checked. Your CLI commands are then validated when you enter them and translated into internal commands.

The Echo setting specifies whether commands read from a file by an Obey command are displayed in the CLI system view. This also determines whether they are logged.

The Update views during obey setting enables you to control whether or not screen updates take place while commands are being executed from an Obey file. If you have several open views, they are all normally updated every time the script causes a break in execution, slowing down AXD significantly. Clear this check box to enable the script to run and update the screen once, when it terminates. The setting persists, with other CLI properties. If a script modifies this CLI property, it is reset to its original state when the script terminates.

The number in the History list size field sets the number of CLI commands that you can recall using the up and down arrow keys or the Ctrl+PageUp key combination. To examine recent commands, or to use a recent command as the basis for a new command, see Command history on page 6-3.

Click on the Format tab to display the dialog shown in Figure 5-88.

![Figure 5-88 Command Line Interface Properties dialog, Format tab](image)

Use this dialog to set the default format for displaying data. This defines the appearance of values displayed in response to such commands as Memory.

Click on the + sign of the data size you want to be displayed. A further list shows you all the formats valid for that size and enables you to choose one.

Click on the Files tab to display the dialog shown in Figure 5-89 on page 5-68.
AXD Desktop

Figure 5-89 Command Line Interface Properties dialog, Files tab

AXD online help gives details of all the fields in the tabbed pages of the CLI Properties dialog.

5.5.8 Debugger Internals system view

The Debugger Internals system view has two tabbed pages:

- Internal Variables
- Statistics on page 5-72.

Internal Variables

The first tabbed page of the Debugger Internals system view shows Internal Variables, as shown in Figure 5-90 on page 5-69.
The debugger, like most programs, uses variables. The internal variables used by the debugger depend on the target in use. If you are using Multi-ICE to debug a hardware target, for example, you see different internal variables from those described here. If you are using RealView ARMulator ISS, the variables displayed depend on the processor you are simulating. They generally include the following:

**$statistics**  
This is a group of internal variables that you can examine more clearly on the Statistics tab (see Statistics on page 5-72) or by using a CLI command (see statistics on page 6-54).

**$rdi_log**  
This variable controls how target information is logged in the RDI Log tab of the Output system view, shown in Figure 5-83 on page 5-63. If it is unset (the default) then no logging occurs. The two least significant bits have the following meanings:

- **Bit 0**  
  RDI (0 = off, 1 = on).

- **Bit 1**  
  Device Driver Logging (0 = off, 1 = on).

This variable is used for diagnostic purposes to track communication between the debugger and the target and so is not normally required.

**$target_fpu**  
This is an enumeration that controls the way that floating point numbers are displayed by the debugger. It is important to ensure the correct display of float and double values in memory that this variable is set to a value that is appropriate for the target in use.
If you attempt to change this value, a validity test checks that the new settings are compatible with the representation of floating point values in the current image. Valid settings and their meanings are:

1. Selects pure-endian doubles (softVFP). This is the default setting for images built with RealView Developer Suite tools. Values are read from ordinary registers.
2. Selects mixed-endian doubles (softFPA). Values are read from ordinary registers.
3. Selects hardware Vector Floating Point unit (VFP). Values are read from registers CP10 and CP11.
4. Selects hardware Floating Point Accelerator (FPA). Values are read from registers CP1 and CP2.
5. Reserved.

Incompatible settings are accepted by the debugger but a warning is given.
SoftVFP and SoftFPA images run correctly on a target whether or not hardware floating point is present. FPA images can also run correctly without hardware floating point, but only if the Floating Point Emulator in RealView ARMulator ISS is active. VFP images require appropriate hardware, or an RealView ARMulator ISS that simulates it.

For further details, and details of the software to install appropriate support code, see the RealView Compilation Tools v2.1 Compiler and Libraries Guide.

$\text{image\_cache\_enable}$
This variable holds internal debugging information when using Trace Debug Tools (TDT) on a target that must not stop execution. Such information would otherwise be lost and so is held locally in the host computer memory. This information is useful only to the debugger and cannot be accessed directly.

$\text{clock}$
This variable applies to RealView ARMulator ISS only and is based on the RealView ARMulator ISS clock speed setting. This variable is unavailable where the RealView ARMulator ISS clock speed is set to real time. Where the RealView ARMulator ISS clock speed is set to simulated, this variable contains the number of simulated microseconds that have elapsed since the application program began execution (see Configure Target... on page 5-86). This variable is read-only.

In addition to these variables, some debug targets can create their own variables. These are named $\langle\text{proc\_name}\rangle$, where:

$\langle\text{proc\_name}\rangle$ is the name of the processor, as shown in the Target tab of the Control system view (for example, ARM720T).
is the name of the variable, and can include:

**irq**  
(For example, $ARM720T$irq.) A target can export this variable to provide a means of asserting the interrupt request pin. To trigger an interrupt manually, set the value to 1. To clear the interrupt, set the value to 0. To take the interrupt exception a processor must have IRQ enabled in the CPSR.

**fiq**  
(For example, $ARM720T$fiq.) A target can export this variable to provide a means of asserting the fast interrupt request pin. To trigger a fast interrupt manually, set the value to 1. To clear the fast interrupt, set it to 0. To take the interrupt exception a processor must have FIQ enabled in the CPSR.

**cputime**  
(For example, $ARM720T$cputime.) This variable applies to RealView ARMulator ISS only and contains the best estimate of the time the processor has been running, measured in clock units. A clock unit is the reciprocal of the RealView ARMulator ISS clock speed setting. This variable is unavailable where the RealView ARMulator ISS clock speed is set to real time (see Configure Target... on page 5-86). This variable is read only.

Your debug target might create other variables. See the target documentation for details.

You can examine the contents of all these variables, and change the values stored in some of them. For more information about data display formats and data entry formats, see Data formatting on page 4-16.

### Debugger Internal Variables pop-up menu

Right-click inside the Debugger Internals system view with the Internal Variables tab selected to display the pop-up menu shown in Figure 5-91.

![Figure 5-91 Internal Variables pop-up menu](image)

Use this pop-up menu to set properties and to select a display format. See AXD online help for details.
Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.

### Statistics

The second tabbed page of the Debugger Internals system view is available only when you use a target simulated by software. The page shows statistics, as in Figure 5-92.

![Figure 5-92 Debugger Internals, von Neumann core statistics](image)

A group of debugger internal variables contains statistics relating to your current debugging session. These variables are displayed more clearly on the **Statistics** tab than on the **Internal Variables** tab. Drag the column divider lines to the left or right to change the column widths if necessary.

The first line of statistics shows values accumulated from the beginning of execution of the program you are debugging, and is labeled `$statistics` (see also the CLI command **statistics** on page 6-54).

You can add more lines of statistics, accumulated from later interruptions of program execution. When execution has stopped, to start accumulating a new line of statistics, right-click in the **Statistics** tab of the Debugger Internals system view, and select **Add New Reference Point**.

Your debug target might display other statistics. See the *RealView ARMulator ISS v1.4 User Guide* for full information on the different cycle types that might be displayed and their meaning. Two examples are shown here:

- Statistics for von Neumann debug targets
- Statistics for Harvard debug targets on page 5-73.

#### Statistics for von Neumann debug targets

When simulating von Neumann architecture cores such as the ARM7TDMI core, shown in Figure 5-92, the following information is displayed:

**Reference Points**

The name you specify to identify each line of statistics that you add.
**Instructions** The number of program instructions executed.

**Core_Cycles**
Internal core cycles indicating the time an instruction spends in the execute stage of the pipeline.

**S_Cycles** The number of sequential cycles performed. The CPU requests transfer to or from the same address, or an address that is a word or halfword after the preceding address.

**N_Cycles** The number of nonsequential cycles performed. The CPU requests transfer to or from an address that is unrelated to the address used in the preceding cycle.

**I_Cycles** The number of internal cycles performed. The CPU does not require a transfer because it is performing an internal function (or running from cache).

**C_Cycles** The number of coprocessor cycles performed.

**Total** The sum of the S_Cycles, N_Cycles, I_Cycles, and C_Cycles.

If you use a map file (see *RealView ARMulator ISS configuration* on page 5-87) the display shows additional information, including:

**Wait_States** The number of wait-states added by the Mapfile component.

**True_Idle_Cycles**
The number of I_Cycles less the number that are part of an I-S pair. It is only displayed if you set SpotISCycles to True.

**Statistics for Harvard debug targets**

When simulating Harvard architecture cores such as the ARM9 core and StrongARM®, different statistics are accumulated, shown in Figure 5-93.

![Figure 5-93 Debugger Internals, Harvard core statistics](image-url)
In these cases, the meanings are:

**Reference Points**
The name you specify to identify each line of statistics that you add.

**Instructions**  The number of program instructions executed.

**Core_Cycles**
The total number of core clock ticks, including stalls because of interlocks and instructions that take more than one cycle.

**ID_Cycles**  Cycles in which both the instruction bus and the data bus were active.

**I_Cycles**  Cycles in which the instruction bus was active and the data bus was idle.

**Idle_Cycles**  Cycles in which both the instruction bus and the data bus were idle.

**D_Cycles**  Cycles in which the data bus was active and the instruction bus was idle.

**Total**  The sum of cycles on the memory bus.

**Statistics pop-up menu**
Right-click inside the Debugger Internals system view with the **Statistics** tab selected to display the pop-up menu shown in Figure 5-94.

![Figure 5-94 Statistics pop-up menu](image)

Use this pop-up menu to add a new line of statistics to the displayed table, or to delete the currently selected line. See AXD online help for details.

Select **Refresh** to update and recalculate the displayed data values. This item is useful if the target supports RealMonitor. See also **Refresh All** on page 5-99.
5.6 Execute menu

The Execute menu (see Figure 5-95), lets you control how execution continues from the current point.

![Figure 5-95 Execute menu](image)

The Execute menu items are described under the following headings:

- **Go**
- **Step** on page 5-76
- **Step In** on page 5-76
- **Step** on page 5-76
- **Step Out** on page 5-77
- **Run To Cursor** on page 5-77
- **Show Execution Context** on page 5-77
- **Toggle Breakpoint** on page 5-77
- **Toggle Watchpoint** on page 5-78
- **Set Watchpoint** on page 5-78
- **Delete All Breakpoints** on page 5-78.

### 5.6.1 Go

This begins execution. If you have loaded an image but not yet run it, execution starts from the first executable instruction. If execution is currently stopped, at a breakpoint for example, then it resumes from the point at which it stopped.

When you start executing an image, AXD tries to locate the relevant source files. If they are not found, you are asked to specify their location in the dialog shown in Figure 5-96 on page 5-76.
If you select the check box **Remember location for future source file searches**, AXD finds these files without your help in subsequent sessions.

If you select the check box **Project source unavailable for current image**, AXD continues the session without access to any source files.

### 5.6.2 Stop

This menu item is enabled only when the program is executing. It stops execution as soon as the program can be interrupted.

### 5.6.3 Step In

This executes the current instruction and stops. If the current instruction is a call to a function, then it stops at the first executable instruction in that function.

This menu item is not enabled when executing Jazelle instructions because stepping options are not available for these instructions.

In addition, if the current instruction is a BXJ instruction this menu item is not enabled.

### 5.6.4 Step

This executes the current instruction and stops. If the current instruction is a call to a function, then it executes the function and stops when control returns to the caller.

A C++ program might contain many calls to library functions that the compiler replaces with inline code if you choose to compile for high speed rather than small size. This prevents the Step command from behaving as expected. A C++ compiler option is
available to force calls to library functions to be compiled as calls in such cases. For more information, see the RealView Compilation Tools v2.1 Compiler and Libraries Guide.

This menu item is not enabled when executing Jazelle instructions because stepping options are not available for these instructions.

In addition, if the current instruction is a BXJ instruction this menu item is not enabled.

5.6.5  Step Out

This completes execution of the current function and stops when control returns to the caller.

This menu item is not enabled when executing Jazelle instructions as stepping options are not available for these instructions.

5.6.6  Run To Cursor

This continues execution but stops when the next instruction to be executed is the one where you have positioned the cursor.

—— Note ————

Because Run to Cursor is dependent on setting a breakpoint, it is not possible to select this option for Jazelle instructions where breakpoints are currently not supported.

5.6.7  Show Execution Context

This selects Show Execution Context when you are viewing either the source code or the disassembled code related to a halted process. The area of code displayed changes so that the visible lines of code are replaced by the lines surrounding the current execution position.

5.6.8  Toggle Breakpoint

When you are viewing a source file or a disassembly, you can set or remove a breakpoint at the current cursor position by selecting Toggle Breakpoint from the Execute menu.

You can also set or remove a breakpoint by double-clicking in the margin of the required line in a source or disassembly view, or by right-clicking on the line and selecting Toggle Breakpoint from the pop-up menu.
Note

In the current version of RealView Developer Suite it is not possible to set a bytecode-based breakpoint. If you specify a breakpoint on Jazelle instructions this creates an invalid breakpoint and might display an error message.

5.6.9  Toggle Watchpoint

When you are viewing a disassembly, you can set or remove a watchpoint on the currently selected item by selecting **Toggle Watchpoint** from the **Execute** menu.

Note

In the current version of RealView Developer Suite it is not possible to set a bytecode-based watchpoint. If you specify a watchpoint on Jazelle instructions this creates an invalid watchpoint and might display an error message.

5.6.10 Set Watchpoint

When you are viewing a source file, you can set or replace a watchpoint on the currently selected item by selecting **Set Watchpoint** from the **Execute** menu.

Note

In the current version of RealView Developer Suite it is not possible to set a bytecode-based watchpoint. If you specify a watchpoint on Jazelle instructions this creates an invalid watchpoint and might display an error message.

5.6.11 Delete All Breakpoints

To delete all currently set breakpoints, select **Delete All Breakpoints** from the **Execute** menu.
5.7 Options menu

The Options menu, shown in Figure 5-97, enables you to examine and change a variety of settings, including some that affect the appearance of the debugger screen. This menu also enables you to start and stop profiling.

![Options menu](image)

The Options menu items are described under the following headings:

- **Disassembly Mode**
- **Configure Interface...**
- **Configure Target...** on page 5-86
- **Configure Processor...** on page 5-95
- **Source Path...** on page 5-96
- **Status Bar display control** on page 5-97
- **Profiling** on page 5-97.

5.7.1 Disassembly Mode

This applies only when you have a Disassembly processor view selected. To specify the type of disassembly you require, select **Disassembly Mode** from the Options menu. A submenu appears, enabling you to select ARM/Thumb Mixed, ARM, Thumb or ByteCode. One of these is checked, indicating the current disassembly mode.

In ARM/Thumb Mixed mode, the debugger uses information read while loading the image to set the appropriate mode. This is possible only when debugging information is present, so cannot be done if, for example, the image is in ROM. The default setting then used might not always be correct.

5.7.2 Configure Interface...

To configure the AXD user interface, select **Configure Interface...** from the Options menu. The resulting dialog has tabbed pages entitled:

- General
- Views
To display detailed information about the features of the currently displayed tabbed page, click **Help**.

When you have made changes on one or more of these tabbed pages, you can apply or abandon the changes as follows:

- **OK**  
  Apply outstanding changes on all tabbed pages and close the dialog.

- **Cancel**  
  Ignore any outstanding changes and close the dialog.

- **Apply**  
  Apply outstanding changes on all tabbed pages and keep the dialog open.

**General**

Figure 5-98 shows the **General** tab of the Configure Interface dialog.

The **General** tab of the Configure Interface dialog enables you to control the behavior of the target processor when you connect the debugger to it, and the actions to be taken when you restart or close a debugging session. It also enables you to make some other general settings applicable to the whole debugging session.

Most targets stop execution when a debugger is connected and restart when instructed to do so. Also, the displayed views are all updated each time the target execution stops. All views therefore show consistent data at all times.
Targets that support RealMonitor can be traced and queried without interrupting execution. The Target connection drop-down list enables you to select an appropriate way of connecting the debugger to the target, depending on whether you are using RealMonitor. See RealMonitor support on page 4-14 for more information.

**Halt**
The debugger is allowed to, and does, stop execution of the target when the connection is made. If connection to a new target is requested during program execution a warning message is displayed so that execution on the current target can continue, or stop, as required. This is the default setting.

**NoHalt**
The target is assumed to be executing and must not be interrupted. If the target supports RealMonitor and a non-intrusive connection can be made, then the connection is made. Otherwise the debugger redispalyes the configuration dialog.

**Attach**
If the target supports RealMonitor and a non-intrusive connection can be made, then the connection is made without stopping target execution. If the target does not support RealMonitor then the connection is still made even though doing so stops the target execution.

--- Note ---
The AXD debug architecture does not currently support attaching and re-attaching while using any kind of semihosting.

Under Action on close/restart you can select a **Save and load session file** check box. If this is checked, details of your debug session are saved in a session file when you end the session, and next time you run AXD the new session starts in the same state. If the **Save and load session file** check box is cleared, details are not saved at the end of the current session, and the next session begins in the usual default state.

The check boxes in the General group control the types of messages recorded in the **Debug Log** tabbed page of the Output system view (see Output system view on page 5-63), and the List size fields enable you to control the amount of recent history that is maintained.

**Views**
Figure 5-99 on page 5-82 shows the **Views** tab of the Configure Interface dialog.
These Default view properties are used as default settings in all displayed views.

The General Font you select applies to the following views:
- Backtrace
- Breakpoints
- Control Monitor
- Low Level Symbols
- Output
- Watchpoints.

The Fixed Font you select applies to the following views:
- Command Line Interface
- Comms Channel
- Console
- Debugger Internals
- Disassembly
- Memory
- Registers
- Source
- Variables.
The Default Initial View State you select applies to the starting state of all views except Source and Disassembly views which always float within the main window. You can set a view window as:

- Docked
- Undocked
- Floating.

Docked and floating windows are described in *Docked and floating windows* on page 2-10. See also *Window menu* on page 5-98.

To display detailed information on all the fields and check boxes on this tabbed page, click Help.

**Formatting**

Figure 5-100 shows the **Formatting** tab of the Configure Interface dialog.

![Figure 5-100 Configure Interface, Formatting tab](image)

The **Formatting** tab of the Configure Interface dialog enables you to define the formatting strings used for the default formatting options decimal, hex, floating point single, floating point double, Q15, and Q31. To change the default formatting string for a format option, select User.

The value you set for the Array expansion threshold limits the number of child items that you can display without first displaying the array expansion pop-up.
Session File

Figure 5-101 shows the **Session File** tab of the Configure Interface dialog. This tabbed page enables you to make settings that apply to all session files that you might create, including the default session file created automatically at the end of each debug session.

![Figure 5-101 Configure Interface, Session File tab](image)

Under Session file options, you can choose whether or not to **Reselect Target**. If this is checked, target details are saved at the end of a session and a new session connects to the same target as the previous session. If unchecked, the new session starts with the same settings and displayed views as the previous session but with no target selected.

If you do reselect the previous target, you can use **Reload Images** to choose whether or not to reload the previous image onto the target. If this is checked, image details are saved at the end of a session and a new session loads the previous image. If unchecked, the new session starts with the same settings and displayed views as the previous session but with no image loaded.

If you use the **Browse** button to locate and select a script file, and check the **Run Configuration Script** check box, then the commands in the specified script file are executed after loading the session file and connecting to the target, but before loading any images.

**Toolbars**

Figure 5-102 on page 5-85 shows the **Toolbars** tab of the Configure Interface dialog.
The check boxes in the Toolbars group control the display of the named toolbars. When a toolbar name is checked in this dialog, that toolbar is displayed on the main AXD screen. These toolbars are shown in Toolbars on page 5-3.

Timed Refresh

Figure 5-103 shows the Timed Refresh tab of the Configure Interface dialog.
The **Timed Refresh** tab of the Configure Interface dialog is particularly useful when you are debugging a target that supports RealMonitor (see *RealMonitor support* on page 4-14).

When you debug a target that does not support RealMonitor, all displayed views are refreshed each time execution on the target stops. This means that all the information you can see is consistent.

Execution on a target that supports RealMonitor, however, can be continuous, with each displayed view showing information that was relevant at one time but not necessarily at the time that the information in any other view was captured.

The pop-up menu available in most views includes a **Refresh** item, but that refreshes the information in that view only. The **Window** menu includes a **Refresh All** item, to refresh all the displayed views at the same time.

If you select the **Enable Timed Refresh** check box on the **Timed Refresh** tab of the Configure Interface dialog so that it is checked, then all displayed views are refreshed automatically and regularly.

Timed refresh is automatically suspended when dialogs are displayed. You can check the **Disable Timer if user prompted by error dialog** check box on the **Timed Refresh** tab of the Configure Interface dialog so that refreshes are disabled if an error dialog is displayed. When you have cleared the error dialog, you can enable timed refresh by clicking on the **Timed Refresh** tool.

You can also check or clear the **Enable Timed Refresh** check box by selecting the **Timed Refresh** item on the **Window** menu or by clicking on the **Timed Refresh** tool.

### 5.7.3 **Configure Target...**

You can select and configure a debug target when you start up AXD (see *Starting and closing AXD* on page 2-3). The **Configure Target...** item on the **Options** menu enables you to change the debug target and its configuration during a debug session.

First, a Choose Target dialog displays a list of available targets, as shown in Figure 5-104 on page 5-87.
If the target you want is not in the list, click the **Add** button to locate and select the required .dll file. The selection list shows all available .dll files including, for example etm.dll.

When you can see the target you want in the list, select that line as shown in Figure 5-104, and click the **Configure** button.

The appearance of the configuration dialog depends on the target you selected. Examples follow showing:

- **RealView ARMulator ISS configuration**
- **Multi-ICE configuration** on page 5-92
- **Remote_A configuration** on page 5-92

**Note**

In some of these procedures you need to locate and select a required file. A browse dialog helps you do this. However, files of the type you require might not be listed unless you select **Windows Explorer → View → Options... → Show all files.**

**RealView ARMulator ISS configuration**

If you need to add RealView ARMulator ISS to the list of available targets in the Choose Target dialog, click **Add** and in the resulting browse dialog locate and select the armulate.dll file.

Select the RealView ARMulator ISS target line and click the **Configure** button to display the dialog shown in Figure 5-105 on page 5-88.
The RealView ARMulator ISS Configuration dialog enables you to examine and change the following settings:

**Processor**  
Use the drop-down list to specify which ARM processor you want RealView ARMulator ISS to simulate.

**Clock**  
Choose between simulating a processor clock running at a speed that you can specify, or executing instructions in real time. Entering a speed without specifying units assumes Hz, for example 50 assumes 50Hz. Speeds given in kHz and GHz are also acceptable.

**Options**  
The Floating Point Emulator (FPE) emulates the Floating Point Accelerator (FPA) coprocessor and enables the execution of floating point instructions not supported by the main processor. Check this option to enable FPE.
Debug Endian

Select the byte order of the target system. This setting:

- Sets the debugger to work with the appropriate byte order.
- Sets the byte order of RealView ARMulator ISS models that do not have a CP15 coprocessor.
- Sets the byte order of RealView ARMulator ISS models that do have a CP15 coprocessor if the Start target Endian option is set to Debug Endian.

For more information see the summary of Endian settings in Table 5-1.

Start target Endian

Select the way in which the byte order of RealView ARMulator ISS models that have a CP15 coprocessor is determined:

- Select the Debug Endian radio button to instruct the model to use the byte order set in the Debug Endian group.
- Select the Hardware Endian radio button to instruct the model to simulate the behavior of real hardware. On reset, the core model starts in little-endian mode. If the rest of the system is big-endian, you must set the big-endian bit in CP15 in your initialization code to change the core model to big-endian mode.

You can set various combinations of the radio buttons in the Debug Endian and Start target Endian groups. Use the possible combinations as shown in Table 5-1.

<table>
<thead>
<tr>
<th>Debug Endian</th>
<th>Start target Endian</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Little</td>
<td>Debug Endian</td>
<td>Use this for a core or system that is always little-endian only (for example, BigEnd pin = 0). This is the default.</td>
</tr>
<tr>
<td>Big</td>
<td>Debug Endian</td>
<td>Use this for a core or system that is always big-endian only (for example, BigEnd pin=1).</td>
</tr>
<tr>
<td>Big</td>
<td>Hardware Endian</td>
<td>Use this for a big-endian system, where the core starts up in little-endian mode, but which is switched to big-endian by writing to CP15 in the initialization code. (The initialization code must be written in an endianness-independent way, that is word accesses only.)</td>
</tr>
<tr>
<td>Little</td>
<td>Hardware Endian</td>
<td>This combination is not required at present.</td>
</tr>
</tbody>
</table>
Memory Map File

Specify a memory map file, or that you want to use default settings.

Floating Point Coprocessor

Where you are using a floating point coprocessor (FPA), use the drop-down list to specify the variant supported by RealView ARMulator ISS, for example ARM926EJ-S with Vector Floating Point (VFP). The default is No_FPU.

MMU/PU Initialization

Specify the initialization of the Memory Management Unit (MMU) or Protection Unit (PU) for your target processor. If you are using the RealView ARMulator ISS to simulate a processor with an MMU, DEFAULT_PAGETABLES is the required setting. For PU processors, or processors where the MMU is disabled, select NO_PAGETABLES.

When developing your own pagetable initialization software in the RealView ARMulator ISS you might want to disable the MMU by selecting NO_PAGETABLES. This means that settings in the peripherals.ami configuration file are ignored.

See ARM Architecture Reference Manual for full information on MMU/PU operation.

See the RealView ARMulator ISS v1.4 User Guide for full information on pagetables.

When you are changing settings in the RealView ARMulator ISS Configuration dialog you must remember the following:

- If you are using the software floating point C libraries, ensure that the Floating Point Emulation option is off (blank), its default setting. Turn the option on (checked) only if you want Floating Point Emulation (FPE) software to be loaded into RealView ARMulator ISS so that you can execute code that uses the Floating Point Accelerator (FPA) instruction set.

- Changes to the RealView ARMulator ISS Configuration dialog do not affect the $target_fpu debugger internal.

- If, in the Memory Map File group, you select No Map File, the memory model declared as default in the default.ami file is used. This typically represents a flat 4GB bank of ideal 32-bit memory having no wait states. To use a memory map file, select Map File. Specify the filename (for example, armsd.map) by entering it, or click the Browse button, locate and select the file, and click Open. You must specify an existing memory map file. For more information about ARMulator and memory map files, see the RealView ARMulator ISS v1.4 User Guide.
When you are setting options in the Clock group you must remember the following:

- If you set a nonzero simulated Clock Speed, then the clock speed used is the value that you enter. Clock speeds can be entered in units of Hz, kHz or GHz. If you do not specify the units then Hz is assumed. Values stored in the debugger internal variable $clock depend on this setting, and are unavailable if you select Real-time. For information about debugger internal variables, see Debugger Internals system view on page 5-68.

- The AXD clock speed defaults to real time for compatibility with the defaults of armd. Selecting Real-time in AXD is equivalent to omitting the -clock armd option on the command line. In other words, the clock frequency is unspecified, and the default clock frequency specified in the configuration file default.ami is used (DEFAULT_CPUSPEED=20MHz).

- For RealView ARMulator ISS, you do not have to specify a clock frequency because RealView ARMulator ISS does not use it to simulate the execution of instructions and count cycles (for $statistics). However, your application program might sometimes need to access a clock, so RealView ARMulator ISS must always be able to give clock information. RealView ARMulator ISS uses the clock frequency from the configuration file if you do not specify a simulated clock speed.

  — In either case, RealView ARMulator ISS uses the clock information to calculate the elapsed time since execution of the application program began. This elapsed time can be read by the application program using the C function clock() or the semihosting SYS_CLOCK, and is also visible to the user from the debugger as $clock. It is also used internally by RealView ARMulator ISS in the calculation of $memstats. The clock speed (whether specified or unspecified) has no effect on actual (real time) speed of execution under RealView ARMulator ISS. It affects the simulated elapsed time only.

  — $memstats is handled slightly differently because it does require a defined clock frequency so that RealView ARMulator ISS can calculate how many wait states are required for the memory speed defined in an armd.map file. If you specify a clock speed and an armd.map file is present, then $memstats gives useful information about memory accesses and times. Otherwise, for calculating the wait states, a default core:memory clock ratio specified in the configuration file is used, so that $memstats can still give useful memory timings.

    Note

$memstats is defined only when a map file is present.
See the RealView ARMulator ISS v1.4 User Guide for full information on ARMulator configuration settings and configuration files.

Multi-ICE configuration

If you need to add Multi-ICE to the list of available targets, click Add and use the resulting browse dialog to locate and select the Multi-ICE.dll file.

Select the Multi-ICE target line and click the Configure button to display the Multi-ICE configuration dialog.

The settings available in this dialog include:

- the network address of the computer running the Multi-ICE Server software
- the selection of a processor driver
- a connection name (required only when access to the Multi-ICE Server software is across a network).

Some versions of Multi-ICE might also enable you to select a .dll file to use as a Debug Communications Channel (DCC) viewer. Do not enable any DCC viewer from this dialog. Instead, use the AXD built-in viewer available from the Processor Views menu and enabled from the Processor Properties dialog. For more details see Comms Channel processor view on page 5-37 and Configure Processor... on page 5-95.

Full descriptions of Multi-ICE configuration are given in the Multi-ICE documentation and in the online help available when the dialog is displayed.

Remote_A configuration

To enable AXD to communicate with an Angel or EmbeddedICE target, you must configure the Remote_A connection appropriately. To configure the Remote_A connection, select the ADP target. If this is not listed, click Add and use the resulting browse dialog to locate and select the remote_a.dll file.

Select the ADP target line and click the Configure button to display the dialog shown in Figure 5-106 on page 5-93.
The Remote_A connection dialog enables you to examine and, if necessary, change the following settings:

**Remote connection driver**

Click **Select...** to see a list of available drivers. This includes Serial, Serial/Parallel, and Ethernet drivers. Select one if you want to use it instead of the current driver. To change the settings of the currently selected driver, click **Configure...**. A dialog appears, similar to those in Figure 5-107, Figure 5-108 on page 5-94, or Figure 5-109 on page 5-94.
Heartbeat  Ensures reliable transmission by sending heartbeat messages. Any errors are more easily detected when known messages are expected regularly.

Endian  These buttons inform the debugger that the target is operating in little-endian or big-endian mode.
  •  If you are using the RealView ARMulator ISS to simulate a processor with an MMU and you have semihosting enabled in the .ami configuration file, the RealView ARMulator ISS sets the big-endian bit in CP15. If semihosting is not enabled, the big-endian bit is not set and the processor executes in little-endian mode. In that case you must write initialization code to set the big-endian bit, or set it manually through the debugger.
  •  If you are using RealView ARMulator ISS to simulate a processor without an MMU, such as the ARM7TDMI® core, the Endian button sets the endianness of the target processor.

For hardware targets such as Multi-ICE, the Endian button only sets the endianness expected by the debugger. You must initialize your hardware to run in the appropriate mode.

Angel automatically corrects a wrong endian target setting.

Channel Viewers  Channel viewers are not supported if you are running AXD under UNIX.
When you run AXD under Windows, checking Enabled enables you to access a displayed list of .dll files. Do not enable any DCC viewer from this dialog. Instead, use the AXD built-in viewer available from the Processor Views menu and enabled from the Processor Properties dialog. For more details see Comms Channel processor view on page 5-37 and Configure Processor...

For information on how to configure other targets, for example ARM Agilent Debug Interface, see the documentation accompanying the product.

5.7.4 Configure Processor...

This menu item provides a quick way for you to display the Processor Properties dialog for the current processor. Selecting Configure Processor... from the Options menu is equivalent to right-clicking on a processor name on the Target tab of the Control system view and selecting Properties from the resulting pop-up menu. A typical Processor Properties dialog is shown in Figure 5-110.

![Figure 5-110 Processor Properties dialog](image)

The Vector Catch group enables you to select the exceptions that are intercepted, causing control to pass back to the debugger. The default settings of vector_catch are RUsPDif. An uppercase letter indicates an exception is intercepted. The exceptions controlled in this way are:

- **R**  Reset
- **U**  Undefined Instruction
- **S**  SWI
- **P**  Prefetch Abort
Each check box in the Vector Catch group indicates whether a particular exception is intercepted (checked) or ignored (blank) for the specified processor. Any changes you make become effective when you click the OK button. For more information see setproctitle on page 6-47.

The Enable Comms Channel and Semihosting selections, the Semihosting mode settings, and the Semihosting SWIs settings can interact with one another. These are governed, to some extent, by the target configuration.

Settings are disabled when it is inappropriate for you to change them. You can, however, view the current settings.

You can switch semihosting on or off using the Semihosting check box. When it is switched on, you can set the semihosting mode to Standard or DCC (Debug Communications Channel). If you select the DCC semihosting mode, then:

- the Comms Channel check box becomes disabled because the options are mutually exclusive
- you might have to change the address stored in the variable to suit the size of the target memory (see Semihosting on page 4-11).

The Vector field sets the value of the $semihosting_vector variable. See the Semihosting chapter of the RealView ARMulator ISS v1.4 User Guide for an explanation of this variable, and for more general information on semihosting issues.

Caution

The Semihosting SWIs fields specify an integer number identifying the ARM and Thumb SWI numbers that are used for semihosting. You are strongly advised not to change these.

5.7.5 Source Path...

Select Source Path... from the Options menu to display the Set Source Path dialog shown in Figure 5-111 on page 5-97. This specifies the paths that are searched, and the order in which they are searched, when a source file is required.
To insert a path in the list, click the Insert button. Either browse for the required path name or enter the full path name, then press Return. For example, you might specify `install_directory\RVDS\Temp` as a source path.

You can select and delete a single path name, or delete all path names. You can also select and move a path name up or down the list.

Source paths are persistent. They are saved and used in subsequent debugging sessions.

You can also set and view source paths using the command-line interface. See `sourcedir` on page 6-53, and `setsourcedir` on page 6-49.

### 5.7.6 Status Bar display control

If you click on the Status Bar menu item so that it is checked the status bar is displayed at the bottom of the AXD screen (see Status bar contents on page 5-5).

If you click the Status Bar menu item so that it is cleared the status bar is not displayed.

### 5.7.7 Profiling

Select Profiling to display a submenu, shown in Figure 5-112. This enables you to control profiling, provided you made suitable settings when you loaded the image. See Profiling on page 4-27 for details.

Figure 5-111 Set Source Path dialog

Figure 5-112 Profiling submenu
5.8 Window menu

The **Window** menu, shown in Figure 5-113, enables you to control the display of windows and icons on your screen.

![Figure 5-113 Window menu](image)

Source and Disassembly views always float within the main window. All other views can be displayed in any one of three types of window:
- docked at one edge of the main window
- floating anywhere on the screen
- floating within the main window.

The **Window** menu items operate on views that are floating within the main window only. Windows that can float to any position on the screen and windows that are docked are not affected or listed.

Any cascaded or tiled windows are arranged within the screen area that remains unoccupied by any docked windows. Docked and floating windows are described in *Docked and floating windows* on page 2-10.

The **Window** menu items are described under the following headings:
- **Cascade** on page 5-99
- **Tile Horizontally** on page 5-99
- **Tile Vertically** on page 5-99
- **Arrange Icons** on page 5-99
- **Refresh All** on page 5-99
- **Timed Refresh** on page 5-99
- **List of relevant windows** on page 5-100.
5.8.1 Cascade

Cascade operates on any windows set to float within the main window. They are repositioned, resized, and overlapped, to be as large as possible while still showing enough of each one to identify it and to enable you to select it. They fill most of the area of the main window that remains unoccupied by any docked windows.

5.8.2 Tile Horizontally

Tile Horizontally operates on any windows set to float within the main window. They are repositioned and resized to avoid any overlapping and to fill the area of the main window that remains unoccupied by any docked windows. The windows are made as wide as is reasonably possible within the space available, with their height restricted if necessary.

5.8.3 Tile Vertically

Tile Vertically operates on any windows set to float within the main window. They are repositioned and resized to avoid any overlapping and to fill the area of the main window that remains unoccupied by any docked windows. The windows are made as high as is reasonably possible within the space available, with their width restricted if necessary.

5.8.4 Arrange Icons

Arrange Icons arranges any windows minimized to icons along the bottom edge of the area of the main window that remains unoccupied by any docked windows.

5.8.5 Refresh All

The Refresh All menu item is useful when you are debugging a target that supports RealMonitor (see RealMonitor support on page 4-14). If you are debugging such a target and have several views displayed, the information shown might have been captured at various times during the debug session so can appear inconsistent.

Select Refresh All from the Window menu to update and recalculate the information in all currently displayed views.

5.8.6 Timed Refresh

Selecting the Timed Refresh menu item or clicking on the Timed Refresh tool is equivalent to selecting Options → Configure Interface → Timed Refresh → Enable Timed Refresh, and toggles on or off the automatic updating and recalculation of all displayed information at regular intervals.
To change the refresh interval, select **Options → Configure Interface → Timed Refresh** and set Refresh Interval (tenths of seconds) to a new value.

**Timed Refresh** is useful when you are debugging a target that supports RealMonitor (see RealMonitor support on page 4-14). With other targets, all displayed views are refreshed each time target execution stops.

### 5.8.7 List of relevant windows

All windows that are currently floating within the main window are listed in the lower part of the **Window** menu, each window identified by the text that appears in its title bar. See this list if some windows have become obscured. Select any window from the list to bring it to the front of the display.
5.9 Help menu

The Help menu provides you with access to AXD online help and to details of the version of AXD that you are running.

Figure 5-114 Help menu

The Help menu items and relevant toolbar icons are described under the following headings:

- Contents
- Using Help
- Online Books
- About AXD on page 5-102
- Toolbar icons on page 5-102.

5.9.1 Contents

Contents displays the first page of AXD online help. You can navigate from there to any other available topic.

5.9.2 Using Help

Using Help displays instructions for various ways to obtain online help while you are using the debugger.

5.9.3 Online Books

Online Books enables you to view the ARM manuals that are published in both printed and online forms, and are complementary to online help. This is equivalent to selecting Start → Programs → ARM → DynaText Documentation.

During RealView Developer Suite installation, you can choose whether or not to install the documentation. You can view online books only if they are installed. If the PDF files are not installed you can view them by reading them from the RealView Developer Suite installation CD-ROM.
5.9.4 About AXD

About AXD displays the name, version number, and build number of the AXD software you are running.

When you have seen the details, close the dialog by clicking on either the Close button or the OK button.

5.9.5 Toolbar icons

- Clicking on the Query icon is equivalent to selecting Contents from the Help menu.
- Clicking on the Query and arrow icon changes the mouse pointer into a similar icon. Click again on any part of the display for which you want help.
This chapter describes the use of the Command Line Interface (CLI) window. It contains the following sections:

- *Command Line Window* on page 6-2
- *Parameters and prefixes* on page 6-4
- *Commands with list support* on page 6-5
- *Predefined command parameters* on page 6-6
- *Definitions* on page 6-9
6.1 Command Line Window

Select Command Line Interface from the System Views menu to display the Command Line Interface (CLI) window. In the CLI window you can enter commands that are equivalent to many of the debugger menu items, or submit a file of such commands. This provides a reliable and consistent way for you to execute sequences of commands repeatedly.

You might use the CLI window for the following reasons:

- As an alternative to the GUI
- To automate repetitive tasks.

To display the CLI window pop-up menu, right-click in the CLI window.

You can paste text into the CLI window instead of typing it, but you must ensure that every line ends with a CR-LF pair. The final line, for example, is not executed if it does not end with CR-LF.

All commands entered, either by typing or by pasting, are added to the CLI history list.

6.1.1 As an alternative to the GUI

Using the GUI involves selecting items from menus. Many of these menu items correspond to commands you can enter in the CLI window.

One advantage of working in the CLI window is the ability to log all your actions in a disk file.

If any of your commands result in data being displayed by the debugger, these appear in the CLI window. You can choose whether a log file includes everything displayed in the CLI window, or your commands only.

You can use both the CLI and the GUI in a debug session. If, for example, a GUI command changes the current processor, then any CLI command that by default refers to the current processor refers to the newly-defined processor.

6.1.2 To automate repetitive tasks

You can record the commands you issue in a log file (see Command Line Interface system view pop-up menu on page 5-65 or record on page 6-38). You can then easily repeat the same commands by submitting the file to the CLI using the obey command (see obey on page 6-36).
6.1.3 CLI pop-up menu

Right-click in the CLI window to display the CLI window pop-up menu. For details refer to the ARM eXtended Debugger (AXD) online help or to Command Line Interface system view pop-up menu on page 5-65.

To display the CLI Properties dialog, shown in Figure 5-87 on page 5-66, Figure 5-88 on page 5-67, and Figure 5-89 on page 5-68, select Properties... from the pop-up menu.

The CLI Properties dialog enables you to set various default values so that you do not have to specify them on commands you intend to issue. It also provides an alternative method of issuing certain commands, such as toggling on or off logging or recording, or selecting files to use for those purposes.

In a few cases, this dialog provides the only method of setting values. Such values include the number of lines of disassembly or source code to display, and the number of history records visible in a view.

Click Help or refer to Command Line Interface system view pop-up menu on page 5-65 for more information about this dialog.

6.1.4 Command history

Your most recent commands are stored and are available for reuse. Press the up arrow and down arrow keys to move backwards and forwards through the list of recent commands. When any earlier command is displayed you can press Return to issue the command for execution.

To issue a new command similar to one you issued earlier, use the up arrow and down arrow keys to display the earlier command, then the left arrow and right arrow keys to position the cursor. Change the earlier command as required, then press Return to issue the new command.

To see the stored list of commands, press the Ctrl+Page Up key combination. If there are too many commands to display in the window, you can scroll the list. Select any displayed command and press Return to use that command as the basis for a new command.

To change the number of recent commands stored, see Command Line Interface system view pop-up menu on page 5-65.
6.2 Parameters and prefixes

When entering commands, you might have to supply parameters of various types. To specify the type of a parameter, prefix its value with one of the symbols #, |, @, or +.

6.2.1 # parameters

After a # symbol the remaining character(s) must be numeric, and identify an object by its position in a list.

Before specifying an object by using a # parameter you must issue a command that displays the relevant indexed list. For commands that display indexed lists, see Commands with list support on page 6-5.

6.2.2 | parameters

Type a | symbol to separate a parent and a child item in a parameter that includes hierarchical levels.

You might need to include a | symbol when you supply a position parameter, for example, even though the symbol is not shown in the syntax description of the command.

A | symbol in a syntax description denotes alternatives, and you do not type it when you enter the command.

6.2.3 @ parameters

After an @ symbol the remaining characters must form an expression that evaluates to an address. Usually, this kind of parameter takes one of the following forms:

- A hexadecimal value, @0x82E0 for example.
- The name of a low-level symbol, @Proc_4 for example.

6.2.4 + parameters

The + symbol prefixes the second parameter of a range when it is to be used as a size rather than an upper value.

6.2.5 Other parameters

You might need to supply other names as parameters (a file, a directory, or a debugger internal variable, for example). They do not begin with one of the symbols #, |, @, or +. For example, to display the value of the internal variable $target_fpu, type:

```
print $target_fpu
```
6.3 Commands with list support

Several commands display lists with entries identified by an index number (starting from 1 for the first entry). You can use these index numbers to refer to specific entries.

The following indexed lists are available:

- files
- classes
- functions
- variables
- watchpoints
- breakpoints
- regbanks
- registers
- stack entries
- low-level symbols
- processors
- images.

Commands that display these indexed lists and commands that accept indexed entries from these lists are described in *Commands* on page 6-13.
6.4 Predefined command parameters

Several commands take parameters in the form of text strings, but a very few predefined values are the only ones you are allowed to supply. For example, where `toggle` is specified as a parameter, you can enter either the string `on` or the string `off`. Any other value for this parameter is invalid.

In the alphabetical list of Commands on page 6-13, the parameters printed in *italics* are those that you replace with the value you require when you issue the command.

These parameters are not case-sensitive. You can freely mix uppercase and lowercase characters. The parameters for which you must specify certain values only are described in the following sections:

- `format`
- `asm`
- `instr` on page 6-7
- `step` on page 6-7
- `memory` on page 6-7
- `scope` on page 6-7
- `toggle` on page 6-8.

6.4.1 format

The `format` parameter must be set to the name or index number of an existing format. To display a list of all currently available formats, refer to `listformat` on page 6-32.

Use this parameter to specify how values are displayed. For example, each line in a memory listing shows the contents of 16 bytes of memory, grouped into 4, 8, or 16 values (see `memory` on page 6-7). The setting of the `format` parameter in the `memory` command determines whether each value is displayed in hexadecimal, decimal, octal, binary, or any other available format.

You can also use the `format` parameter to specify the default display format for registers, memory, or watchpoints. The default setting of `format` is shown on the Format tab of the CLI Properties dialog or by the `format` command.

For more information about formats, see Data formatting on page 4-16.

6.4.2 asm

The `asm` parameter must be set to ARM, Thumb, ByteCode or auto.
ARM instructions occupy 32 bits and Thumb instructions occupy 16 bits. ARM C and C++ compilers can generate either ARM or Thumb code. Use the \texttt{asm} parameter to specify that the code being debugged contains ARM code or Thumb code, or Jazelle code, or that the debugger must make the setting itself (auto). You usually have to specify the instruction type only when the code was built without debug information.

The setting of \texttt{asm} is shown in the Instruction Size field of the CLI Properties dialog.

### 6.4.3 instr

The \texttt{instr} parameter must be set to \texttt{line} or \texttt{instr}.

This parameter determines whether a step consists of a line of source code (\texttt{line}) or an assembler instruction (\texttt{instr}).

You can examine or change the setting of \texttt{instr} in the Step size field of the CLI Properties dialog General tab, or with the \texttt{stepsize} CLI command.

### 6.4.4 step

The \texttt{step} parameter, if specified, must be set to \texttt{in} or \texttt{out}.

This affects the way an instruction calling a function is processed. If you specify \texttt{in}, the step proceeds only to the first executable instruction in the called function. If you specify \texttt{out}, the step includes execution of the called function and proceeds to the instruction at which execution returns to the calling program. If you omit the \texttt{step} parameter, execution steps over a line or instruction.

### 6.4.5 memory

The \texttt{memory} parameter must be set to 8, 16, or 32.

- \texttt{8} Displays memory in 8-bit bytes.
- \texttt{16} Displays memory in 16-bit halfwords.
- \texttt{32} Displays memory in 32-bit words.

The setting of \texttt{memory} is shown in the Size field of the CLI Properties dialog.

To specify the format for displaying values, see \texttt{format} on page 6-6.

### 6.4.6 scope

The \texttt{scope} parameter must be set to \texttt{class}, \texttt{global}, or \texttt{local}.

This parameter specifies that any context variables displayed by the associated command are those scoped to class, global, or local, respectively.
6.4.7  **toggle**

The `toggle` parameter must be set to on or off.

This parameter switches the associated command on or off.
6.5 Definitions

With most commands you have to specify parameters that define, for example, a processor, file, position, address, or format. This section lists these definitions and explains how to use them as command parameters:

**asm** Denotes that assembler instructions are ARM (32-bit), Thumb (16-bit) or Jazelle (8-bit). You must specify ARM, Thumb, ByteCode or auto. If you specify auto, the debugger determines the correct setting itself when possible.

**breakpoint** You specify a breakpoint as its index in the breakpoint list, in the form of a value prefixed by #.

**class** You can identify a class by:
- the class name which can include the name of an image, separated from the class name by a vertical bar, in the form `image|class`
- the index of the class in the current class list, in the form of a value prefixed with #.

**context** You can specify a context by specifying a stack entry, in the form of a value prefixed by #.

**expr** An expression is either a numerical value or an expression that evaluates to a numerical value.

**file** You can identify a file by:
- its filename
- the index of the file in the current file list, in the form of a value prefixed with #
- the globally unique identifier of the file as shown in the output of a files command
- null, the current file is used.

**format** Denotes the format in which the contents of memory, registers, or variables are displayed. You must specify the name or index number of an available format.

**image** You can identify an image by:
- the name of the image
- the index of the image in the current image list, in the form of a value prefixed with #
- the globally unique identifier of the image as shown in the output of an images command
null (defaults to the image associated with the current processor).

index
You can refer to items in a list by specifying their position in the list. For example, this gives you a convenient way of referring to a watchpoint in commands such as clearwatch.

instr
You must specify either instr to define a step as one instruction or line to define a step as one line of source code.

ipvariable
Denotes any one of a group of variables that define image-related properties. The variables currently supported are:

- cmdline
  This variable holds the parameter passed to the image when execution starts. If the image requires multiple parameters, enclose the whole string in quotes ("...").

memory
Denotes that memory is to be displayed in bytes, halfwords, or words. You must specify 8, 16, or 32.

position
To specify a position in a source file, use vertical bar separators as in image|file|line. If you omit the image name, the image associated with the current processor is assumed.

A position might also be a location within an executable image. In this case you can specify it in the form image@address.

A position can also be inferred from many debug objects, such as breakpoints or low-level symbols. You can therefore specify a position as an index of a position-based object in the last displayed list of these objects. Specify the index as a value prefixed by #.

ppvariable
Denotes any one of a group of variables that define processor-related properties. The variables currently supported are:

- vector_catch
  Defines which exceptions in the processor are intercepted by the debugger. For details see Processor pop-up menu on page 5-50 and setprocprop on page 6-47.

- comms_channel
  Enables or disables the communications channel.

- semihosting_enabled
  Enables or disables semihosting, as follows:
  
  0   semihosting disabled
  1   standard semihosting enabled
  2   DCC semihosting enabled (applies only to Multi-ICE® or ARM Agilent Debug Interface, the add-on product to RealView® Developer Suite).
semihosting_vector
   Defines handler address. Applies to Multi-ICE only.

semihosting_dcchandler_address
   Defines handler address. Applies to Multi-ICE only.

arm_semihosting_swi
   Defines ARM software interrupt number reserved for semihosting.

thumb_semihosting_swi
   Defines Thumb software interrupt number reserved for semihosting.

**processor**
   You can identify a processor by:
   * the name of the processor
   * the index of the processor in the current processor list, in the form of a value prefixed with 
     
   * the globally unique identifier of the processor as shown in the output of a processors command
   * null (defaults to the current processor).

**regbank**
   You can identify a register bank by:
   * The name of the register bank. This is processor-dependent. Use the regbanks command to generate a register bank list. Examples of register banks are:
     - Current
     - User or System or User/System
     - IRQ
     - FIQ
     - SVC
     - Abort
     - Undefined
     - EICE
     - EICE Watch 0
     - EICE Watch 1
   For example, to write to the Address register of Watchpoint Unit 0 use:
   
sreg "EICE Watch 0|Address Value" 0x00000008

   * The index of the register bank in the register bank list, in the form of a value prefixed with 
     
   * The globally unique identifier of the register bank shown in the register bank list.
You can use the `registers` command to list the registers in a register bank. You can identify a register by:

- the name of the register
- the index of the register in a register list generated by the `registers` command, in the form of a value prefixed with `#`.

**scope**

Denotes which context variables to display, based on their scope. You must specify `class`, `local`, or `global`.

**step**

This controls the amount of processing that takes place following an instruction that calls a function. You must specify this as `in` or `out`, or omit it. If omitted, the step is interpreted as step over line or instruction.

**string**

You specify a text string enclosed in quotes ("...").

**toggle**

Where this parameter is allowed, you can use it to switch on or off certain properties. You must specify either `on` or `off`.

**value**

You specify a numeric value.

**watchpoint**

You specify a watchpoint as its index in the watchpoint list, in the form of a value prefixed by `#`. 
6.6 Commands

This section lists in alphabetical order all the commands that you can issue using the command-line interface. Refer to Definitions on page 6-9 for descriptions of parameters used with many of these commands.

In the syntax definition of each command, square brackets ([...]) enclose optional parameters and a vertical bar (|) separates alternatives from which you choose one. Do not type the square brackets or the vertical bar.

You might need to type vertical bars when entering hierarchical values, for example `imagename@address` for a position parameter.

Replace parameters printed in italics with the value you require.

When you supply more than one parameter, use a comma or a space as a separator. The syntax definitions and examples in this chapter use a space.

If a parameter is a name that includes spaces, enclose it in quotation marks.

If you want to enter a command that is similar to one you have previously entered, use the up and down arrow keys to retrieve the earlier command, then use the left and right arrow keys to position the cursor where you want to change the command. The number of commands is defined in the history list.

Ctrl+Page Up shows a complete history list of commands.

Where lines of output are described, <tab> indicates that the items are displayed in columns.

A few command descriptions include an alias for the command. You can use either the command or its alias. Aliases are supported because you might be familiar with their use in armsd, or use these forms of the commands in existing script files.

6.6.1 addsourcedir

No longer a valid command. See `setsourcedir` on page 6-49 and `sourcedir` on page 6-53.

6.6.2 backtrace

See `stackentries` on page 6-53.
6.6.3 break

If you supply no parameters, the break command lists all the breakpoints that are currently set. Each breakpoint is shown on a separate line, after a first line containing the headings for the following columns:

| Index | The position in the list. This gives you a convenient way of referring to a breakpoint in commands such as clearbreak. |
| State | Displays an X if the breakpoint is currently disabled. |
| Position | This shows the fully-qualified source code filename in brackets, a colon, and the source code line number at which the breakpoint is set. It also shows, in square brackets, the corresponding memory address. |
| Count | Two numbers are shown as X/Y. X is the number of times execution has arrived at the breakpoint since the last time the breakpoint was triggered. Y is the number of times execution has to arrive at the breakpoint to trigger it. |
| Size | This shows whether the breakpoint is ARM-sized (32 bits) or Thumb-sized (16 bits). The breakpoint size can usually be detected automatically, in which case AUTO is shown. |
| Condition | Any condition that you have specified that must also be satisfied before the breakpoint can be triggered is shown here. This must be a boolean expression. |
| Additional | The final column displays additional information. This can include one or more of the following: Processor Identifies the processor in which the breakpoint is set. S/HW Shows whether the breakpoint is implemented in hardware or software. (ID) A hardware breakpoint can have a hardware resource identifier. These identifiers are shown here. Action This shows whether the action taken when the breakpoint is triggered is to stop execution of the target (Break) or to log the event (Log). |

If you supply parameters, the command creates and sets a new breakpoint so that execution continues until the specified address is visited for the nth time. If you do not specify a value for n, a default value of 1 is assumed, so execution stops every time the address is visited.

The shorthand form of the break command is br.
Syntax

\texttt{br[ expr|posn [ \ n]]}

where:

- \textit{expr|posn} is either an expression or a position that defines where a new breakpoint is to be created.
- \textit{n} specifies the number of times execution must arrive at the breakpoint in order to trigger it. The default value is 1.

Examples

- \texttt{br 0x8000} sets a breakpoint at address 0x8000.
- \texttt{br @main} sets a breakpoint on main.
- \texttt{br c:\test\main.c|130 100} sets a breakpoint on line 130 of file main.c, requiring 100 arrivals to trigger it.
- \texttt{br #5|150} sets a breakpoint at line 150 of file number 5. The index #5 must have been obtained using the files command.

When you have created a new breakpoint, you can change its properties with the \texttt{setbreakprops} command. See \texttt{setbreakprops} on page 6-44.

A sample listing is shown in Example 6-1.

Example 6-1  Break listing

<table>
<thead>
<tr>
<th>Index</th>
<th>Position</th>
<th>Count</th>
<th>Size</th>
<th>Condition</th>
<th>Additional</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1</td>
<td>[0x000084EC]{dhry_1.c:149}</td>
<td>0/1</td>
<td>AUTO</td>
<td>N/A</td>
<td>ARM7T_1 HW(-1) Log: Point A hit Position: [0x000084EC]{C:\Program Files\ARM\RVDS\Examples\dhrystone\dhry_1.c:149}</td>
</tr>
<tr>
<td>#2</td>
<td>[0x000084F0]{dhry_1.c:150}</td>
<td>0/750</td>
<td>AUTO</td>
<td>N/A</td>
<td>ARM7T_1 HW(-1) Break Position: [0x000084F0]{C:\Program Files\ARM\RVDS\Examples\dhrystone\dhry_1.c:150}</td>
</tr>
<tr>
<td>#3</td>
<td>[0x00008290]{dhry_1.c:91}</td>
<td>0/1</td>
<td>AUTO</td>
<td>N/A</td>
<td>ARM7T_1 HW(-1) Break Position: [0x00008290]{C:\Program Files\ARM\RVDS\Examples\dhrystone\dhry_1.c:91}</td>
</tr>
</tbody>
</table>

Note

To set complex breakpoints, use the \texttt{setbreakprops} command (see \texttt{setbreakprops} on page 6-44) or select \texttt{Breakpoints...} from the \texttt{System Views} menu.
6.6.4 cclasses

The cclasses command lists all the classes in the specified class in the currently loaded image. Each class is shown on a separate line, in the following format:

index<tab>classname

The position in this list, index, gives you a convenient way of referring to a class of classes.

The shorthand form of the cclasses command is ccl.

Syntax

ccl class

Example

ccl testclass
Displays subclasses of testclass.

6.6.5 cfunctions

The cfunctions command lists all the functions in the specified class. Each variable is shown on a separate line, in the following format:

index<tab>functionname (parameterlist)

The position in this list, index, gives you a convenient way of referring to a class function.

The shorthand form of the cfunctions command is cfu.

Syntax

cfu class

Example

cfu #2 Displays functions in the class identified by index number 2. The index must have been obtained using the classes command.
6.6.6 classes

The classes command lists all the classes in the specified image, or in the current image if you do not specify an image. Each class is shown on a separate line, in the following format:

index<tab>classname

The position in this list, index, gives you a convenient way of referring to a class. The shorthand form of the classes command is cl.

Syntax

cl[ image]

6.6.7 clear

The clear command clears the command-line window. The shorthand form of the clear command is clr.

Syntax

clr

6.6.8 clearbreak

The clearbreak command unsets and deletes a specified breakpoint or all current breakpoints. See break on page 6-14 for a description of how to refer to a breakpoint.

The shorthand form of the clearbreak command is cbr.

Alias

unbreak is an alias for clearbreak.

Syntax

cbr breakpoint|all

Examples

cbr #2       Clears breakpoint number 2. The index #2 must have been obtained using the break command.
unbreak all  Clears all current breakpoints. The parameter all is case-sensitive.

6.6.9  clearstat

The clearstat command deletes the set of accumulated statistics at the specified reference point.

The shorthand form of the clearstat command is cstat.

Syntax

cstat  referencepoint

where:

referencepoint

  Specifies the set of statistics you want to delete. You must specify a reference point name. This name is case-sensitive. If the name contains spaces, enclose it in double quotes.

Examples

  cstat rp001  Deletes the set of statistics at reference point rp001.

  cstat "Ref Point 2"

  Deletes the set of statistics at reference point Ref Point 2.

You cannot delete the line of statistics that has the reference point name $statistics.

If you specify a reference point that does not exist, an error message is displayed.

See also statistics on page 6-54 for a description of how to add a new reference point or display all reference points.
6.6.10 clearwatch

The clearwatch command unsets and deletes a specified watchpoint or all current watchpoints. See watchpt on page 6-59 for a description of how to refer to a watchpoint.

The shorthand form of the clearwatch command is cwpt.

Alias

unwatch is an alias for clearwatch.

Syntax

cwpt watchpoint|all

Examples

cwpt #2        Clears watchpoint number 2. The index #2 must have been obtained using the watchpt command.

unwatch all    Clears all current watchpoints. The parameter all is case-sensitive.

6.6.11 comment

The comment command sends the specified character string to the current log file. If logging is not taking place this command has no effect.

The shorthand form of the comment command is com.

Syntax

com string
6.6.12 context

If you do not supply a parameter, the context command displays details of the current context, as follows:

Image: imagename|@address
File: sourcefilename|linenumber

If you specify a stack entry, the context command sets the current context to that of the stack entry you specify. See stackentries on page 6-53 for more information on stack entries.

This command does not change the execution context. It enables you to browse through all the available contexts of the current debug session and examine context-related variables.

The shorthand form of the context command is con.

Syntax

con[ parameter]

Example

con #2  Sets the current context to that of stack entry number 2. The index #2 must be obtained using the stackentries command.
6.6.13 convariables

The convariables command displays the name, type, and value of all variables valid in the current or specified context and in the specified scope. If you do not specify a scope, then class, global, and local variables are listed.

The shorthand form of the convariables command is convar.

Syntax

convar[ context][ scope][ format]

where:

context Specifies the context of the variables you want to list, the default being the current context (see stackentries on page 6-53).

scope Can be set to class, global, or local (see scope on page 6-7).

format Specifies the format in which the contents of the variables are listed, if this is different from the default format (see format on page 6-6).

Examples

convar #1 dec

Displays the global, class, and local variables in the context of stack entry number 1, in decimal format. Index #1 must be obtained with the stackentries command.

convar local

Displays the local variables in the current context, in hexadecimal format.
6.6.14 cvariables

The `cvariables` command lists all the variables in the specified class in the currently loaded image. Each variable is shown on a separate line, in the following format:

`index<tab>variablename<tab>type`

The position in this list, `index`, gives you a convenient way of referring to a class variable.

The shorthand form of the `cvariables` command is `cva`.

**Syntax**

`cva class`

**Examples**

`cva testclass`

Displays the class variables of `testclass`.

`cva #1`

Displays the class variables of the class identified by index number 1. The index must be obtained using the `classes` command.

6.6.15 dbginternals

The `dbginternals` command displays the debugger internal variables of the current target. These are the same variables as those displayed when you select **Debugger Internals** from the **System Views** menu. Each variable is shown on a separate line, in the following format:

`variablename<tab>value`

The shorthand form of the `dbginternals` command is `di`.

**Syntax**

`di`
6.6.16 disassemble

The `disassemble` command disassembles and displays lines of assembler code that correspond to the contents of the specified area of memory.

The shorthand form of the `disassemble` command is `dis`.

**Alias**

`list` is an alias for `disassemble`.

**Syntax**

```
dis expr1 [+]expr2 [ asm]
```

where:

- `expr1`: Is an expression that evaluates to the starting address of the area of memory you want to see disassembled.
- `expr2`: Is an expression that either evaluates to the end address of the area of memory you want to see disassembled or, if preceded by `+`, evaluates to the number of bytes you want disassembled. If a value is not supplied on the command line, the value from the Bytes to display property box is used.
- `asm`: Can be set to `ARM`, `Thumb`, `ByteCode` or `auto` (see `asm` on page 6-6). If not specified, the current value of the Instruction Size field of the CLI properties dialog is used.

**Example**

```
dis 0x8200 +64 ARM
```

Displays disassembled instructions that represent the ARM code currently stored in the 64 bytes of memory starting at address `0x8200`.

```
dis 0x8000 +10 ByteCode
```

Displays disassembled instructions that represent the Jazelle code currently stored in the 10 bytes of memory starting at address `0x8000`.
6.6.17 echo

The echo command enables you to choose whether CLI commands read from an Obey file are displayed in the CLI system view. Because you can log whatever is displayed in the CLI system view, this command also determines whether CLI commands read from an Obey file are logged.

If an Obey file includes an echo command, the new setting is effective only while commands from that Obey file are being executed. The echo setting then reverts to the state it was in when the Obey process began.

Using the echo command is equivalent to checking or unchecking the Echo check box in the CLI Properties dialog.

There is no shorthand form of the echo command.

Syntax

echo on|off

where:
on Means that CLI commands subsequently read from an Obey file appear in the CLI system view. This is the default setting.
off Means that CLI commands subsequently read from an Obey file do not appear in the CLI system view.

6.6.18 examine

See memory on page 6-35.
6.6.19 files

The `files` command lists all the source files that have contributed debug information to the specified image, or to the current image if you do not specify an image. Each source file is shown on a separate line, in the following format:

index<tab>ID<tab>filename

This means that you can refer to a source file in any one of three ways:

- **index**: The position in this list.
- **ID**: The identifier of the source file.
- **filename**: The name of the source file.

The shorthand form of the `files` command is `fi`.

**Syntax**

`fi[ image]`

6.6.20 fillmem

The `fillmem` command fills the specified area of memory with the specified value repeated sufficient times. If the size of the area to be filled is not an exact multiple of the size of the value being written, some bytes remain unchanged at the end of the area. The value written (repeatedly) to memory is the value you specify, padded with leading zeros or truncated if necessary to achieve the size you specify with the `memory` parameter.

The shorthand form of the `fillmem` command is `fmem`.

**Syntax**

`fmem expr1[+]expr2 value[ memory]`

where:

- **expr1**: Specifies the starting address of the area of memory to be filled.
- **expr2**: Specifies either the end address or, if preceded by +, the number of bytes of memory to be filled.
- **value**: Specifies what is to be written to memory.
- **memory**: Can be set to 8, 16, or 32, and determines whether value should be evaluated to an 8-bit, a 16-bit, or a 32-bit value (see `memory` on page 6-7).
Example

`fmem 0x83A4 +20 0x61626364 32`

Overwrites the 20 bytes of memory starting at address 0x83A4 with the 4-byte value 0x61626364 repeated five times. To see the effect of this and other commands, load an image, open a Memory processor view big enough to see about 16 lines and set its starting address to 0x8300. Then in the CLI system view perform the examples given for the commands fillmem, savebinary, reload, and loadbinary.

6.6.21 findstring

The `findstring` command searches for the specified string in the specified area of memory or, by default, in the whole available memory range. The command displays messages giving the starting address of every occurrence found of the specified value.

If you view the contents of memory with size set to more than 8 bits, it is possible for bytes to be displayed in an order different from that in which they are stored (as a result of the endian setting). The `findstring` command always tests consecutive memory locations, regardless of how the contents of those locations might be displayed.

The shorthand form of the `findstring` command is `fds`.

Syntax

`fds string[[ low-exp][ [+]] high-exp]]`

where:

- `string` Specifies the string you are seeking.
- `low-exp` Is an expression that evaluates to the memory address where the search is to begin.
- `high-exp` Is an expression that evaluates to the memory address where the search is to end or, if preceded by `+`, the number of bytes of memory to search.

Example

`fds "cb" 0x8300 0x8400`

Reports finding the specified string at five addresses within the specified range if you have performed the fillmem example. The order in which the bytes you entered in the fillmem example are stored depends on the endian setting of the target. This `fds` example assumes they were stored in the order 0x64 0x63 0x62 0x61 ("dcba").
6.6.22 findvalue

The findvalue command searches for the specified value in the specified area of memory or, by default, in the whole available memory range. The command displays messages giving the starting address of every occurrence found of the specified value.

If you view the contents of memory with size set to more than 8 bits, it is possible for bytes to be displayed in an order different from that in which they are stored (as a result of the endian setting). The findvalue command always tests consecutive memory locations, regardless of how the contents of those locations might be displayed.

The shorthand form of the findvalue command is fdv.

Syntax

fdv valexpr[[ low-expr][ [+ ]high-expr]]

where:
valexpr Is an expression that evaluates to the value you are seeking.
low-expr Is an expression that evaluates to the memory address where the search is to begin.
high-expr Is an expression that evaluates to the memory address where the search is to end or, if preceded by +, the number of bytes of memory to search.

Example

fdv 0x6362 0x8300 0x8400

Reports finding the specified value at five addresses within the specified range if you have performed the fillmem example. The order in which the bytes you entered in the fillmem example are stored depends on the endian setting of the target. This fdv example assumes they were stored in the order 0x64 0x63 0x62 0x61 ("dcba").
6.6.23 format

The format command sets the default format to be used for displaying data in the CLI system view or, if issued with no parameters, reports the current display format.

The shorthand form of the format command is fmt. See also, importformat on page 6-31 and listformat on page 6-32.

Syntax

fmt [format_name[ control_string]]

where:

format_name Defines the format to be used, in any of the following forms:
  #n Where n is the index number of the format as shown in the last displayed format list (see listformat on page 6-32).
  RDIName As shown in the last displayed format list.
  ShortName As shown in the last displayed format list, or on the Format tab of the CLI Properties dialog.

control_string Defines any associated control string required by the specified format. For example, with a Q-format as the first parameter, a printf control string as the second parameter defines how values are displayed. (Q-format is currently the only supplied format that can take a further control string.)

Examples

fmt #3 Sets format number 3 as the default for displays in the CLI system view.

fmt Q3.29 %12.6f Interprets data in Q3.29 format and displays the values in 12.6f format.

fmt 0x%4x Uses printf with 0x%4x as its control string.
6.6.24 functions

The `functions` command lists all the functions in the specified image, or of the current image if you do not specify an image. Each function is shown on a separate line, in the following format:

```
index<tab>functiontype functionname (ParameterList)
```

The position in this list, Index, gives you a convenient way of referring to a function.

The shorthand form of the `functions` command is `fu`.

**Syntax**

```
fu[ image]
```

6.6.25 getfile

See `loadbinary` on page 6-33.

6.6.26 go

See `run` on page 6-40.

6.6.27 help

The `help` command invokes AXD online help.

The shorthand form of the `help` command is `hlp`.

**Syntax**

```
hlp
```
6.6.28 images

The images command lists all the images currently loaded on the target. Each image is shown on a separate line, in the following format:

index\tID\timage name

This means that you can refer to an image in any one of three ways:

index  The position in this list.
ID     The identifier of the image.
image name  The name of the image.

For an example of a command that can refer to an image see reload on page 6-40.

The shorthand form of the images command is im.

Syntax

`im`

6.6.29 imgproperties

The imgproperties command displays internal variables related to the specified image, or to the currently loaded image if you do not specify an image. See Definitions on page 6-9 for a list of image-related internal variables that you can set, and `setimgprop` on page 6-45 for details of a command you can use to set them.

Each variable is shown on a separate line, in the following format:

`ipvariable:\tvalue`

The shorthand form of the imgproperties command is ip.

Syntax

`ip[ image]`
6.6.30  importformat

The `importformat` command searches a specified file for any valid format descriptions. Any valid formats found, that do not conflict with internal formats listed under RDINames (see `listformat` on page 6-32), are added to the list of available formats. A parameter enables you to specify what happens in the event of a conflict of format names.

Files most likely to contain format descriptions are supplementary display modules, having a `.sdm` filename extension, see Appendix C *Supplementary Display Module Formats*.

The shorthand form of the `importformat` command is `impfmt`.

See also `format` on page 6-28.

**Syntax**

```
impfmt  sdm_file[ fail_action]
```

where:

- `sdm_file` Specifies a supplementary display module (a `.sdm` file) that contains format descriptions.
- `fail_action` Specifies the action to take if an imported format description conflicts with an existing debugger internal format. You can specify any of the following actions:
  - `fail` This is the default action, and returns an error message reporting the conflict.
  - `msgbox` A message box prompts you to select the fail, ignore, or replace option.
  - `replace` The new format definition replaces the existing one of the same name.
  - `ignore` The new definition is ignored, and the existing definition remains unchanged.

6.6.31  let

See `setwatch` on page 6-50.

6.6.32  list

See `disassemble` on page 6-23.
6.6.33 listformat

The listformat command displays a list of available formats, each on a separate line in the following format:

Index<tab>ShortName<tab>RDIName

The position in this list, Index, gives you a convenient way of referring to a format.

The format name shown under ShortName is the name that appears in the various format submenus. Because you can name and define more formats, this name cannot be guaranteed to be unique. The format name shown under RDIName is the system-wide unique name of each available format.

The shorthand form of the listformat command is lsfmt.

See also format on page 6-28.

Syntax

lsfmt[ n]

where:

n Is an optional number specifying a number of bits. If you specify 16, for example, then the command lists only those formats that are appropriate for displaying 16-bit values. If you do not supply a data item size, then the command lists all available formats.

6.6.34 load

The load command loads the contents of the specified image file onto the specified processor. If you do not specify a processor, the command loads the image onto the current processor.

The shorthand form of the load command is ld.

Syntax

ld file[ processor]

where:

file Specifies the file containing the image you want to load.
processor Specifies the processor onto which you want to load the image.

An image loaded by the load command has a default breakpoint set at the first executable instruction in main().
6.6.35 loadbinary

The loadbinary command reads the specified file and loads its contents into target memory, starting at the specified address.

The shorthand form of the loadbinary command is lb.

**Alias**

getfile is an alias for loadbinary.

**Syntax**

```
lb file addrexpr
```

where:

- **file** Specifies the file containing the data to be loaded.
- **addrexpr** Is an expression that evaluates to a memory address.

**Example**

```
lb sctest.bin 0x8300
```

Copies the contents of a file called sctest.bin into an area of memory starting at address 0x8300. To see the effect of this command, load an image, open a Memory processor view and set its starting address to 0x8300. Then in the CLI system view perform the examples given for the commands fillmem, savebinary, reload, and loadbinary.
6.6.36 loadsession

The loadsession command loads any earlier debug session that was saved in a session file that is still available. (To save a debug session, see savesession on page 6-43.)

The shorthand form of the loadsession command is lss.

Syntax

lss file

where:

file Specifies the session file to load.

6.6.37 loadsymbols

The loadsymbols command loads debug information from the specified file onto the specified processor, or onto the current processor if you do not specify a processor.

The shorthand form of the loadsymbols command is lds.

Alias

readsym is an alias for loadsymbols.

Syntax

lds file[ processor]

where:

file Specifies the file containing the symbols you want to load.

processor Specifies the processor onto which you want to load the symbols.

6.6.38 log

The log command starts or stops logging the contents of the CLI window to a disk file. If you supply no parameter, logging stops. If you supply a filename, logging starts in the specified file and any existing log file is closed. See also record on page 6-38.

There is no shorthand form of the log command.

Syntax

log[ file]
6.6.39 lowlevel

The `lowlevel` command lists all the low-level symbols associated with the specified image, or with the current image if you do not supply a parameter. Each low-level symbol is shown on a separate line, in the following format:

```
index<tab>address<tab>symbolname
```

The position in this list, `index`, gives you a convenient way of referring to a low-level symbol in other commands.

The shorthand form of the `lowlevel` command is `lsym`.

**Syntax**

```
lsym[image]
```

6.6.40 memory

The `memory` command displays the specified area of memory according to the specified size and format parameters, or using default size and format settings if you do not supply them (to set default values, use either the format command or the CLI Properties dialog). Each line displayed shows the contents of 16 bytes of memory, as follows:

```
address<tab>formattedvalues<tab>ASCIIequivalents
```

The shorthand form of the `memory` command is `mem`. The ASCII equivalent is based on the 8-bit value.

**Alias**

`examine` is an alias for `memory`.

**Syntax**

```
mem expr1[+expr2[ memory[ format]]]
```

where:

- `expr1` Is an expression that evaluates to the starting address of the area of memory that you want to examine.
- `expr2` Is an expression that either evaluates to the end address of the area of memory that you want to examine or, if preceded by a +, evaluates to the number of bytes that you want to examine. If `expr2` is not present, the number of bytes displayed uses the value in the Bytes to display dialog box.
- `memory` Can be set to 8, 16, or 32 (see `memory` on page 6-7).
Can be set to the RDI name as shown in the last displayed format list or to the index number of any available format (see format on page 6-6).

**Example**

```
mem 0x8300 +256 8 hex
```

Displays 16 lines, each showing the address of the first byte, the contents of 16 bytes, and their ASCII equivalents.

### 6.6.41 obey

The `obey` command executes the list of CLI commands contained in the specified file. There is no shorthand form of the `obey` command.

**Syntax**

```
obey file
```

where:

`file` Identifies a file containing valid CLI commands, each separated by a carriage return, with the end of file at the beginning of a new line.

### 6.6.42 parse

The `parse` command sets the parsing state on or off according to the supplied parameter. You must normally leave `parse` set to its default value of on so that commands are checked for valid syntax before being translated into internal commands.

The shorthand form of the `parse` command is `par`.

**Syntax**

```
par toggle
```

where:

`toggle` Must be set to on or off.

### 6.6.43 print

See `watch` on page 6-59.
6.6.44 processors

The processors command lists all the processors available on the current target. Each processor is shown on a separate line, in the following format:

index<tab>ID<tab>procname

This means you can refer to a processor in any one of three ways:

index  The position in this list.
ID     The identifier of the processor.
procname The name of the processor.

For examples of commands in which you might need to refer to a processor see stop on page 6-56 and run on page 6-40.

The shorthand form of the processors command is proc.

Syntax

proc

6.6.45 procproperties

The procproperties command displays internal variables related to the debug target of the specified processor, or to the current processor if you do not specify a processor. The command displays variables such as the vector catch settings, semihosting status, and the status of the debug communications channel. Each variable is shown on a separate line, in the following format:

ppvariable<tab>value

The shorthand form of the procproperties command is pp.

Syntax

pp[  image]

6.6.46 putfile

See savebinary on page 6-42.
6.6.47 quitdebugger

The quitdebugger command ends execution of AXD.

The shorthand form of the quitdebugger command is quitd.

Syntax

quitd

6.6.48 readsyms

See loadsymbols on page 6-34.

6.6.49 record

The record command starts or stops the logging of commands (only) to a disk file. If you supply no parameter, logging stops. If you supply a filename, logging starts in the specified file and any existing log file is closed. See also log on page 6-34.

The shorthand form of the record command is rec.

Syntax

rec[ file]

6.6.50 regbanks

The regbanks command lists all the register banks associated with the specified processor, or with the current processor if you do not supply a parameter. Each register bank is shown on a separate line, in the following format:

index<tab>ID<tab>regbankname

The position in this list, index, gives you a convenient way of referring to a register bank in other commands. For this command, ID is given without a leading # character.

The shorthand form of the regbanks command is regbk.

Syntax

regbk[ processor]
6.6.51 registers

The `registers` command lists all the registers and their values in the specified register bank. The register bank name is displayed on the first output line, and column headings on the second. Each register is then shown on a separate line, in the following format:

```
index<tab>regname<tab>regvalue
```

The index value given in this list enables you to specify individual registers in other commands. See `setreg` on page 6-48, for example.

The value of each register is shown in its default format unless you specify a format.

The shorthand form of the `registers` command is `reg`.

**Syntax**

```
reg[ regbank[ format]]
```

where:

- `regbank` Specifies the register bank to be listed. If you do not specify a register bank, the one named `Current` is listed. See `regbanks` on page 6-38 for details of how to specify a register bank.

- `format` Specifies the format to be used in the list if you do not want the default format (see `format` on page 6-6).

**Example**

```
reg user
```

Displays the number, name, and contents of each of the registers in the user register bank. You can issue a `regbk` command to see a list of the current register banks.
6.6.52 reload

The `reload` command reloads the specified image. If you do not specify an image, the command reloads the current image. See `images` on page 6-30 for information on referring to images.

The shorthand form of the `reload` command is `rld`.

**Syntax**

```
rld[image]
```

where:

- `image` Specifies the image you want to reload.

**Example**

```
rld
```

Reloads the current image. This can be useful if you have made changes to the image in memory and want to restore the image to its original state. To see the effect of this command, load an image, open a Memory processor view, and set its starting address to `0x8300`. Then in the CLI system view perform the examples given for the commands `fillmem`, `savebinary`, `reload`, and `loadbinary`.

6.6.53 run

The `run` command starts or restarts execution in the specified processor, or in the current processor if you do not specify a processor.

The shorthand form of the `run` command is `r`.

**Alias**

`go` is an alias for `run`.

**Syntax**

```
r[processor]
```

where:

- `processor` Specifies the processor (the current processor is the default).
6.6.54 runmode

No longer a valid command. See stepsize on page 6-56.

6.6.55 runtopos

The runtopos command causes execution to proceed until the specified position is reached. The command applies to execution in the specified processor, or in the current processor if you do not specify one.

The shorthand form of the runtopos command is rto.

Syntax

\[ rto \ position[ \ processor] \]

where:

\[ position \] Is an expression that evaluates to a memory address or line number.
\[ processor \] Identifies the processor.

Example

\[ rto \ #1 \ | \ 130 \] Causes execution to run to position 130 in the file specified by index 1 in the file list.
6.6.56 savebinary

The savebinary command copies the contents of the specified area of memory to the specified disk file.

The shorthand form of the savebinary command is sb.

Alias

putfile is an alias for savebinary.

Syntax

sb file expr1 [+\)expr2

where:

file Specifies the file in which you want to save the contents of the specified area of memory.

expr1 Is an expression that evaluates to the starting address of the area of memory to save.

expr2 Is an expression that evaluates either to the end address of the area of memory to save or, if preceded by +, to the number of bytes to save.

Example

sb sctest.bin 0x8300 +256

Saves in a file called sctest.bin the contents of the 256-byte area of memory starting at address 0x8300. To see the effect of this command, load an image, open a Memory processor view, and set its starting address to 0x8300, then in the CLI system view perform the examples given for the commands fillmem, savebinary, reload, and loadbinary.
6.6.57  savesession

The savesession command saves details of the current debug session in a specified file. This enables the debug session to be restored to its current state at any future time. (To restore a debug session, see loadsession on page 6-34.)

The shorthand form of the savesession command is ss.

Syntax

ss file

where:

file Specifies the session file to be created.

6.6.58  setaci

The setaci command enables you to set the debugger internal $aci_command to a specified string. If the debugger internal $aci_command is not present then this command generates an error. There is no CLI interface to view the current setting of this property.

The shorthand form of the setaci command is aci.

Syntax

aci string
6.6.59 setbreakprops

The setbreakprops command enables you to set various properties of a breakpoint.

The breakpoint must already exist. Issue the command once for each breakpoint property to be set.

The shorthand form of the setbreakprops command is sbp.

Syntax

`sbp breakpoint propid value`

where:
- `breakpoint` Identifies the breakpoint that is to have a property set.
- `propid` Identifies the name of the property to be set as shown in Table 6-1.
- `value` Specifies the setting you want the property to have. Each property takes its own type of setting as shown in the table.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>state</td>
<td>Flag (enable or disable)</td>
</tr>
<tr>
<td>processor</td>
<td>Processor</td>
</tr>
<tr>
<td>condition</td>
<td>String or value</td>
</tr>
<tr>
<td>log_text</td>
<td>String</td>
</tr>
<tr>
<td>break_size</td>
<td>ASM</td>
</tr>
<tr>
<td>count</td>
<td>Integer</td>
</tr>
</tbody>
</table>

Specify the name exactly as shown in the table, using lowercase characters.

Examples

`sbp #3 state enable`

Enables breakpoint number 3.

`sbp #2 processor #1`

Sets breakpoint number 2 to act on processor number 1.
6.6.60 setimgprop

The `setimgprop` command sets an image-related internal variable to the specified value (see `imgproperties` on page 6-30). You need to supply either a string or an expression, depending on the type of the variable.

The shorthand form of the `setimgprop` command is `sip`.

**Syntax**

```
sip image ipvar value
```

where:

- **image** Specifies the image that is to have an internal variable reset.
- **ipvar** Specifies the ipvariable to be reset. See Definitions on page 6-9 for a list of valid ipvariables.
- **value** Specifies the new value to be assigned to the specified variable.

**Example**

```
sip myimage cmdline "-a -o -z"
```

Specifies that whenever you load (or reload) the image `myimage`, it is supplied with the string "-a -o -z" as though you had entered that string after the image name on a command line. If the string consists of a single parameter, it does not need to be enclosed in quotes.

6.6.61 setmem

The `setmem` command sets the contents of memory at the specified address to the specified value.

The shorthand form of the `setmem` command is `smem`.

**Syntax**

```
smem addrexpr valexpr[ memory]
```

where:

- **addrexpr** Evaluates to the memory address at which you want to insert the new value.
valexpr Evaluates to the value that you want to insert at the specified memory address. This evaluation results in an 8-bit, a 16-bit, or a 32-bit value depending on the setting of the memory parameter, or of the current global variable value if you do not specify the memory parameter.

memory If used must be set to 8, 16, or 32 (see memory on page 6-7).

Example

\texttt{smem 0x83A8 0x41424344 32}

Overwrites the 4 bytes of memory starting at address 0x83A8 with the 4-byte value 0x41424344.

6.6.62 \texttt{setpc}

The \texttt{setpc} command sets the program counter to the specified value. The value you enter is evaluated according to the current setting of the input base variable.

The shorthand form of the \texttt{setpc} command is \texttt{pc}.

Syntax

\texttt{pc expr}

6.6.63 \texttt{setproc}

The \texttt{setproc} command makes the specified processor the current one. If other commands are issued with no processor specified, they apply to the current processor.

The shorthand form of the \texttt{setproc} command is \texttt{sproc}.

Syntax

\texttt{sproc processor}
6.6.64 setprocprop

The `setprocprop` command sets a processor-related internal variable to the specified value (see `procproperties` on page 6-37). You have to supply a value of the type required for the variable you are setting.

The shorthand form of the `setprocprop` command is `spp`.

**Syntax**

```
spp ppvariable value [processor]
```

where:

- **ppvariable** Specifies the variable to be reset. See `Definitions` on page 6-9 for a list of valid ppvariables.
- **value** Specifies the new value to be assigned to the specified variable.
  In the case of the `vector_catch` variable, you can supply a hexadecimal value, a decimal value, a string of characters, or a single character (see Table 6-2).

**processor** Specifies the ID number for the processor.

**Examples**

```
spp vector_catch 0x00DF
```

Is equivalent to using Processor Properties to check all the vector catch check boxes giving a setting of RUSPDIF instead of the default setting of RUSPDIF. See `Configure Processor...` on page 5-95.

```
spp vector_catch IuS
```

Sets the I and S bits on, and the U bit off, leaving the other bits unchanged.

---

**Table 6-2 Allocation of bits in vector_catch variable**

<table>
<thead>
<tr>
<th>Bit Sets</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not used</td>
<td></td>
<td>F</td>
<td></td>
<td>I</td>
<td></td>
<td>D</td>
<td>P</td>
<td>S</td>
<td>U</td>
</tr>
</tbody>
</table>

You are recommended to enclose a string of characters or a single character in quotes. If the string contains the character D or F, you must use quotes to avoid any attempt to interpret it as a hexadecimal value.
spp vector_catch "D"
    Sets the D bit on, and all the other bits unchanged.

spp vector_catch 0
    Sets all the vector catch bits off. If you are debugging an embedded
    application with a JTAG-based debug agent like Multi-ICE, you can use
    this to free a watchpoint unit in the EmbeddedICE logic of the processor.

spp semihosting_enabled 0
    Disables semihosting by not placing a breakpoint on the SWI vector. This
    also frees a watchpoint unit in the EmbeddedICE logic of the processor,
    for debugging an embedded application. For more information see the
    RealView ARMulator ISS v1.4 User Guide.

### 6.6.65 setreg

The `setreg` command sets the specified register in the specified register bank to the
value obtained by evaluating the specified expression (see `registers` on page 6-39). If
you do not specify a register bank, the register bank named `Current` is used.

The expression can include a register bank name and register name.

If you are debugging an Angel target, you can set the registers of the current mode only.

The shorthand form of the `setreg` command is `sreg`.

#### Syntax

```
sreg [regbank|]register expr
```

#### Examples

```
sreg r12 100  Sets register r12 in register bank current to the value 100.
sreg FIQ|r12 IRQ|r13
    Sets register r12 in register bank FIQ to the value of register r13 in register
    bank IRQ.
```
6.6.66 setsourcedir

The setsourcedir command sets the list of paths to be searched.

The paths in this list, and the order in which they are listed, specify the paths searched when a source file is required. To display the current list, see sourcedir on page 6-53.

The shorthand form of the setsourcedir command is ssd.

Syntax

ssd dir_list[ index]

where:

- dir_list: Specifies one or more fully-qualified directories, or is a null string.
- index: Specifies a position within the current list of directories.

The list is of fully qualified directory names. Enclose the list in quotation marks if it contains any spaces. If you are specifying multiple directories, separate them with ; for Windows or : for UNIX.

To clear the current list, issue the ssd command with an empty string.

If you supply an index position, your directory list is inserted before the directory currently listed at the index number you specify.

If you do not supply an index position, your directory list overwrites any existing list of directories.

Examples

ssd "c:\my srcs\proj A;d:\proj B;c:\srclib"
   Replaces any existing list.

ssd ""
   Clears the current list

ssd c:\mydir2 #2
   Inserts the specified directory as the second in the list.
6.6.67 setwatch

The setwatch command sets the specified expression to the specified value. This is of most use when the expression is one that is being watched (see watch on page 6-59).

The shorthand form of the setwatch command is swat.

Alias

let is an alias for setwatch.

Syntax

swat expr1 expr2

where:
express1 Specifies an expression to which you want to assign a value.
expr2 Specifies a new value to be assigned to the expression.

Examples

swat a1 100  Sets variable a1 to the value 100.
swat a b   Sets variable a to the value of variable b.
6.6.68 setwatchprops

The setwatchprops command enables you to set watchpoint properties. The watchpoint must already exist. Issue the command once for each watchpoint property to be set.

The shorthand form of the setwatchprops command is \texttt{swp}.

Syntax

\texttt{swp watchpoint propid value}

where:

\texttt{watchpoint} Identifies the watchpoint that is to have a property set.

\texttt{propid} Identifies the property to be set. You can identify a watchpoint property by its name, as shown in Table 6-3.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>state</td>
<td>Flag (enable or disable)</td>
</tr>
<tr>
<td>processor</td>
<td>Processor</td>
</tr>
<tr>
<td>condition</td>
<td>String or value</td>
</tr>
<tr>
<td>log_text</td>
<td>String</td>
</tr>
<tr>
<td>value</td>
<td>Value</td>
</tr>
<tr>
<td>break_size</td>
<td>ASM</td>
</tr>
<tr>
<td>watch_size</td>
<td>Integer</td>
</tr>
<tr>
<td>count</td>
<td>Integer</td>
</tr>
</tbody>
</table>

Specify the name exactly as shown in the table, using lowercase characters.

\texttt{value} Specifies the setting you want the property to have. Each property takes its own type of setting as shown in the table.

Examples

\texttt{swp \#3 state enable}

Enables watchpoint number 3.
swp #2 value 17
Set the value that is watched for by watchpoint number 2 to 17.

swp #2 watch_size 32
Force the size of watchpoint number 2 to 32 bits.

### 6.6.69 source

The `source` command displays the specified lines of the specified source file, in the following format:

```
linenumber<tab>sourcecode
```

The file must be associated with a loaded image.

The shorthand form of the `source` command is `src`.

**Alias**

type is an alias for `source`.

**Syntax**

```
src value1 [+]value2[ file]
```

where:

- `value1` Specifies the line number in the source file at which you want the listing to begin.
- `value2` Specifies either the last line number to be listed or, if preceded by `+`, the number of lines you want listed.
- `file` Specifies the source file you want to list (by default the command lists the file associated with the current context).

**Example**

```
src 111 +10 Displays lines 111 to 120 of source file dhry_1.c if you have the Dhrystone example program loaded and halted at the default breakpoint.
```
6.6.70  sourcedir

The sourcedir command displays the list of paths searched when a source file is required, in the following format:

index<tab>fully qualified directory name

The paths, on local or remote machines, are searched in the listed order.

To change the list of paths, see setsourcedir on page 6-49.

The shorthand form of the sourcedir command is sdir.

Syntax

sdir

6.6.71  stackentries

The stackentries command lists the current backtrace information stored in the debugger describing the current execution context. Each stack entry is listed on a separate line, in the following format:

index<tab>stackentry

The index value given in this list enables you to specify individual stack entries in other commands. See convariables on page 6-21 and context on page 6-20, for example.

The shorthand form of the stackentries command is stk.

Alias

backtrace is an alias for stackentries.

Syntax

stk[ count]

where:

count          Specifies the number of lines you want listed if you do not want the whole stack displayed.
6.6.72 stackin

The stackin command sets the current context to that of the called procedure or method.

The shorthand form of the stackin command is in.

**Syntax**

in

6.6.73 stackout

The stackout command sets the current context to that of the calling procedure or method.

The shorthand form of the stackout command is out.

**Syntax**

out

6.6.74 statistics

The statistics command adds a new reference point with a specified name or displays all the current reference points, in the following format:

reference point name\tab\value

The shorthand form of the statistics command is stat.

**Syntax**

stat[ \text{ ref\_pt\_name} ]

where:

\text{ ref\_pt\_name} \quad \text{Specifies the name of a new reference point that you want to add. If the name already exists, an error message is displayed.}

\text{ If you do not supply a reference point name, the statistics at all reference points are displayed.}

See also clearstat on page 6-18 for a description of how to delete the statistics at a specified reference point.
**6.6.75 step**

The `step` command causes execution to proceed by one step.

The `step` command is not available when executing Jazelle instructions. Submitting the command when the processor is in Jazelle state produces an error.

The `step` and `step in` commands are not available where the current instruction is a BXJ instruction.

The shorthand form of the `step` command is `st`.

**Syntax**

```
st[ step][ instr]
```

where:

- `step` Can be set to `in` or `out` (see `step` on page 6-7).
- `instr` Can be set to `line` or `instr` (see `instr` on page 6-7).

**Examples**

- **step in line** Steps one source line. If the line contains a subroutine call, steps into the subroutine.

- **step out instr**

  Steps out of the current stack. If no stack frame information is available, steps one instruction.

- **step** Steps, without forcing a step in or out, one instruction or source line depending on the setting of `instr` (see `instr` on page 6-7). If a subroutine call is encountered, this command steps over it.
6.6.76 stepsizes

The stepsizes command enables you to examine or set the step size. To see the current setting, issue the command with no parameter.

The shorthand form of the stepsizes command is ssize.

**Syntax**

ssize[ instr]

where:

instr Can be set to instr or line (see instr on page 6-7), but is overridden if no source is available.

6.6.77 stop

The stop command stops execution of the specified processor, or of the current processor if you supply no parameter.

There is no shorthand form of the stop command.

**Syntax**

stop[ processor]

6.6.78 trace

The trace command toggles the trace status on or off. This command is effective only when the add-on product Trace Debug Tools (TDT) is licensed for use and the target supports trace.

There is no shorthand form of the trace command.

**Syntax**

trace on|off

The command displays no output if it succeeds. If unsuccessful, it displays one of the following error messages:

- not a valid trace target
- fail to start/stop trace
6.6.79 traceload

The traceload command loads a Trace configuration file. This command is effective only when the target supports trace.

The shorthand form of the traceload command is trload.

**Syntax**

```
trload tcfile
```

where:

- `tcfile` Specifies the Trace configuration file to be read.

6.6.80 type

See source on page 6-52.

6.6.81 unbreak

See clearbreak on page 6-17.

6.6.82 update

The update command enables you to specify whether or not screen updates take place while commands from an Obey file are being executed.

The shorthand form of the update command is upd.

**Syntax**

```
upd toggle
```

where:

- `toggle` Can be set to either on or off.

For more information see Command Line Interface Properties dialog, General tab on page 5-66.

6.6.83 unwatch

See clearwatch on page 6-19.
6.6.84 variables

The `variables` command lists all the global variables of the specified image, or of the current image if you do not specify an image. Each variable is listed on a separate line, in the following format:

```
index<tab>varname
```

The position in this list, `index`, gives you a convenient way of referring to a variable.

The shorthand form of the `variables` command is `va`.

**Syntax**

```
va[ image]
```
6.6.85 watch

The watch command displays the name, type, and value of the specified expression, in the following format:

name<tab>type<tab>value

The command displays a simple expression according to the specified format, or the default format if you do not specify one (see also format on page 6-6). It displays a complex expression after suitably expanding it. See also setwatch on page 6-50.

The shorthand form of the watch command is wat.

Alias

print is an alias for watch.

Syntax

wat expr[ format]

Example

wat 5*Int_1_Loc-Int_2_Loc==10 dec

Displays the value 1 (true) if 5*Int_1_Loc-Int_2_Loc evaluates to 10, or 0 (false) otherwise.

6.6.86 watchpt

If you supply parameters, the watchpt command creates and sets a new watchpoint so that execution continues normally until the value stored at the specified location changes for the nth time. If you do not specify n it takes a default value of 1.

If you supply no parameters, the watchpt command lists all the watchpoints that are currently set. Each watchpoint is shown on a separate line, after a first line containing the headings for the following columns:

Index The position in the list. This gives you a convenient way of referring to a watchpoint in commands such as clearwatch.

An X is displayed if the watchpoint is currently disabled.

Item This shows the fully-qualified source code filename in brackets, a colon, and the source code line number at which the watchpoint is set. It also shows, in square brackets, the corresponding memory address, and, if set, the value being watched for.
Watching  This describes what you are watching.

Size     This shows whether the watchpoint is ARM-sized (4bytes), Thumb-sized (2bytes), or a single byte (1byte).

Count    Two numbers are shown. The first is the number of times the value stored at the watchpoint has changed since the last time the watchpoint was triggered. The second shows the number of times the value has to change to trigger the watchpoint.

Condition Any condition that you have specified that must also be satisfied before the watchpoint can be triggered is shown here.

Additional The final column displays additional information. This can include one or more of the following:

- **S/HW**  Shows whether the watchpoint is implemented in hardware or software.
- **(ID)**  A hardware watchpoint can have a hardware resource identifier. Any such identifier is shown here.
- **Processor**  Identifies the processor in which the watchpoint is set.
- **Action**  This shows whether the action taken when the watchpoint is triggered is to stop execution of the target (break) or to log the event (log).

The shorthand form of the watchpt command is `wpt`.

**Syntax**

`wpt [ expr[n] ]`

**Example**

`wpt 0x83A8 5`  Sets a watchpoint at address 0x83A8, requiring 5 changes of content to trigger it.

When you have created a new watchpoint, you can change its properties with the `setwatchprops` command. See `setwatchprops` on page 6-51.

Bitfields are not watchable.

If you are debugging through JTAG or EmbeddedICE logic, ensure that watchpoints on global or static variables use hardware watchpoints to avoid any performance penalty.

You can also use the `wpt` command to set an AXD watchpoint on a range of addresses. For example:
wpt (char[16])=0xF200
traps all data changes that take place in the 16 bytes of memory starting at 0xF200.

For this to work efficiently when you are debugging with, for example, Multi-ICE, ensure that the size of the watchpoint in bytes is a power of 2, and that the address of the watchpoint is aligned on a size-byte boundary. Accesses to the area you specify are trapped only if they change any value stored there. A replacement of a value with the same value, for example, is not trapped.

6.6.87 where

The where command displays information about the specified context, or about the current context if you do not supply a parameter. The command displays the source file name, line number, and source line if the source is available. Otherwise the command displays the disassembled instruction (see stackentries on page 6-53).

There is no shorthand form of the where command.

Syntax

where([ context])
Part B

armsd
Chapter 7
About armsd

The ARM Symbolic Debugger (armsd) is an interactive source-level debugger that provides debugging support for languages such as C, and low-level support for ARM assembly language. It is a command-line debugger that runs on all supported platforms. This chapter contains the following sections:

- *About armsd* on page 7-2
- *Command syntax* on page 7-3.
7.1 About armsd

The ARM symbolic debugger (armsd) can be used to debug programs built using the ARM tools.

7.1.1 Selecting a debugger

armsd supports:

- debugging using RealView® ARMulator® ISS
- remote debugging using ADP.

7.1.2 Automatic command execution on startup

You normally enter armsd commands from the keyboard, or by specifying a script file containing commands, but before armsd accepts any of this input it obeys commands from an initialization file, if one exists.

The initialization file is called armsd.ini. The current directory is searched first for this file, then the directory specified by the environment variable ARMHOME.
7.2 Command syntax

You invoke armsd using the commands given in Command-line options. Underlining shows the permitted abbreviations.

The full list of commands available when armsd is running is given in Alphabetical list of armsd commands on page 9-7.

7.2.1 Command-line options


where:

-help Gives a summary of the armsd command-line options.

-vsn Displays information on the armsd version.

-little Specifies that memory is to be little-endian (the default setting).

-big Specifies that memory is to be big-endian.

-cpu name Specifies the CPU type that is to be simulated. With this option you must not specify -rem or -adp as the target. Specify -armul as the target to invoke RealView ARMulator ISS. If you do not specify a target, RealView ARMulator ISS is invoked if it can simulate the specified processor. If the specified processor cannot be simulated, armsd exits. Instead of name you can specify list, to display a list of processors available on the target. For example:

armsd -cpu list
lists available processors of standard targets (RealView ARMulator ISS and Remote_A)

armsd -armul -cpu list
lists available processors of RealView ARMulator ISS

armsd -target dllname -cpu list
lists available processors of the specified target.

RealView ARMulator ISS is the only ARM supplied target that has a list of available processors.

Instead of -cpu you can still use -proc, but this is now obsolete.

-fpe Instructs RealView ARMulator ISS to load the FPE on startup.
-nofpe  Instructs RealView ARMulator ISS not to load the FPE on startup (this is the default setting).

-symbols  Reads debug information from the specified image file but does not download the image.

-0 name  Writes output from the debuggee to the named file.

-script name  Takes commands from the named file (reverts to stdin on reaching EOF).

-exec  Instructs the debugger to load and execute the named file immediately, and quit when execution stops.

-i name  Adds name to the set of paths to be searched to find source files.

-clock n  Specifies the clock speed in Hz (suffixed with K or M) for RealView ARMulator ISS. This is intended for use with an armsd.map file.

-target dllname  Specifies a .dll file that is a third-party RDI target simulator to be used instead of RealView ARMulator ISS.

-remote  Selects remote debugging. By default this is ADP.

-armul  Selects RealView ARMulator ISS. This is assumed by default if you do not specify a target but do specify a processor type that RealView ARMulator ISS can simulate.

-adp options  Selects remote debugging using ADP, further defined by one or more of the following options:

-port expr  specifies the ADP port to use, where expr selects serial, serial-and-parallel, or ethernet communications and can be one of:

s=n  Selects serial port communications. n can be 1, 2 or a device name.

s=n, p=m  Selects serial-and-parallel port communication. n and m can be 1, 2, or a device name. There must be no space between the arguments.

e=id  Selects ethernet communication. id is the ethernet address of the target board.
For serial and serial-and-parallel communications, you can add $h=0$ to the port expression to switch off the heartbeat feature of ADP. For example, `-port s=1, h=0` selects serial port 1 and turns off the ADP heartbeat.

- **-linespeed n**
  Sets the line speed to $n$.

- **-loadconfig name**
  Specifies a file containing required configuration data, when using a Remote_A connection to EmbeddedICE. See `loadconfig` on page 9-47 for more information.

- **-selectconfig name version**
  Specifies the target for which configuration data is required, when using a Remote_A connection to EmbeddedICE. See `selectconfig` on page 9-48 for more information.

- **image_name**
  Gives the name of the file to debug. You can also specify this information using the load command. See `load` on page 9-28 for more information.

- **args**
  Gives program arguments. You can also specify this information using the load command. See `load` on page 9-28 for more information.

--- Note ---

Where given, the debug file, and any associated arguments, must be the last entry on the command line. This ensures that all specified command-line options are correctly interpreted.
Chapter 8
Getting Started in armsd

This chapter includes more information about the use of the *ARM Symbolic Debugger* (armsd). It contains the following sections:

- Specifying source-level objects on page 8-2
- armsd variables on page 8-7
- Low-level debugging on page 8-13.
8.1 Specifying source-level objects

This section gives information on syntax conventions, variables, program locations, expressions, and constants. It contains the following subsections:

- Command syntax conventions
- Variable names and context
- Program locations on page 8-4
- Expressions on page 8-5
- Constants on page 8-6.

8.1.1 Command syntax conventions

The following conventions are used in descriptions of armsd commands:

- `monospace` Shows command elements that you must type at the keyboard.
- `monospace` Many command names can be abbreviated. Underlined text shows the permitted abbreviation of a command.
- `monospace` Represents an item such as a filename or variable name. Replace this with the name of your file or variable, for example.
- `{}` Items in braces are optional. The braces are for clarity. Do not type them. In the one case where braces are required by the debugger, these are enclosed in quotation marks in the syntax pattern.
- `*` A star (*) following a set of braces means that the items in those braces can be repeated as many times as required.

8.1.2 Variable names and context

You can usually refer to variables by their names in the original source code. To print the value of a variable, type:

```
print variable
```

High-level languages

With structured high-level languages, you can access variables defined in the current context by giving their names. Other variables must be preceded by the context (for example, the name of the function) in which they are defined. This also gives access to variables that are not visible to the executing program at the point at which they are being examined. The syntax is:

```
procedure:variable
```
Global variables

You can access global variables by qualifying them with the module name or filename if there is any ambiguity. For example, because the module name is the same as a procedure name, you must prefix the filename or module name with #. The syntax is:

#module:variable

Ambiguous declarations

If a variable is declared more than once within the same procedure, resolve the ambiguity by qualifying the reference with the line number in which the variable is declared in addition to, or instead of, the function name:

#module:procedure:line-no:variable

Variables within activations of a function

To pick out a particular activation of a repeated or recursive function call, prefix the variable name with a backslash (\) followed by an integer. Use 1 for the first activation, 2 for the second, and so on. A negative number looks backwards through activations of the function, starting with \-1 for the previous one. If no number is specified and multiple activations of a function are present, the debugger always looks at the most recent activation.

To refer to a variable within a particular activation of a function, use:

procedure\{-}activation-number:variable

Expressing context

The complete syntax for the various ways of expressing context is:

{#}module{{:procedure}*}
\{-}activation-number}
{#}procedure{{:procedure}*}
\{-}activation-number}
#

Specifying variable names

The complete syntax for specifying a variable name is:

{context:.{line-number:::}}variable

The various syntax extensions required to differentiate between objects rarely have to be used together.
8.1.3 Program locations

Some commands require arguments that refer to locations in the program. You can refer to a location in the program by:

- procedure name
- program line number
- statement within a line.

In addition to the high-level program locations described here, you can also specify low-level locations. See Entering addresses on page 4-12 and Low-level symbols on page 8-13 for further details.

Procedure name

Using a procedure name alone sets a breakpoint (see break on page 9-12) at the entry point of that procedure.

Program line number

Program line numbers can be qualified in the same way as variable names, for example:

```
#module:123
procedure:3
```

Line numbers can sometimes be ambiguous, for example when a file is included within a function. To resolve any ambiguities, add the name of the file or module in which the line occurs in parentheses. The syntax is:

```
number(filename)
```

Statement within a line

To refer to a statement within a line, use the line number followed by the number of the statement within the line, in the form:

```
line-number.statement-number
```

So, for example, 100.3 refers to the third statement in line 100.
8.1.4 Expressions

Some debugger commands require expressions as arguments. Their syntax is based on C. A full set of operators is available. Lower-numbered operators have higher precedence. These are shown in Table 8-1, in descending order of precedence.

<table>
<thead>
<tr>
<th>Precedence</th>
<th>Operator</th>
<th>Purpose</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>()</td>
<td>Grouping</td>
<td>a * (b + c)</td>
</tr>
<tr>
<td></td>
<td>[]</td>
<td>Subscript</td>
<td>isprime[n]</td>
</tr>
<tr>
<td>rec-&gt;next</td>
<td>-&gt;</td>
<td>Indirect selection</td>
<td>rec-&gt;next is identical to (*rec).next</td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>Logical NOT</td>
<td>!finished</td>
</tr>
<tr>
<td></td>
<td>~</td>
<td>Bitwise NOT</td>
<td>~mask</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>Unary minus</td>
<td>-a</td>
</tr>
<tr>
<td></td>
<td>*</td>
<td>Indirection</td>
<td>*ptr</td>
</tr>
<tr>
<td></td>
<td>&amp;</td>
<td>Address</td>
<td>&amp;var</td>
</tr>
<tr>
<td>3</td>
<td>*</td>
<td>Multiplication</td>
<td>a * b</td>
</tr>
<tr>
<td></td>
<td>/</td>
<td>Division</td>
<td>a / b</td>
</tr>
<tr>
<td></td>
<td>%</td>
<td>Integer remainder</td>
<td>a % b</td>
</tr>
<tr>
<td>4</td>
<td>+</td>
<td>Addition</td>
<td>a + b</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>Subtraction</td>
<td>a - b</td>
</tr>
<tr>
<td>5</td>
<td>&gt;&gt;</td>
<td>Right shift</td>
<td>a &gt;&gt; 2</td>
</tr>
<tr>
<td></td>
<td>&lt;&lt;</td>
<td>Left shift</td>
<td>a &gt;&gt; 2</td>
</tr>
<tr>
<td>6</td>
<td>&lt;</td>
<td>Less than</td>
<td>a &lt; b</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td>Greater than</td>
<td>a &gt; b</td>
</tr>
<tr>
<td></td>
<td>&lt;=</td>
<td>Less than or equal</td>
<td>a &lt;= b</td>
</tr>
<tr>
<td></td>
<td>&gt;=</td>
<td>Greater than or equal</td>
<td>a &gt;= b</td>
</tr>
<tr>
<td>7</td>
<td>==</td>
<td>Equal</td>
<td>a == 0</td>
</tr>
</tbody>
</table>
You can only apply subscripting to pointers and array names. The symbolic debugger checks both the number of subscripts and their bounds, in languages that support this checking. You are advised not to use out-of-bound array accesses. As in C, you can use the name of an array without subscripting to yield the address of the first element.

Use the prefix indirection operator * to dereference pointer values. If ptr is a pointer, *ptr yields the object to which it points.

If the left-hand operand of a right shift is a signed variable, the shift is an arithmetic one and the sign bit is preserved. If the operand is unsigned, the shift is a logical one and zero is shifted into the most significant bit.

--- Note -----
Expressions must not contain function calls that return nonprimitive values.

8.1.5 Constants

Constants can be decimal integers, floating-point numbers, octal integers, or hexadecimal integers. The constant 1 is an integer whereas 1.0 is a floating-point number.

Character constants are also allowed. For example, ‘A’ yields 65, the ASCII code for the character A.

You can specify address constants by the address preceded with an @ symbol. For commands that accept low-level symbols by default, you can omit the @.

<table>
<thead>
<tr>
<th>Precedence</th>
<th>Operator</th>
<th>Purpose</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>&amp;</td>
<td>Bitwise AND</td>
<td>a &amp; b</td>
</tr>
<tr>
<td>9</td>
<td>^</td>
<td>Bitwise EOR</td>
<td>a ^ b</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td>Bitwise OR</td>
</tr>
<tr>
<td>11</td>
<td>&amp;&amp;</td>
<td>Logical AND</td>
<td>a &amp;&amp; b</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8.2 armsd variables

This section lists the variables available in armsd, and gives information on manipulating them. It contains the following subsections:

- Summary of armsd variables
- Accessing variables on page 8-10
- Formatting printed results on page 8-11
- Specifying the base for input of integer constants on page 8-12.

8.2.1 Summary of armsd variables

You can modify many debugger defaults by setting variables. Table 8-2 lists the variables. Most of these are described elsewhere in this chapter in more detail.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$clock (RealView ARMulator ISS only)</td>
<td>Number of microseconds since simulation started. This read-only variable is available only if a processor clock speed is specified. See RealView ARMulator ISS configuration on page 5-87 for information on specifying the simulated processor clock speed.</td>
</tr>
<tr>
<td>$cmdline</td>
<td>Argument string for the debuggee.</td>
</tr>
<tr>
<td>$echo</td>
<td>Nonzero to echo commands from obeyed files (initially 1).</td>
</tr>
<tr>
<td>$examine_lines</td>
<td>Default number of lines for examine command (initially 8).</td>
</tr>
<tr>
<td>$int_format</td>
<td>Default format for printing integer values (initially “0x%.8lx”).</td>
</tr>
<tr>
<td>$float_format</td>
<td>Default format for printing floating-point values (initially “%g”).</td>
</tr>
<tr>
<td>$uint_format</td>
<td>Default format for printing unsigned integer values (initially “0x%.8lx”).</td>
</tr>
<tr>
<td>$sbyte_format</td>
<td>Default format for printing signed byte values (initially “%c”).</td>
</tr>
<tr>
<td>$ubyte_format</td>
<td>Default format for printing unsigned byte values (initially “%c”).</td>
</tr>
<tr>
<td>$string_format</td>
<td>Default format for printing string values (initially “%s”).</td>
</tr>
<tr>
<td>$complex_format</td>
<td>Default format for printing complex values (initially “(%g,%g)”).</td>
</tr>
<tr>
<td>$pointer_format</td>
<td>Default format for printing pointer values (initially “0x%.8lx”).</td>
</tr>
<tr>
<td>$inputbase</td>
<td>Base for input of integer constants (initially 10).</td>
</tr>
<tr>
<td>$list_lines</td>
<td>Default number of lines for list command (initially 16).</td>
</tr>
</tbody>
</table>
### Table 8-2 armsd variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$fpresult</td>
<td>Floating-point value returned by last called function (junk if none, or if a floating-point value was not returned). A read-only variable. $fpresult returns a result only if the image has been built for hardware floating-point. If the image is built for software floating-point, it returns zero.</td>
</tr>
<tr>
<td>$type_lines</td>
<td>Default number of lines for the type command.</td>
</tr>
</tbody>
</table>
| \$memory_statistics (RealView ARMulator ISS only) | Outputs any memory map statistics that RealView ARMulator ISS has been keeping. A read-only variable. See RealView ARMulator ISS configuration on page 5-87 for further details.  

**Note**  
\$memory_statistics is only defined when an armsd.map file is present. |
| \$statistics (RealView ARMulator ISS only) | Outputs any statistics which RealView ARMulator ISS has been keeping. A read-only variable. |
| \$statistics_inc (RealView ARMulator ISS only) | Similar to \$statistics, but outputs the difference between the current statistics and those when \$statistics was last read. A read-only variable. |
| \$vector_catch | Indicates whether or not execution is interrupted when various exceptions occur. The default value is %RUsPDAfE. Capital letters indicate that the exception is to be intercepted:  
R  Reset  
U  Undefined Instruction  
S  SWI  
P  Prefetch Abort  
D  Data Abort  
A  Reserved (do not use)  
I  IRQ  
F  FIQ  
E  Reserved (do not use) |
| \$rdi_log | RDI logging is enabled if nonzero, and serial line logging is enabled if bit 1 is set (initially 0). |
### Table 8-2 armsd variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{top_of_memory}$</td>
<td>This variable informs the debugger where the top of RAM is on your target. This is used to enable Multi-ICE®, EmbeddedICE, and Angel to return sensible values when a <code>HEAP_INFO</code> SWI call is made to determine where to place the heap and stack in memory. The default is $0x80000$ (512KB). Modify this before executing a program on the target if the memory available differs from this.</td>
</tr>
</tbody>
</table>
| $\text{target\_fpu}$ | This variable controls the way that floating-point values are interpreted by the debugger. It is important for correct display of float and double values in memory that this variable is set to a value that is appropriate for the target in use. If you attempt to change this value, a validity test ensures that the only settings allowed are those that are compatible with the representation of floating-point values in the current image. Valid settings and their meanings are:  
1 Selects pure-endian doubles (softVFP). This is the default setting for images built with RealView Developer Suite tools. Values are read from ordinary registers.  
2 Selects mixed-endian doubles (softFPA). Values are read from ordinary registers.  
3 Selects hardware Vector Floating-Point unit (VFP). Values are read from registers CP10 and CP11.  
4 Selects hardware Floating-Point Accelerator (FPA). Values are read from registers CP1 and CP2.  
5 Reserved.  
Incompatible settings are accepted but a warning is given. SoftVFP and SoftFPA images run correctly on a target whether or not hardware floating point is present. FPA images can also run correctly without hardware floating point, but only if the Floating Point Emulator in RealView ARMulator ISS is active. VFP images require appropriate hardware. For more information, see the *RealView Compilation Tools v2.1 Compiler and Libraries Guide*. |
The variables in Table 8-3 are included to support EmbeddedICE.

Table 8-3 armsd variables for Multi-ICE and EmbeddedICE

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$icebreaker_lockedpoints</td>
<td>Shows or sets locked EmbeddedICE logic points.</td>
</tr>
<tr>
<td>$semihosting_vector</td>
<td>Sets up semihosting SWI vector.</td>
</tr>
<tr>
<td>$semihosting_arm_swi</td>
<td>Defines which ARM SWIs are interpreted as semihosting requests by the debug agent. The default is 0x123456. Do not change this.</td>
</tr>
<tr>
<td>$semihosting_thumb_swi</td>
<td>Defines which Thumb SWIs are interpreted as semihosting requests by the debug agent. The default is 0xAB. Do not change this.</td>
</tr>
</tbody>
</table>

8.2.2 Accessing variables

The following commands are available for accessing variables.
print

This command examines the contents of variables in the debugged program, or displays the result of arbitrary calculations involving variables and constants. Its syntax is:

\[ p\{print\}\{/format\} \ expression \]

For example:

\[ print/%x \ listp->next \]

prints field next of structure listp.

If no format string is entered, integer values default to the format described by the variable \$int\_format. The default format string for floating-point values is \%g. By default, pointer values are printed in hexadecimal notation using the format string \%0x.8lx, for example, \%0x000100E4.

let

The \texttt{let} command enables you to change the value of a variable or contents of a memory location. Its syntax is:

\[ \{let\} \ variable = \ expression\{\,\} \ expression\}^* \]
\[ \{let\} \ memory\_location = \ expression\{\,\} \ expression\}^* \]

You can use an equals sign (=) or a colon (:) to separate the variable or location from the expression. If you specify multiple expressions, separate them by commas or spaces.

You can change variables to compatible types of expression only. However, the debugger performs conversions between integer and floating-point values if necessary, rounding to zero. You can change the value of an array, but not its address, because array names are constants. If you omit the subscript, it defaults to zero. If you specify multiple expressions, each expression is assigned to \texttt{variable}[n-1], where \(n\) is the nth expression.

The \texttt{let} command is used in low-level debugging to change memory. If the left-hand expression is a constant or a true expression (and not a variable) it is treated as a word address, and memory at that location (and if necessary the following locations) is changed to the values in the following expression(s).

### 8.2.3 Formatting printed results

You can set the default format strings used by the \texttt{print} command for the output of results of various types of data by using \texttt{let} with the following variable names:

- \$int\_format
- \$uint\_format
- \$float\_format
For example, you can change the value of the root-level variable $int_format from its initial setting of "0x%.81x" to another value with a command of the form:

{let} $int_format = string

The initial value of each of these format variables is given in Summary of armsd variables on page 8-7.

8.2.4 Specifying the base for input of integer constants

You use the $inputbase variable to set the base used for the input of integer constants.

{let} $inputbase = expression

If the input base is set to 0, numbers are interpreted as octal if they begin with 0. Regardless of the setting of $inputbase, hexadecimal constants are recognized if they begin with 0x.

——— Note ————

$inputbase only specifies the base for the input of numbers. For information on output formats see Formatting printed results on page 8-11.
8.3 Low-level debugging

Low-level debugging tables are generated automatically during linking (unless linked with -nodebug).

There is no need to enable debugging at the compilation stage for low-level debugging only.

8.3.1 Low-level symbols

Low-level symbols are differentiated from high-level ones by preceding them with @.

The differences between high and low-level symbols are:

- a low-level symbol for a procedure refers to its call address, often the first instruction of the stack frame initialization
- the corresponding high-level symbol refers to the address of the code generated by the first statement in the procedure.

You can use low-level symbols with most debugger commands. For example, when used with the watch command they stop execution if the word at the location named by the symbol changes. You can also use low-level symbols where a command expects an address expression.

Certain commands (list, find, examine, putfile, and getfile) accept low-level symbols by default. To specify a high-level symbol, precede it by ^.

You can also use memory addresses with commands. These must also be preceded by @. For further details see Entering addresses on page 4-12.

Note

Low-level symbols do not have a context and so they are always available.
8.3.2 Predefined symbols

There are several predefined symbols, as shown in Table 8-4. To differentiate these from any high-level or low level symbols in the debugging tables, precede them with #.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>r0 to r14</td>
<td>The general-purpose ARM registers 0 to 14.</td>
</tr>
<tr>
<td>r15</td>
<td>The address of the instruction that is about to execute. This can include the condition code flags, interrupt enable flags, and processor mode bits, depending on the target ARM architecture. This value can be different from the real value of register 15 because of the effect of pipelining.</td>
</tr>
<tr>
<td>pc</td>
<td>The address of the instruction that is about to execute.</td>
</tr>
<tr>
<td>sp</td>
<td>The stack pointer (r13).</td>
</tr>
<tr>
<td>lr</td>
<td>The link register (r14)</td>
</tr>
<tr>
<td>fp</td>
<td>The frame pointer (r11).</td>
</tr>
<tr>
<td>psr and cpsr</td>
<td>psr and cpsr are synonyms for the program status register for the current mode. The values displayed for the condition code flags, interrupt enable flags, and processor mode bits, are an alphabetic letter for each condition code and interrupt enable flag, and a mode name (preceded by an underscore) for the mode bits. The mode name is one of USER, IRQ, FIQ, SVC, UNDEF, ABORT, and SYSTEM. Mode values out of normal ranges are labeled Reserved_nn. 26-bit mode is no longer supported by the ARM tool chain.</td>
</tr>
<tr>
<td>spsr</td>
<td>spsr is the saved program status register for the current mode. The values displayed are those listed for psr and cpsr.</td>
</tr>
<tr>
<td>f0 to f7</td>
<td>The FPA floating-point registers 0 to 7.</td>
</tr>
<tr>
<td>fpsr</td>
<td>The FPA floating-point status register.</td>
</tr>
<tr>
<td>fpcr</td>
<td>The FPA floating-point control register.</td>
</tr>
<tr>
<td>a1 to a4</td>
<td>These are ATPCS register names. They refer to arguments 1 to 4 in a procedure call (stored in r0 to r3).</td>
</tr>
<tr>
<td>v1 to v7</td>
<td>These are ATPCS register names. They refer to the 5, 6, or 7 general-purpose register variables that the compiler allocates (stored in r4 to r10).</td>
</tr>
<tr>
<td>sb</td>
<td>This is the ATPCS static base in RWPI variants of the ATPCS (r9/v6).</td>
</tr>
<tr>
<td>s1</td>
<td>This is the ATPCS stack limit register, used in variants of the ATPCS that implement software stack limit checking (r10/v7).</td>
</tr>
</tbody>
</table>
Printing register information

You can examine all these registers with the print command and change them with the let command. For example, the following form displays the Program Status Register (PSR):

```
print/%x #psr
```

Setting the PSR

The let command can also set the PSR, using the usual syntax for PSR flags.

For example, you can set the N and F flags, clear the V flag, and leave the I, Z, and C flags untouched and the processor set to 32-bit supervisor mode, by typing:

```
let #psr = %NvF_SVC
```

The following example changes to User mode:

```
psr = %_User
```

--- Note ---

The percentage sign must precede the condition flags and the underscore which in turn must precede the processor mode description.

Using # with low-level symbols

Normally, you do not have to use # to access a low-level symbol. You can use # to force a reference to a root context if you see the error message:

```
Error: Name not found
```

For example, use #pc=0 instead of pc=0.
Getting Started in armsd
Chapter 9
Working with armsd

This chapter lists and explains every command supported by the ARM Symbolic Debugger (armsd). It contains the following sections:

- Groups of armsd commands on page 9-2
- Alphabetical list of armsd commands on page 9-7
- Accessing the debug communications channel on page 9-46
- armsd commands for EmbeddedICE on page 9-47.
9.1 Groups of armsd commands

This section lists all armsd commands in functional groups. The commands are explained individually in *Alphabetical list of armsd commands* on page 9-7.

The functional groups are:

- **Symbols**
- **Controlling execution**
- **Reading and writing memory** on page 9-3
- **Program context** on page 9-3
- **Low-level debugging** on page 9-3
- **Coprocessor support** on page 9-4
- **Profiling commands** on page 9-5
- **Miscellaneous commands** on page 9-5.

The semicolon character (;) separates two commands on a single line.

---

**Note**

The debugger queues commands in the order it receives them, so that any commands attached to a breakpoint are not executed until all previously queued commands have been executed.

---

9.1.1 Symbols

These commands enable you to view information on armsd symbols:

- `symbols` Lists all symbols, such as variables and function names, defined in the given or current context, along with their type information.
- `variable` Provides type and context information on the specified variable (or structure field).
- `arguments` Shows the arguments that were passed to the current procedure, or another active procedure.

9.1.2 Controlling execution

These commands enable you to control execution of programs by setting and clearing watchpoints and breakpoints, and by stepping through instructions and statements:

- `break` Adds breakpoints.
- `call` Calls a procedure.
go          Starts execution of a program.

istep       Steps through one or more instructions.

load        Loads an image for debugging.

reload      Reloads the object file specified on the armd command line, or with the last load command.

step        Steps execution through one or more statements.

unbreak     Removes a breakpoint.

unwatch     Clears a watchpoint.

watch       Adds a watchpoint.

9.1.3 Reading and writing memory

These commands enable you to set and examine program context:

getfile     Reads from a file and writes the content to memory.

putfile     Writes the contents of an area of memory to a file.

9.1.4 Program context

These commands enable you to set and examine program context:

where       Prints the current context as a procedure name, line number in the file, filename and the line of code.

backtrace   Prints information about all currently active procedures.

context     Sets the context in which the variable lookup occurs.

out         Sets the context to be the same as that of the caller of the current context.

in          Sets the context to that called from the current level.

9.1.5 Low-level debugging

These commands enable you to select low-level debugging and to display the contents of memory, registers, and low-level symbols:

language    Sets up low-level debugging if you are already using high-level debugging.
Working with armd

- **registers**: Displays the contents of ARM registers 0 to 14, the PC and the status flags contained in the PSR.

- **fregisters**: Displays the contents of the eight floating-point registers f0 to f7 and the floating-point program status register FPSR.

- **examine**: Enables you to examine the contents of the memory between a pair of addresses, displaying it in both hexadecimal and ASCII formats, with 16 bytes per line.

- **list**: Displays the contents of the memory between a specified pair of addresses in hexadecimal, ASCII and instruction format, with four bytes (one instruction) per line.

- **find**: Finds all occurrences in memory of a given integer value or character string.

- **lsym**: Displays low-level symbols and their values.

### 9.1.6 Coprocessor support

The symbolic debugger includes coprocessor support that enables access to registers of a coprocessor through a debug monitor that is ignorant of the coprocessor. This is only possible if the registers of the coprocessor are read (if readable) and written (if writable) by a single **MRC**, **MCR**, **LDC** or **STC** instruction in a non-User mode. For coprocessors with more unusual registers, there must be support code in a debug monitor. The following commands are available:

- **coproc**: Describes the register set of a coprocessor and specifies how the contents of the registers are formatted for display.

- **cregdef**: Describes how the contents of a coprocessor register are formatted for display.

- **cregisters**: Displays the contents of all readable registers of a coprocessor, in the format specified by an earlier **coproc** command.

- **cwrite**: Writes to a coprocessor register.
9.1.7 Profiling commands

The following commands enable you to start, stop, and reset the profiler, and to write profiling data to a file:

- **pause** Prompts you to press a key to continue.
- **profclear** Resets profiling counts.
- **profon** Starts collecting profiling data.
- **proffoff** Stops collecting profiling data.
- **profwrite** Writes profiling information to a file.

9.1.8 Miscellaneous commands

These are general commands:

- **!** Passes the following command to the host operating system.
- **|** Introduces a comment line.
- **alias** Defines, undefines, or lists aliases. It enables you to define your own symbolic debugger commands.
- **comment** Writes a message to stderr.
- **help** Displays a list of available commands, or help on a particular command.
- **log** Sends the output of subsequent commands to a file in addition to the screen.
- **obey** Executes a set of debugger commands which have previously been stored in a file, as if they are being typed at the keyboard.
- **print** Examines the contents of variables in the program being debugged.
- **type** Types the contents of a source file, or any text file, between a specified pair of line numbers.
- **while** Is part of a multi-statement line.
- **quit** Terminates the current symbolic debugger session and closes any open log or obey files.
9.1.9 Commands to access the debug communications channel

ccin
Selects a file to read.
ccout
Selects a file to write.

For details of these commands see Accessing the debug communications channel on page 9-46.

9.1.10 Commands for EmbeddedICE

The following commands support EmbeddedICE. These are deprecated and will not be supported in future versions of the toolkit.

listconfig
Lists configurations known to the debug agent.
loadagent
Downloads an EmbeddedICE ROM image.
loadconfig
Loads an EmbeddedICE configuration data file.
selectconfig
Selects an EmbeddedICE configuration block.

For details of these commands see armsd commands for EmbeddedICE on page 9-47.
9.2 Alphabetical list of armsd commands

This section explains how the armsd command syntax is annotated, and lists the terminology used. Every armsd command is then listed and explained, starting with the ! command on page 9-9.

9.2.1 Names used in syntax descriptions

These terms are used in the following sections for the command syntax descriptions:

**Context** The activation state of the program. See Variable names and context on page 8-2.

**Expression** An arbitrary expression using the constants, variables, and operators described in Expressions on page 8-5. It is either a low-level or a high-level expression, depending on the command.

**Low-level** Low-level expressions are arbitrary expressions using constants, low-level symbols, and operators. You can include high-level variables in low-level expressions if their specification starts with \# or $, or if they are preceded by ^.

**High-level** High-level expressions are arbitrary expressions using constants, variables, and operators. You can include low-level symbols in high-level expressions by preceding them with @.

The list, find, examine, putfile, and getfile commands require low-level expressions as arguments. All other commands require high-level expressions.

**Location** A location within the program (see Program locations on page 8-4).

**Variable** A reference to a variable in the program. Use the simple variable name to look at a variable in the current context, or add more information as described in Variable names and context on page 8-2 to see a variable elsewhere in the program.

**Format** This is one of:

- hex.
- ascii.
- string.

This is a sequence of characters enclosed in double quotes ("'). A backslash (\) can be used as an escape character within a string.
A C `printf()` function format descriptor. Table 9-1 shows some common descriptors.

### Table 9-1 Format descriptors

<table>
<thead>
<tr>
<th>Type</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>%d</td>
<td>signed decimal integer (default for integers)</td>
</tr>
<tr>
<td></td>
<td>%u</td>
<td>unsigned integer</td>
</tr>
<tr>
<td></td>
<td>%x</td>
<td>hexadecimal (lowercase letters) (same as hex format).</td>
</tr>
<tr>
<td>char</td>
<td>%c</td>
<td>character (same as ascii format).</td>
</tr>
<tr>
<td>char *</td>
<td>%s</td>
<td>pointer to character (same as string format).</td>
</tr>
<tr>
<td>void *</td>
<td>%p</td>
<td>pointer (same as %.8x), for example, 00018abc.</td>
</tr>
<tr>
<td>float</td>
<td>%e</td>
<td>exponent notation, for example, 9.999999e+00</td>
</tr>
<tr>
<td></td>
<td>%f</td>
<td>fixed point notation, for example, 9.999999</td>
</tr>
<tr>
<td></td>
<td>%g</td>
<td>general floating-point notation, for example, 1.1, 1.2e+06.</td>
</tr>
</tbody>
</table>
9.2.2 ! command

The ! command gives access to the command line of the host system without quitting the debugger.

Syntax

The syntax of ! is:

! command

where:

command Is the operating system command to execute.

Usage

Any command whose first character is ! is passed to the host operating system for execution. For example, !dir (DOS) or !ls (UNIX) lists the contents of the current directory.

9.2.3 | command

The | command introduces a comment line.

Syntax

The syntax of | is:

| comment

where:

comment Is a text string.

Usage

This command enables you to annotate your armsd script file.
9.2.4 alias

The alias command defines, undefines, or lists aliases. It enables you to define symbolic debugger commands.

Syntax

The syntax of alias is:

```
alias {name{expansion}}
```

where:

- `name` Is the name of the alias.
- `expansion` Is the expansion for the alias.

Usage

If you supply no argument, all currently defined aliases are displayed. If expansion is not specified, the alias named is deleted. Otherwise expansion is assigned to the alias name.

The expansion can be enclosed in double quotes ("") to enable the inclusion of characters not normally permitted or with special meanings, such as the alias expansion character (') and the statement separator (;).

Aliases are expanded whenever a command line or the command list in a do clause is about to be executed.

Words consisting of alphanumeric characters enclosed in backquotes (') are expanded. If no corresponding alias is found they are replaced by null strings. If the character following the closing backquote is non-alphanumeric, the closing backquote can be omitted. If the word is the first word of a command, the opening backquote can be omitted. To use a backquote in a command, precede it with another backquote.

Example

```
alias restart "reload;break @main;go"
```
9.2.5 arguments

The arguments command shows the arguments that were passed to the current, or other active procedure.

Syntax

The syntax of arguments is:

\[
\text{arguments} \{\text{context}\}
\]

where:

\[
\text{context}
\]

Specifies the program context to display. If context is not specified, the current context is used (normally the procedure active when the program was suspended).

Usage

You use the arguments command to display the name and context of each argument within the specified context.

9.2.6 backtrace

The backtrace command prints information about all currently active procedures, starting with the most recent, or for a given number of levels.

Syntax

The syntax of backtrace is:

\[
\text{backtrace} \{\text{count}\}
\]

where:

\[
\text{count}
\]

Specifies the number of levels to trace. This is an optional argument. If you do not specify count, the currently active procedures are traced.

Usage

When your program has stopped running, because of a breakpoint or watchpoint, you use backtrace to extract information on currently active procedures. You can access information like the current function and the line of source code calling the function, for example.
9.2.7 break

The break command enables you to specify breakpoints.

Syntax

The syntax of the break command is:

```
break{/size} {loc {count} {do '{'command;'command'}'} {if expr}}
```

where:

- `/size` Specifies which code type to break:
  - `/16` Specifies the instruction size as Thumb.
  - `/32` Specifies the instruction size as ARM.
  
  If you do not specify `size`, break determines the breakpoint size by extracting information from the nearest symbol at or below the address to be broken. This is usually correct, if debug information is available. You must specify `size` when, for example, you set a breakpoint on ROM.

- `loc` Specifies where to break the code. See Program locations on page 8-4.

- `count` Specifies the number of times the statement must be executed before the program is suspended. It defaults to 1, so if `count` is not specified, the program is suspended the first time the breakpoint is encountered.

- `do` Specifies commands to be executed when the breakpoint is reached. These commands must be enclosed in braces. Commands must be separated by semicolons. If you not specify a `do` clause, break displays the program and source line at the breakpoint. If you want the source line displayed in conjunction with the `do` clause, use `where` as the first command in the `do` clause.

- `expr` Makes the breakpoint conditional on the value of `expr`.

Usage

The break command specifies breakpoints at:

- procedure names
- lines
- statements within a line.

Each breakpoint is given a number prefixed by `. A list of current breakpoints and their numbers is displayed if break is used without any arguments.

--- Note ---

Use `unbreak` to delete any unwanted breakpoints. See `unbreak` on page 9-42.

---
9.2.8 call

The call command calls a procedure.

Syntax

The syntax of the call command is:

```
call {/size} loc {{expression-list}}
```

where:

`/size` Specifies whether the procedure is entered in ARM state or Thumb state:

```
/16 specifies Thumb code
/32 specifies ARM code.
```

With no size specifier, call tries to determine the instruction set of the destination code by extracting information from the nearest symbol at or below the address to call. This usually chooses the correct size, but you can set the size explicitly. The command correctly sets the PSR T-bit to switch to ARM or Thumb state before the call, and restores it on exit.

`loc` Is a function or low-level address.

`expression_list` Is a list of arguments to the procedure. String literals are not permitted as arguments. If you specify more than one expression, separate the expressions with commas.

Usage

If the procedure (or function) returns a value, examine it using:

```
print $result For integer variables.
print $fpresult For floating-point variables.
```

9.2.9 coproc

The coproc command describes the register set of a coprocessor and specifies how the contents of the registers are formatted for display.

Syntax

The syntax of the coproc command is:

```
coproc cpnum {rno{rno1} size access values {displaydesc}+}*+
```
where:

- **cpnum**: Identifies the coprocessor.
- **rno{::rno1}**: Identifies the register set.
- **size**: Is the register size in bytes.
- **access**: Can comprise the letters:
  - **R**: The register is readable.
  - **W**: The register is writable.
  - **D**: The register is accessed through LDC or STC instructions (if not present, the register is accessed through MRC or MCR instructions).

- **values**: The format depends on whether the register is to be accessed through MRC/MCR instructions or through LDC/STC instructions. If access is through MRC/MCR instructions, it comprises four integer values separated by a space or comma. These values form bits 0 to 7 and 16 to 23 of an MRC instruction to read the register, and bits 0 to 7 and 16 to 23 of an MCR instruction to write the register:
  
  - `r0_7, r16_23, w0_7, w16_23`

  If access is through LDC/STC instructions, it comprises two integer values to form bits 12 to 15 and bit 22 of LDC or STC instructions to read and write the register:
  
  - `b22, b12_15`

- **displaydesc**: Describes how the contents of the registers are to be formatted for display, and takes one of the forms listed in Table 9-2 on page 9-15.

### Usage

Each command can describe one register, or a range of registers, that are accessed and formatted uniformly.

### Example

For example, the floating-point coprocessor might be described by the command:

```
coproc 1 0:7 16 RWD 1,8
8 4 RW 0x10,0x30,0x10,0x20 w0[16:20] 'izoux' '_' w0[0:4] 'izoux'
9 4 RW 0x10,0x50,0x10,0x40
```
Values for the displaydesc argument

Values for the displaydesc argument are given in Table 9-2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>string</td>
<td>Printed as is.</td>
</tr>
<tr>
<td>field string</td>
<td>Used as a printf format string to display the value of field.</td>
</tr>
<tr>
<td>field '{' string {string}* '}' field</td>
<td>One of the forms wn, wn[bit], or wn[bit1:bit2]. The string in the appropriate position for the value of field is displayed (the first string for value 0, and so on).</td>
</tr>
<tr>
<td>field 'letters'</td>
<td>One of the forms wn[bit] or wn[bit1:bit2]. There must be one character in letters for each bit of field. The letters are displayed in uppercase if the corresponding bit of the field is set, and in lowercase if it is clear. The first letter represents the lowest bit if bit1 &lt; bit2, otherwise it represents the highest bit.</td>
</tr>
</tbody>
</table>
9.2.10 context

The context command sets the context in which the variable lookup occurs.

**Syntax**

The syntax of the context command is:

```plaintext
context context
```

where:

- `context` specifies the program context. If `context` is not specified, the context is reset to the active procedure.

**Usage**

The context command affects the default context used by commands that take a context as an argument. When program execution is suspended, the search context is set to the active procedure.

9.2.11 cregisters

The cregisters command displays the contents of all readable registers of a coprocessor.

**Syntax**

The syntax of the cregisters command is:

```plaintext
cregisters cpnum
```

where

- `cpnum` selects the coprocessor.

**Usage**

The contents of the registers is displayed in the format specified by an earlier coproc command. The formatting options are described in Table 9-2 on page 9-15.

9.2.12 cregdef

The cregdef command describes how the contents of a coprocessor register are formatted for display.
Syntax
The syntax of the `cregdef` command is:
```bash
cregdef cpnum rno displaydesc
```
where:
- `cpnum` Selects the coprocessor.
- `rno` Selects the register number in the selected coprocessor.
- `displaydesc` Describes how the processor contents are formatted for display.

Usage
The contents of the registers is displayed according to the formatting options described in Table 9-2 on page 9-15.

9.2.13 cwrite

The `cwrite` command writes to a coprocessor register.

Syntax
The syntax of the `cwrite` command is:
```bash
cwrite cpnum rno val\{val...\}* 
```
where:
- `cpnum` Selects the coprocessor.
- `rno` Selects the register number in the named coprocessor.
- `val` Each `val` is an integer value and there must be one `val` item for each word of the coprocessor register.

Usage
Before you write to a coprocessor register, you must define that register as writable. This is described in `coproc` on page 9-13.

9.2.14 examine

The `examine` command enables you to examine the contents of memory.
Syntax

The syntax of the examine command is:

\texttt{examine \{expression1\} \{, \{+\}expression2\}}

where:

- \texttt{expression1} gives the start address. The default address used is either:
  - the address associated with the current context, minus 64, if the context has changed since the last examine command was issued
  - the address following the last address displayed by the last examine command, if the context has not changed since the last examine command was issued.

- \texttt{expression2} specifies the end address, which can take three forms:
  - if omitted, the end address is the value of the start address +128
  - if \texttt{expression2} is preceded by +, the end address is given by the value of the start line + \texttt{expression2}
  - if there is no +, the end line is the value of \texttt{expression2}.

You can use the $\texttt{examine_lines}$ variable to alter the default number of lines displayed from its initial value of 8 (128 bytes).

Usage

This command enables you to examine the contents of the memory between a pair of addresses, displaying it in both hexadecimal and ASCII formats, with 16 bytes per line. Low-level symbols are accepted by default.

9.2.15 find

The \texttt{find} command finds all occurrences in a specified area of memory of a given integer value or character string.

Syntax

The syntax of the \texttt{find} command is either of the following:

\texttt{find expression1,expression2,expression3}
\texttt{find string,expression2,expression3}
where:

expression1  Gives the words in memory to search for.
expression2  Specifies the lower boundary for the search.
expression3  Specifies the upper boundary for the search.
string       Specifies the string to search for.

Usage
If the first form is used, the search is for words in memory whose contents match the value of expression1.

If the second form is used, the search is for a sequence of bytes in memory (starting at any byte boundary) whose contents match those of string.

Low-level symbols are accepted by default.

9.2.16 fpregisters
The fpregisters command displays the contents of the eight FPA floating-point registers f0 to f7 and the Floating Point Status Register (FPSR).

Syntax
The syntax of the fpregisters command is:

fpregisters[/full]

where:

/full       Includes more information on the floating-point numbers in the registers.

Usage
There are two formats for the display of floating-point registers.

fpregisters       Displays the registers and FPSR, in the following form:

f0 = 0           f1 = 3.1415926535
f2 = Inf         f3 = 0
f4 = 3.1415926535 f5 = 1
f6 = 0           f7 = 0
fpsr = %IZ0ux_izoux
fpregisters/full

Produces a more detailed display:

\[
\begin{align*}
\text{f0} & = I + 0x3FFF 1 0x0000000000000000 \\
\text{f1} & = I + 0x4000 1 0x490FDAA208BA2000 \\
\text{f2} & = I + 0x43FF 1 0x0000000000000000 \\
\text{f3} & = I - 0x0000 0 0x0000000000000000 \\
\text{f4} & = I + 0x4000 1 0x490FDAA208BA2000 \\
\text{f5} & = I + 0x3FFF 1 0x0000000000000000 \\
\text{f6} & = I + 0x0000 0 0x0000000000000000 \\
\text{f7} & = I + 0x0000 1 0x0000000000000000 \\
\text{fpsr} & = 0x01070000
\end{align*}
\]

(fpregisters/full does not output both sets of values.)

The format of this display is (for example):

\[
\begin{align*}
F & S \\ Exp & J \\ Mantissa & u
\end{align*}
\]

where:

- **F** Specifies precision and format:
  - F: Single precision
  - D: Double precision
  - E: Extended precision
  - I: Internal format
  - P: Packed decimal

- **S** Is the sign.

- **Exp** Is the exponent.

- **J** Is the bit to the left of the binary point.

- **Mantissa** Are the digits to the right of the binary point.

- **u** The u between the sign and the exponent indicates that the number is flagged as uncommon, in this example infinity. This applies only to internal format numbers.

In the FPSR description, the first set of letters represent the current settings of the five Exception Trap Enables, also called the Exception Mask. The second set of letters are the Cumulative Exception Flags and represent the exceptions that have occurred. The status of the mask and flag bits is indicated by their case. Uppercase means the flag is set and lowercase means it is cleared.

The exceptions represented are:

- I: Invalid operation
- Z: Divide by zero
0   Overflow
U   Underflow
X   Inexact.

Bits 16 to 20 of the 32-bit FPSR are the Exception Trap Enables, and bits 0 to 4 are the Cumulative Exception Flags.

9.2.17  go

The go command starts execution of the program.

Syntax

The syntax of the go command is:

```
go {while expression}
```

where:

```
while   If while is used, expression is evaluated when a breakpoint is reached. If expression evaluates to true (that is, nonzero), the breakpoint is not reported and execution continues.
```

```
expression   Specifies the expression to evaluate.
```

Usage

The first time go is executed, the program starts from its normal entry point. Subsequent go commands resume execution from the point at which it was suspended.

9.2.18  getfile

The getfile command reads from a file and writes the content to memory.

Syntax

The syntax of the getfile command is:

```
getfile filename expression
```

where:

```
filename   Names the file to read from.
```

```
expression   Defines the memory location to write to.
```
Usage

The contents of the file are read as a sequence of bytes, starting at the address which is the value of expression. Low-level symbols are accepted by default.

Example

getfile image.bin 0x0

**9.2.19 help**

The help command displays a list of available commands, or help on commands.

Syntax

The syntax of the help command is:

```
help {command}
```

where:

- **command** is the name of the command you want help on.

Usage

The display includes syntax and a brief description of the purpose of each command. If you need information about all commands, in addition to their names, type help *.

**9.2.20 in**

The in command changes the current context by one activation level.

Syntax

The syntax of the in command is:

```
in
```

Usage

The in command sets the context to that called from the current level. It is an error to issue an in command when no further movement in that direction is possible.

**9.2.21 istep**

The istep command steps execution through one or more instructions.
Syntax

The syntax of the istep command is:

```
isstep {in} {count|while} expression
isstep out
```

Usage

This command is analogous to the step command except that it steps through one instruction at a time, rather than one high-level language statement at a time.

The use of the istep command is not supported in Jazelle state. Submitting this command generates an error message.

9.2.22 language

The language command sets the high-level language.

Syntax

The syntax of the language command is:

```
language {language}
```

where:

```
language       Specifies the language to use. Enter one of the following:
               •   none
               •   C
               •   F77
               •   PASCAL
               •   ASM.
```

Usage

The symbolic debugger uses any high-level debugging tables generated by a compiler to set the default language to the appropriate one for that compiler, whether it is Pascal, Fortran, or C. If it does not find high-level tables, it sets the default language to none, and modifies the behavior of where and step so that:

```
where    Reports the current program counter and instruction.
step     Steps by one instruction.
```
9.2.23 **let**

The `let` command enables you to change the value of a variable or contents of a memory location.

**Syntax**

The syntax of the `let` command is:

```
{let} {variable | location} = expression{,} expression*
```

where:

- `variable` Names the variable to change.
- `location` Names the memory location to change.
- `expression` Contains the expression or expressions.

**Usage**

You use the `let` command in low-level debugging to change memory. If the left-side expression is a constant or a true expression (and not a variable), it is treated as a word address, and memory at that location (and if necessary the following locations) is changed to the values in the following expression(s).

An equals sign (=) or a colon (:) can separate the variable or location from the expression. If you specify multiple expressions, separate them by commas or spaces.

Variables can only be changed to compatible types of expression. However, the debugger converts integers to floating-point and vice versa, rounding to zero. The value of an array can be changed, but not its address, because array names are constants. If the subscript is omitted, it defaults to zero.

If you specify multiple expressions, each expression is assigned to `variable[n-1]`, where `n` is the `n`th expression.

See also `let` on page 8-11 for more information on the `let` command.

**Specifying the source directory**

You can use the variable `$sourcedir` to specify alternative search paths for source files for the image currently loaded. This variable defaults to NULL if no alternative directories are specified. You can set the value of `$sourcedir` using the command:

```
{let} $sourcedir = string
```
where string must be a valid pathname, or pathnames. The string must be enclosed in double quotes. If you are using armsd in a Windows DOS environment you must escape the backslash directory separator with another backslash character.

For example:

```
let $sourcedir="c:\\myhome"
```

Multiple paths must be separated by a semicolon. For example:

```
ARMSD: let $sourcedir = "/home/usr/me/src;/home/usr/me/src2"
```

```
ARMSD: p $sourcedir
"/home/usr/me/src;/home/usr/me/src2"
```

```
ARMSD: let $sourcedir = "/home/usr 2/HER NAME/PROJ B FILES"
```

--- Note ---

No warning is displayed if you enter an invalid pathname.

--- Command-line arguments ---

You can specify command-line arguments for the debuggee using the let command with the root-level variable $cmdline. The syntax is:

```
{let} $cmdline = string
```

The program name is automatically passed as the first argument, so you must not include it in the string. You can examine the setting of $cmdline using print. Commands that use the program name are:

- go Starts execution of the program.
- getfile Reads the contents of an area of memory from a file.
- load Loads an image for debugging.
- putfile Writes the contents of an area of memory to a file.
- reload Reloads the object file specified on the armsd command line, or the last load command.
- type Types the contents of a source file, or any text file, between a specified pair of line numbers.

--- Reading and writing bytes and halfwords (shorts) ---

When you specify a write to memory in armsd, a word value is used. For example:
let 0x8000 = 0x01

makes armsd transfer a word (4 bytes) to memory starting at the address 0x8000. The bytes at 0x8001, 0x8002, and 0x8003 are zeroed.

To write only a single byte, you must indicate that a byte transfer is required. You can do this with:

let *(char *)0xaddress = value

Similarly, to read from an address use:

print *(char *)0xaddress

You can also read and write halfwords (shorts) in a similar way:

let *(short *)0x8000 = valueprint /%x *(short *)0x8000

where /%x displays in hex.

**Editing long long variables**

If you are changing the value of a long long or unsigned long long variable, your new value might be of such a length that it appears to be invalid. In this case, enter LL or ULL as appropriate at the end of the new value to force its acceptance.
9.2.24 list

The list command displays the contents of the memory between a specified pair of addresses in hexadecimal, ASCII, and instruction format, with four bytes (one instruction) per line.

Syntax

The syntax of the list command is:

```
list[/size] {expression1}, {+}expression2
```

where:

- **size** Distinguishes between ARM and Thumb code:
  - /16 Lists as Thumb code
  - /32 Lists as ARM code.

  With no size specifier, list tries to determine the instruction set of the destination code by extracting information from the nearest symbol at or below the address to start the listing.

- **expression1** Gives the start address. If unspecified, this defaults to either:
  - the address associated with the current context minus 32, if the context has changed since the last list command was issued
  - the address following the last address displayed by the last list command, if the context has not changed since the last list command was issued.

- **expression2** Gives the end address. It can take three forms:
  - if expression2 is omitted, the end address is the value of the start address + 64
  - if it is preceded by +, the end address is the start line + expression2
  - if there is no +, the end line is the value of expression2.

Usage

The $list_lines variable can alter the default number of lines displayed from its initial value of 16 (64 bytes).

Low-level symbols are accepted by default.
9.2.25 load

The `load` command loads an image for debugging.

**Syntax**

The syntax of the `load` command is:

```
load[/profile-option] image-file {arguments}
```

where:

- `profile-option` Specifies which profiling option to use:
  - `/callgraph` Directs the debugger to provide the image being loaded with counts which enable the dynamic call-graph profile to be constructed.
  - `/profile` Directs the debugger to prepare the image being loaded for flat profiling.

- `image-file` Is the name of the file to be debugged.
- `arguments` Are the command-line arguments the program normally takes.

**Usage**

You can also specify `image-file` and any necessary `arguments` on the command line when the debugger is invoked. See *Command-line options* on page 7-3 for more information.

If no arguments are supplied, the arguments used in the most recent load or reload, setting of `$cmdline`, or command-line invocation are used again.

The `load` command clears all breakpoints and watchpoints, and does not set a breakpoint at `main()` by default.

If the image you are loading uses floating point data, the `$target_fpu` debugger internal variable must match the image. See Table 8-2 on page 8-7.

9.2.26 localvar

The `localvar` command creates a debugger variable of the specified type in the symbol table maintained by the debugger (so access to the variable requires a `$` prefix).
Syntax

The syntax of the `localvar` command is:

```
localvar vartype varname
```

where:

- `vartype` Specifies the type of the variable you are creating
- `varname` Is the name of the variable you are creating.

Usage

Use `localvar` to create a local variable, as in the following example that sets the contents of memory from address 0x8000 to address 0x8FFF to all zeros:

```
localvar int fred
$fred = 0x8000
*$fred = 0; $fred = $fred + 4; while $fred < 0x9000
```
9.2.27  log

The log command sends the output of subsequent commands to a file and to the screen.

Syntax

The syntax of the log command is:

log filename

where:

filename      Is the name of the file where the record of activity is being stored.

Usage

To stop logging, type log with no argument. View the file with type or a text editor.

Note

The debugger prompt and the debug program input/output is not logged.
9.2.28  lsym

The `lsym` command displays low-level symbols and their values.

Syntax

The syntax of the `lsym` command is:

```
lsym pattern
```

where:

- `pattern` Is a symbol name or part of a symbol name.

Usage

The wildcard (*) matches any number of characters. You can use it at the start of the pattern, at the end, or both:

```
lsym *fred       Displays information about fred, alfred.
lsym fred*      Displays information about fred, frederick.
lsym *fred*     Displays information about alfred, alfreda, fred, frederick.
```

The wildcard ? matches one character:

```
lsym ??fred      Matches Alfred.
lsym Jo?         Matches Joe, Joy, and Jon.
```

9.2.29  obey

The `obey` command executes a set of debugger commands that have previously been stored in a file, as if they were being typed at the keyboard.

Syntax

The syntax of the `obey` command is:

```
obey command-file
```

where:

- `command-file` Is the file containing the list of commands for execution.
Usage

You can store frequently-used command sequences in files, and call them using obey.

9.2.30 out

The out command changes the current context by one activation level and sets the context to that of the caller of the current context.

Syntax

The syntax of the out command is:

```
out
```

Usage

If you issue an out command when no further movement in that direction is possible an error message is generated.

If you want to step though assembly language code you must ensure that you use frame directives in your assembly language code to describe stack usage. See the RealView Compilation Tools v2.1 Assembler Guide for more information.

9.2.31 pause

The pause command prompts you to press a key to continue.

Syntax

The syntax of the pause command is:

```
pause prompt-string
```

where:

```
prompt-string        Is a character string written to stderr.
```

Usage

Execution continues only after you press a key. If you press ESC while commands are being read from a file, the file is closed before execution continues.
9.2.32 print

The print command examines the contents of the variables in the debugged program, or displays the result of arbitrary calculations involving variables and constants.

Syntax

The syntax of the print command is:

\[
\text{print}[/\text{format}] \ \text{expression}
\]

where:

\[/\text{format}\]
Selects a display format, as described in Table 9-1 on page 9-8. If no /format string is entered, integer values default to the format described by the variable $\text{int\_format}$. Floating-point values use the default format string %g. Pointer values are treated as integers, using a default fixed format %.8x, for example, 000100e4.

\[\text{expression}\]
Enters the expression for evaluation.

Usage

See also print on page 8-11 for more information on the print command.

9.2.33 profclear

The profclear command clears profiling counts.

Syntax

The syntax of the profclear command is:

\[\text{profclear}\]

Usage

For more information on the ARM profiler, see Appendix E Using the ARM Profiler.

9.2.34 proffoff

The proffoff command stops the collection of profiling data.

Syntax

The syntax of the proffoff command is:
prooff

Usage
For more information on the ARM profiler, see Appendix E Using the ARM Profiler.

9.2.35 profon

The profon command starts the collection of profiling data.

Syntax
The syntax of the profon command is:

```
profon {interval}
```

where:

```
interval  Is the time between PC-sampling in microseconds.
```

Usage
Lower values have a higher performance overhead, and slow down execution, but higher values are not as accurate.

This defaults to flat profiling unless a profile option was specified when the image was loaded. See also load on page 9-28.

For more information, see the RealView ARMulator ISS v1.4 User Guide.

9.2.36 profwrite

The profwrite command writes profiling information to a file.

Syntax
The syntax of the profwrite command is:

```
profwrite {filename}
```

where:

```
filename  Is the name of the file to contain the profiling data.
```
9.2.37 putfile

The putfile command writes the contents of an area of memory to a file. The data is written as a sequence of bytes.

Syntax

The syntax of the putfile command is:

```
putfile filename expression1, {+}expression2
```

where:

- `filename` Specifies the name of the file to write the data into.
- `expression1` Specifies the lower boundary of the area of memory to be written.
- `expression2` Specifies the upper boundary of the area of memory to be written.

Usage

The upper boundary of the memory area is defined as follows:

- If `expression2` is not preceded by a `+` character, the upper boundary of the memory area is the value of:
  
  \[ \text{expression2} - 1 \]

- If `expression2` is preceded by a `+` character, the upper boundary of the memory area is the value of:
  
  \[ \text{expression1} + \text{expression2} - 1 \]

Low-level symbols are accepted by default.

Example

```
putfile image.bin 0x0,+0x8000
```

9.2.38 quit

The quit command terminates the current armsd session.
**Syntax**

The syntax of the `quit` command is:

```
quit
```

**Usage**

This command also closes any open log or obey files.

### 9.2.39 readsyms

The `readsyms` command (like the `-symbols` command-line option) reads debug information from the specified image file but does not load the image.

**Syntax**

The syntax of the `readsyms` command is:

```
readsyms filename
```

**Usage**

This command gathers required debugging information from the specified executable image file but does not load the image into memory. The corresponding code must be made available in another way (for example, through a `getfile`, or by being in ROM).

### 9.2.40 registers

The `registers` command displays the contents of ARM registers 0 to 14, the program counter, and the program status registers.

**Syntax**

The syntax of the `registers` command is:

```
registers {mode}
```

where:

- `mode` Selects the registers to display. For a list of mode names, see *Predefined symbols* on page 8-14.

  This option can also take the value `all`, where the contents of all registers of the current mode are displayed, together with all banked registers for other modes with the same address width.
Usage

If used with no arguments, or if mode is the current mode, the contents of all registers of the current mode are displayed. If the mode argument is specified, but is not the current mode, the contents of the banked registers for that mode are displayed.

A sample display produced by registers might look like this:

**Example 9-1**

```
r0  = 0x00000000  r1  = 0x00000001  r2  = 0x00000002  r3  = 0x00000003
r4  = 0x00000004  r5  = 0x00000005  r6  = 0x00000006  r7  = 0x00000007
r8  = 0x00000008  r9  = 0x00000009  r10 = 0x0000000A  r11 = 0x0000000B
r12 = 0x0000000C  r13 = 0x0000000D  r14 = 0x0000000E
pc  = 0x00000000  cpsr = %nzcvqIFt_SVC  spsr = %nzcvqift_Reserved_00
```

9.2.41 reload

The reload command reloads the object file specified on the armsd command line, or with the last load command.

Syntax

The syntax of the reload command is:

```
reload[/profile-option] {arguments}
```

where

- **profile-option** Specifies which profiling option to use:
  - `/callgraph` Tells the debugger to provide the image being loaded with counts to enable the dynamic call-graph profile to be constructed.
  - `/profile` Directs the debugger to prepare the image being loaded for flat profiling.

- **arguments** Are the command-line arguments the program normally takes. If no arguments are specified, the arguments used in the most recent load or reload setting of $cmdline or command-line invocation are used again.
Usage

Breakpoints (but not watchpoints) remain set after a reload command.
9.2.42 step

The step command steps execution through one or more program statements.

Syntax

The syntax of the step command is:

```
step {in} {out} {count|while} expression
```

where:

- **in**: Continues single-stepping into procedure calls, so that each statement within a called procedure is single-stepped. If in is absent, each procedure call counts as a single statement and is executed without single stepping.
- **out**: Steps out of a function to the line of originating code that immediately follows that function.
- **count**: Specifies the number of statements to be stepped through. If you omit it only one statement is executed.
- **while**: Continues single-stepped execution until its expression evaluates as false (zero).
- **expression**: Is evaluated after every step.

Usage

To step by instructions rather than statements:

- use the istep command
- or enter language none.

If you want to step though assembly language code you must ensure that you use frame directives in your assembly language code to describe stack usage. See the RealView Compilation Tools v2.1 Assembler Guide for more information.

The use of the step command is not supported in Jazelle state. Submitting this command generates an error message.
9.2.43 symbols

The symbols command lists all symbols defined in the given or current context, with their type information.

Syntax

The syntax of the symbols command is:

```
symbols {context}
```

where:

- `context` Defines the program context:
  - to see global variables, define context as the filename with no path or extension
  - to see internal variables, use symbols $.

Usage

The information produced is listed in the form:

```
name type[, storage-class], location
```

- `storage-class` applies to source object only, not to debugger internal variables, and is one of auto, static, or external.

- `location` is one of the following:
  - `register r%d` (variable stored in register r%d)
  - `memory 0x%x` (variable stored at memory location 0x%x)
  - `constant` (variable is actually a constant)
  - `debugger variable`
  - `filtered`
  - `split location` (variable stored in several locations, possibly complex)
  - `moving, location` (variable moves, actual location shown)
  - `unknown` (location does not exist or an error occurred).
9.2.44 type

The type command types the contents of a source file, or any text file, between a specified pair of line numbers.

Syntax

The syntax of the type command is:

\[
\text{type } \{ \text{expression1} \} \{, \{+\text{expression2}\} \{, \text{filename} \} \}
\]

where:

- \text{expression1} Gives the start line. If \text{expression1} is omitted, it defaults to:
  - the source line associated with the current context minus 5, if the context has changed since the last type command was issued
  - the line following the last line displayed with the type command, if the context has not changed.

- \text{expression2} Gives the end line, in one of three ways:
  - if \text{expression2} is omitted, the end line is the start line +10
  - if \text{expression2} is preceded by +, the end line is given by the value of the start line + \text{expression2}
  - if there is no +, the end line is the value of \text{expression2}.

Usage

To look at a file other than that of the current context, specify the filename required and the locations within it.

To change the number of lines displayed from the default setting of 10, use the \$\text{type_lines} variable.
9.2.45  unbreak

The unbreak command removes a breakpoint.

Syntax

The syntax of the unbreak command is:

```
unbreak {location | #breakpoint_num}
```

where:

- `location` Is a source code location.
- `breakpoint_num` Is the number of the breakpoint

Usage

If there is only one breakpoint, delete it using unbreak without any arguments.

Note

A breakpoint always keeps its assigned number. Breakpoints are not renumbered when another breakpoint is deleted, unless the deleted breakpoint was the last one set.

9.2.46  unwatch

The unwatch command clears a watchpoint.

```
unwatch
```

Syntax

The syntax of the unwatch command is:

```
unwatch {variable | #watchpoint_number}
```

where:

- `variable` Is a variable name.
- `variable` Is the number of a watchpoint (preceded by #) set using the watch command.

Usage

If only one watchpoint has been set, delete it using unwatch without any arguments.
9.2.47 variable

The variable command provides type and context information on the specified variable (or structure field).

Syntax

The syntax of the variable command is:

```
variable variable
```

where:

```
variable    Specifies the variable to examine.
```

Usage

The variable command can also return the type of an expression.

Information about the specified variable is displayed as described in symbols on page 9-40.

9.2.48 watch

The watch command sets a watchpoint on a variable.

Syntax

The syntax of the watch command is:

```
watch {variable}
```

where:

```
variable    Names the variable to watch.
```

Usage

If you do not specify variable, a list of current watchpoints is displayed along with their numbers. When the variable is altered, program execution is suspended. As with break and unbreak, these numbers can subsequently be used to remove watchpoints.

Bitfields are not watchable.

If you are debugging through JTAG or EmbeddedICE logic, ensure that watchpoints on global or static variables use hardware watchpoints to avoid any performance penalty.
It is possible to set a watchpoint on a range of addresses. For example:

```c
watch (char[16])*0xF200
```

traps all data changes that take place in the 16 bytes of memory starting at 0xF200.

For this to work efficiently when you are debugging with, for example, Multi-ICE®, ensure that the size of the watchpoint in bytes is a power of 2, and that the address of the watchpoint is aligned on a size-byte boundary. Accesses to the area you specify are trapped only if they change any value stored there. A replacement of a value with the same value, for example, is not trapped.

--- Note ---

Adding software watchpoints can make programs execute very slowly, because the value of variables has to be checked every time they might have been altered. It is more practical to set a breakpoint in the area of suspicion and set watchpoints when execution has stopped.

---

### 9.2.49 where

The `where` command prints the current context and shows the procedure name, line number in the file, filename, and the line of code.

**Syntax**

The syntax of the `where` command is:

```
where {context}
```

where:

- `context` Specifies the program context to examine.

**Usage**

If a context is specified after the `where` command, the debugger displays the location of that context.
9.2.50 while

The `while` command is only useful at the end of a line containing one or more existing statements. Enter multi-statement lines by separating the statements with ; characters.

Syntax

The syntax of the `while` command is:

```
statement; {statement;} while expression
```

where:

```
statement; {statement;}
```

Represents one or more statements to be executed while the expression is true.

expression

Defines the expression to be evaluated.

Usage

After execution of the statements, `expression` is evaluated. If true, execution of the line is repeated. This continues until `expression` evaluates to false (zero).
9.3 Accessing the debug communications channel

The debugger accesses the debug communications channel using the commands described in this section.

For more information, see the RealView Compilation Tools v2.1 Developer Guide.

9.3.1 ccin

The ccin command selects a file containing data for reading into the target.

Syntax

The syntax of the ccin command is:

```
ccin filename
```

where:

`filename` Names the file containing the data for reading.

9.3.2 ccout

The ccout command selects a file where data from the target is written.

Syntax

The syntax of the ccout command is:

```
ccout filename
```

where:

`filename` Names the file where the data is written.
9.4 **armsd commands for EmbeddedICE**

The armsd commands described in this section are included for compatibility with EmbeddedICE. These are deprecated, and might be removed from future tool kits.

9.4.1 **listconfig**

The `listconfig` command lists the configurations known to the debug agent.

**Syntax**

The syntax of the `listconfig` command is:

```
listconfig file
```

where:

`file` Specifies the file where the list of configurations is written.

9.4.2 **loadagent**

The `loadagent` command downloads a replacement EmbeddedICE ROM image, and starts it (in RAM).

**Syntax**

The syntax of the `loadagent` command is:

```
loadagent file
```

where:

`file` Names the EmbeddedICE ROM image file to load.

9.4.3 **loadconfig**

The `loadconfig` command loads an EmbeddedICE configuration data file. Such files contain data required by EmbeddedICE related to various versions of various processors. See also `selectconfig` on page 9-48.

**Syntax**

The syntax of the `loadconfig` command is:

```
loadconfig file
```
where:

file Names the EmbeddedICE configuration data file to load.

9.4.4 selectconfig

An EmbeddedICE configuration data file contains data blocks, each identified by a processor name and version. The selectconfig command selects the required block of EmbeddedICE configuration data from those available in the specified configuration file (see loadconfig on page 9-47).

Syntax

The syntax of the selectconfig command is:

selectconfig name version

where:

name Is the name of the processor for which configuration data is required.

version Indicates the version to be used:

any Accepts any version number. This is the default.

n Uses version n.

n+ Uses version n or later.
Appendix A
AXD and armsd Commands

This appendix compares the commands supported by the command-line interface of the ARM eXtended Debugger (AXD) with those supported by the ARM Symbolic Debugger (armsd). It also lists variables with values that you might want to examine or change, showing the AXD commands that enable you to do so. This appendix contains the following sections:

- Comparison of commands on page A-2
- Useful internal variables on page A-8.
A.1 Comparison of commands

The ARM debugger armsd is driven by commands only. The ARM debugger AXD is generally driven through its graphical user interface, but it also offers a command-line interface window.

See:
- Chapter 6 AXD Command-line Interface for a full description of the commands available in the AXD debugger
- Chapter 9 Working with armsd for a full description of the commands available in armsd.

Some commands operate in exactly the same way in both debuggers. Others have close equivalents. Some commands are available in one debugger and not the other. Table A-1 contains all the commands available in both debuggers, arranged alphabetically, and shows equivalences where they exist.

<table>
<thead>
<tr>
<th>armsd commands</th>
<th>AXD commands</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>!command</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>comment</td>
<td>comment string</td>
</tr>
<tr>
<td>alias [name[expansion]]</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>arguments [context]</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>backtrace [count]</td>
<td>backtrace[count]</td>
<td></td>
</tr>
<tr>
<td>break[/size][ loc[ count] [ do {command; command}] [ if expr]]</td>
<td>break[ expr</td>
<td>position [nth_time]]</td>
</tr>
<tr>
<td>call[/size] loc[ expr-list]</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>cclasses class</td>
<td>ccl</td>
</tr>
<tr>
<td>-</td>
<td>cfunctions class</td>
<td>cfu</td>
</tr>
<tr>
<td>-</td>
<td>classes[ image]</td>
<td>cl</td>
</tr>
<tr>
<td>-</td>
<td>clear</td>
<td>clr</td>
</tr>
<tr>
<td>axsmd commands</td>
<td>AXD commands</td>
<td>Short form</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>-</td>
<td>clearbreak breakpoint</td>
<td>al</td>
</tr>
<tr>
<td></td>
<td>clearbreak has the alias unbreak</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>clearstat referencepoint</td>
<td>cstat</td>
</tr>
<tr>
<td>-</td>
<td>clearwatch breakpoint</td>
<td>al</td>
</tr>
<tr>
<td></td>
<td>clearwatch has the alias unwatch</td>
<td></td>
</tr>
<tr>
<td>coproc cpnum[ rno[=rno2] size access values [ displaydesc]*]</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>context context</td>
<td>context[ context]</td>
<td>con</td>
</tr>
<tr>
<td>-</td>
<td>convariables[ context] [ scope][ format]</td>
<td>convar</td>
</tr>
<tr>
<td>cregdef cpnum rno displaydesc</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>cvariables class</td>
<td>cva</td>
</tr>
<tr>
<td>cwrite cpnum rno val [ val ...]*</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>dbginternals</td>
<td>di</td>
</tr>
<tr>
<td>-</td>
<td>disassemble expr1 [+expr2[ asm]] disassemble has the alias list</td>
<td>dis</td>
</tr>
<tr>
<td>let $echo 0</td>
<td>1</td>
<td>echo toggle</td>
</tr>
<tr>
<td>examine[ expr1 ] [, [+expr2]</td>
<td>examine expr1, [+expr2 [ memory[ format]]</td>
<td>mem</td>
</tr>
<tr>
<td></td>
<td>examine is an alias of memory</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>files[ image]</td>
<td>fi</td>
</tr>
<tr>
<td>-</td>
<td>fillmem expr1 [+expr2 value[ memory]] fnmem</td>
<td></td>
</tr>
<tr>
<td>find expr1, expr2, expr3</td>
<td>findvalue valexpr[ [expr1] [ expr2]]</td>
<td>fdv</td>
</tr>
<tr>
<td>find string, expr2, expr3</td>
<td>findstring string[ [expr1] [ expr2]]</td>
<td>fds</td>
</tr>
<tr>
<td>ARMSD COMMAND</td>
<td>AXD COMMAND</td>
<td>SHORT FORM</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>format[fmt_name[ctrl_string]]</td>
<td>fmt</td>
<td></td>
</tr>
<tr>
<td>functions[image]</td>
<td>fu</td>
<td></td>
</tr>
<tr>
<td>getfile file addrexpr</td>
<td>lb</td>
<td></td>
</tr>
<tr>
<td>go[processor]</td>
<td>r</td>
<td></td>
</tr>
<tr>
<td>help[command]</td>
<td>hlp</td>
<td></td>
</tr>
<tr>
<td>images</td>
<td>im</td>
<td></td>
</tr>
<tr>
<td>improps[im]</td>
<td>ip</td>
<td></td>
</tr>
<tr>
<td>importformat sdm_file[fail_action]</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>stackin</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>istep[in][count</td>
<td>while]expr</td>
<td>istep</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>list[size][expr1][,][+][expr2]</td>
<td>dis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>lsfmt</td>
</tr>
<tr>
<td>load[profile-opt]image-file[arg]</td>
<td>ld</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>lb</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>lss</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>lds</td>
</tr>
</tbody>
</table>

Table A-1 ARMSD and AXD commands (continued)
### Table A-1 armsd and AXD commands (continued)

<table>
<thead>
<tr>
<th>armsd commands</th>
<th>AXD commands</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>localvar vartype varname</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>log filename</code></td>
<td><code>log[ file]</code></td>
<td>-</td>
</tr>
<tr>
<td><code>lsym pattern</code></td>
<td><code>lowlevel[ image]</code></td>
<td><code>lsym</code></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>memory expr1 [+]*expr2</code></td>
<td><code>mem</code></td>
</tr>
<tr>
<td></td>
<td><code>[ memory[ format]]</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>memory has the alias examine</code></td>
<td></td>
</tr>
<tr>
<td><code>obey command-file</code></td>
<td><code>obey file</code></td>
<td>-</td>
</tr>
<tr>
<td><code>out</code></td>
<td><code>stackout</code></td>
<td><code>out</code></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>parse toggle</code></td>
<td><code>par</code></td>
</tr>
<tr>
<td><code>pause prompt-string</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>print[/format] expression</code></td>
<td><code>print expr[/format]</code></td>
<td><code>wat</code></td>
</tr>
<tr>
<td></td>
<td><code>print is an alias of watch</code></td>
<td></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>processors</code></td>
<td><code>proc</code></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>procproperties[ image]</code></td>
<td><code>pp</code></td>
</tr>
<tr>
<td><code>profclear</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>profoff</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>profon[ interval]</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>profwrite[ filename]</code></td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td><code>putfile filename expr1, [+]*expr2</code></td>
<td><code>putfile file expr1 [+]*expr2</code></td>
<td><code>sb</code></td>
</tr>
<tr>
<td></td>
<td><code>putfile is an alias of savebinary</code></td>
<td></td>
</tr>
<tr>
<td><code>quit</code></td>
<td><code>quitdebugger</code></td>
<td><code>quitd</code></td>
</tr>
<tr>
<td><code>readsyms filename</code></td>
<td><code>readsyms file[ processor]</code></td>
<td><code>lds</code></td>
</tr>
<tr>
<td></td>
<td><code>readsyms is an alias of loadsymbols</code></td>
<td></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>record[ file]</code></td>
<td><code>rec</code></td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>regbanks[ processor]</code></td>
<td><code>regbk</code></td>
</tr>
</tbody>
</table>
### Table A-1 armisd and AXD commands (continued)

<table>
<thead>
<tr>
<th>armisd commands</th>
<th>AXD commands</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>registers[ regbank[ format]]</td>
<td></td>
<td>reg</td>
</tr>
<tr>
<td>reload[profile-option] [ arguments]</td>
<td>reload[ image]</td>
<td>rld</td>
</tr>
<tr>
<td>run[ processor]</td>
<td></td>
<td>r</td>
</tr>
<tr>
<td>run has the alias go</td>
<td></td>
<td></td>
</tr>
<tr>
<td>runtopos position[ processor]</td>
<td></td>
<td>rto</td>
</tr>
<tr>
<td>savebinary file expr1 [+exp]r2</td>
<td>savebinary has the alias putfile</td>
<td>sb</td>
</tr>
<tr>
<td>savesesession sesfile</td>
<td></td>
<td>ss</td>
</tr>
<tr>
<td>setaci string</td>
<td></td>
<td>aci</td>
</tr>
<tr>
<td>setbreakprops breakpoint propid value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>setimmpop image ipvar value</td>
<td></td>
<td>sip</td>
</tr>
<tr>
<td>setmem addrexpr valexpr</td>
<td>setmem has the alias mem</td>
<td>smem</td>
</tr>
<tr>
<td>pc=xx setpc expr</td>
<td></td>
<td>pc</td>
</tr>
<tr>
<td>setproc processor</td>
<td></td>
<td>sproc</td>
</tr>
<tr>
<td>setproccprop ppvar value</td>
<td></td>
<td>spp</td>
</tr>
<tr>
<td>setreg [regbank]register expr</td>
<td></td>
<td>sreg</td>
</tr>
<tr>
<td>setsourcedir directory_list</td>
<td></td>
<td>ssd</td>
</tr>
<tr>
<td>setwatch expr1, expr2 setwatch has the alias let</td>
<td></td>
<td>swat</td>
</tr>
<tr>
<td>setwatchprops watchpoint propid value</td>
<td></td>
<td>swp</td>
</tr>
<tr>
<td>source value1 [+value2 [ file]</td>
<td>source has the alias type</td>
<td>src</td>
</tr>
<tr>
<td>sourcedir[ path[ index]]</td>
<td></td>
<td>sdir</td>
</tr>
</tbody>
</table>
Table A-1 armsd and AXD commands (continued)

<table>
<thead>
<tr>
<th>armsd commands</th>
<th>AXD commands</th>
<th>Short form</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>backtrace [count]</code></td>
<td><code>stackentries[ count]</code></td>
<td>stk</td>
</tr>
<tr>
<td></td>
<td>stackentries has the alias backtrace</td>
<td></td>
</tr>
<tr>
<td><code>in</code></td>
<td><code>stackin</code></td>
<td>in</td>
</tr>
<tr>
<td><code>out</code></td>
<td><code>stackout</code></td>
<td>out</td>
</tr>
<tr>
<td><code>p $statistics</code></td>
<td><code>statistics[ ref_pt_name]</code></td>
<td>stat</td>
</tr>
<tr>
<td>`step [in</td>
<td>out] [count</td>
<td>while] expr`</td>
</tr>
<tr>
<td><code>-</code></td>
<td><code>stepsize[ instr]</code></td>
<td>ssize</td>
</tr>
<tr>
<td></td>
<td><code>stop[ processor]</code></td>
<td></td>
</tr>
<tr>
<td><code>symbols[ context]</code></td>
<td><code>-</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>`trace on</td>
<td>off`</td>
</tr>
<tr>
<td></td>
<td><code>traceload tcfile</code></td>
<td>trload</td>
</tr>
<tr>
<td><code>type[ expr1][, [+]expr2] [, fname]</code></td>
<td><code>type value1 [+]value2[ file]</code></td>
<td>src</td>
</tr>
<tr>
<td></td>
<td>type is an alias of source</td>
<td></td>
</tr>
<tr>
<td>`unbreak [ location</td>
<td>#breakpoint_num]`</td>
<td><code>unbreak breakpoint</code></td>
</tr>
<tr>
<td></td>
<td>unbreak is an alias of clearbreak</td>
<td></td>
</tr>
<tr>
<td>`unwatch [ variable</td>
<td>#watchpoint_num]`</td>
<td><code>unwatch watchpoint</code></td>
</tr>
<tr>
<td></td>
<td>unwatch is an alias of clearwatch</td>
<td></td>
</tr>
<tr>
<td><code>variable variable</code></td>
<td><code>variables[ image]</code></td>
<td>va</td>
</tr>
<tr>
<td><code>print expr</code></td>
<td><code>watch expr[ format]</code></td>
<td>wat</td>
</tr>
<tr>
<td></td>
<td>watch has the alias print</td>
<td></td>
</tr>
<tr>
<td><code>watch[ variable]</code></td>
<td><code>watchpt[ expr[ nth_time]]</code></td>
<td>wpt</td>
</tr>
<tr>
<td><code>where[ context]</code></td>
<td><code>where[ context]</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>statement;[ statement;] while expr</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-</code></td>
<td></td>
</tr>
</tbody>
</table>
### A.2 Useful internal variables

Table A-2 lists some variables with values that you might want to examine or change.

In armsd you examine these as debugger internal variables and can change their values with a `let` command. In AXD more CLI commands are available. These are described in full in Chapter 6 *AXD Command-line Interface*.

<table>
<thead>
<tr>
<th>armsd variable</th>
<th>AXD command</th>
</tr>
</thead>
<tbody>
<tr>
<td>$vector_catch</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$cmdline</td>
<td>setimgprop image cmdline params</td>
</tr>
<tr>
<td>$rdi_log</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$target_fpu</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$semihosting_enabled</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$semihosting_vector</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$semihosting_arm_swi</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$semihosting_thumb_swi</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$arm_swi</td>
<td>setprocprop arm_semihosting_swi value</td>
</tr>
<tr>
<td>$thumb_swi</td>
<td>setprocprop thumb_semihosting_swi value</td>
</tr>
<tr>
<td>$semihosting_dcchandler_address</td>
<td>pp to examine, spp to change</td>
</tr>
<tr>
<td>$icebreaker_lockedpoints</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$safe_non_vector_address</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$top_of_memory</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$system_reset</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$cp_access_code_address</td>
<td>pr to examine, let to change. Multi-ICE® only.</td>
</tr>
<tr>
<td>$user_input_bit1</td>
<td>Hardware input to Multi-ICE® only. Not writable.</td>
</tr>
<tr>
<td>$user_input_bit2</td>
<td>Hardware input to Multi-ICE® only. Not writable.</td>
</tr>
<tr>
<td>$user_output_bit1</td>
<td>pr to examine, let to change</td>
</tr>
<tr>
<td>$user_output_bit2</td>
<td>pr to examine, let to change</td>
</tr>
</tbody>
</table>
### Table A-2 Internal variables (continued)

<table>
<thead>
<tr>
<th>armsd variable</th>
<th>AXD command</th>
</tr>
</thead>
<tbody>
<tr>
<td>$arm9_restart_code_address</td>
<td>pr to examine, let to change. Multi-ICE 1.3 and 1.4</td>
</tr>
<tr>
<td>$cache_clean_code_address</td>
<td>pr to examine, let to change. Multi-ICE 2.0.</td>
</tr>
<tr>
<td>$sw_breakpoints_preferred</td>
<td>pr to examine, let to change. Multi-ICE only.</td>
</tr>
<tr>
<td>$sourcedir</td>
<td>sdir to examine, ssd to change</td>
</tr>
<tr>
<td>$echo</td>
<td>echo on</td>
</tr>
</tbody>
</table>
Appendix B
Coprocessor Registers

This appendix describes coprocessor registers for various ARM processors. It contains the following sections:

- *ARM710T processor* on page B-2
- *ARM720T processor* on page B-3
- *ARM740T processor* on page B-4
- *ARM920T Rev 0 processor* on page B-5
- *ARM920T Rev 1 processor* on page B-7
- *ARM940T Rev 0 processor* on page B-9
- *ARM940T Rev 1 processor* on page B-11
- *ARM946E-S processor* on page B-13
- *ARM966E-S processor* on page B-15
- *ARM10200E processor* on page B-16
- *ARM1020E processor* on page B-20
- *ARM10E processor* on page B-22
- *XScale processor* on page B-24.
## B.1 ARM710T processor

Table B-1 describes the coprocessor registers of the ARM710T processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate cache</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate</td>
<td>Invalidate TLB</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_Address (by address)</td>
<td>Invalidate TLB single entry</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
## B.2 ARM720T processor

Table B-2 describes the coprocessor registers of the ARM720T processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate cache</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate</td>
<td>Invalidate TLB</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_Address</td>
<td>Invalidate TLB single entry</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
## B.3 ARM740T processor

Table B-3 describes the coprocessor registers of the ARM740T processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cacheable</td>
<td>Cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Bufferable</td>
<td>Bufferable</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection</td>
<td>Protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region0</td>
<td>Memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region1</td>
<td>Memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region2</td>
<td>Memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region3</td>
<td>Memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region4</td>
<td>Memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region5</td>
<td>Memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region6</td>
<td>Memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region7</td>
<td>Memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate cache</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
## B.4 ARM920T Rev 0 processor

Table B-4 describes the coprocessor registers of the ARM920T Rev 0 processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DLOCK</td>
<td>Data cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ILOCK</td>
<td>Instruction cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLBDLOCK</td>
<td>Data TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLBLIOCK</td>
<td>Instruction TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate both caches</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td></td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td></td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanValidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
### Table B-4 ARM920T Rev 0 (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_I+D TLB</td>
<td>Invalidate I+D TLB</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_I</td>
<td>Invalidate I TLB</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_I_Address</td>
<td>Invalidate I TLB entry (by address)</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_D</td>
<td>Invalidate D TLB</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_D_Address</td>
<td>Invalidate D TLB entry (by address)</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
B.5 ARM920T Rev 1 processor

Table B-5 describes the coprocessor registers of the ARM920T Rev 1 processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: PFSR</td>
<td>Prefetch fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: FAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DLOCK</td>
<td>Data cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ILOCK</td>
<td>Instruction cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLBDLOCK</td>
<td>Data TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLBIFLACK</td>
<td>Instruction TLB lock</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate both caches</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate I Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate D Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean D Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanAndInvalidate D Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
Table B-5 ARM920T Rev 1 (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate</td>
<td>Invalidate I+D TLB</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_I</td>
<td>Invalidate I TLB</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_I_Address</td>
<td>Invalidate I TLB entry (by address)</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_D</td>
<td>Invalidate D TLB</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLB operations: Invalidate_D_Address</td>
<td>Invalidate D TLB entry (by address)</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
## B.6 ARM940T Rev 0 processor

Table B-6 describes the coprocessor registers of the ARM940T Rev 0 processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DCacheable</td>
<td>Data cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ICacheable</td>
<td>Instruction cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Bufferable</td>
<td>Bufferable</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DProtection</td>
<td>Data protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: IProtection</td>
<td>Instruction protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion0</td>
<td>Data memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion1</td>
<td>Data memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion2</td>
<td>Data memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion3</td>
<td>Data memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion4</td>
<td>Data memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion5</td>
<td>Data memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion6</td>
<td>Data memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion7</td>
<td>Data memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion0</td>
<td>Instruction memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion1</td>
<td>Instruction memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion2</td>
<td>Instruction memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion3</td>
<td>Instruction memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion4</td>
<td>Instruction memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
# Table B-6 ARM940T Rev 0 (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Instruction Regions: IRegion5</td>
<td>Instruction memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion6</td>
<td>Instruction memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion7</td>
<td>Instruction memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 8, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache lockdown: D_Lockdown</td>
<td>Data lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache lockdown: I_Lockdown</td>
<td>Instruction lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
B.7 ARM940T Rev 1 processor

Table B-7 describes the coprocessor registers of the ARM940T Rev 1 processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DCacheable</td>
<td>Data cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ICacheable</td>
<td>Instruction cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Bufferable</td>
<td>Bufferable</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DProtection</td>
<td>Data protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: IProtection</td>
<td>Instruction protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion0</td>
<td>Data memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion1</td>
<td>Data memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion2</td>
<td>Data memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion3</td>
<td>Data memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion4</td>
<td>Data memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion5</td>
<td>Data memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion6</td>
<td>Data memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Data Regions: DRegion7</td>
<td>Data memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion0</td>
<td>Instruction memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion1</td>
<td>Instruction memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion2</td>
<td>Instruction memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion3</td>
<td>Instruction memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
### Table B-7 ARM940T Rev 1 (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Instruction Regions: IRegion4</td>
<td>Instruction memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion5</td>
<td>Instruction memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion6</td>
<td>Instruction memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Instruction Regions: IRegion7</td>
<td>Instruction memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 8, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache lockdown: D_Lockdown</td>
<td>Data lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache lockdown: I_Lockdown</td>
<td>Instruction lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
# ARM946E-S processor

Table B-8 describes the coprocessor registers of the ARM946E-S processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TCMS</td>
<td>Tightly coupled memory size</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DCacheable</td>
<td>Data cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ICacheable</td>
<td>Instruction cacheable</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Bufferable</td>
<td>Bufferable</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DProtection</td>
<td>Data protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: IProtection</td>
<td>Instruction protection</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 3</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region0</td>
<td>Memory area 0 definition</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region1</td>
<td>Memory area 1 definition</td>
<td>CP = 15: CRn = 6, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region2</td>
<td>Memory area 2 definition</td>
<td>CP = 15: CRn = 6, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region3</td>
<td>Memory area 3 definition</td>
<td>CP = 15: CRn = 6, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region4</td>
<td>Memory area 4 definition</td>
<td>CP = 15: CRn = 6, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region5</td>
<td>Memory area 5 definition</td>
<td>CP = 15: CRn = 6, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region6</td>
<td>Memory area 6 definition</td>
<td>CP = 15: CRn = 6, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Protection Regions: Region7</td>
<td>Memory area 7 definition</td>
<td>CP = 15: CRn = 6, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
### Table B-8 ARM946E-S (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache lockdown: D_Lockdown</td>
<td>Data lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache lockdown: I_Lockdown</td>
<td>Instruction lockdown control</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Tightly coupled regions: DTCMR</td>
<td>Data tightly coupled memory region</td>
<td>CP = 15: CRn = 9, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Tightly coupled regions: ITCMR</td>
<td>Instruction tightly coupled memory region</td>
<td>CP = 15: CRn = 9, CRm = 1, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
B.9 ARM966E-S processor

Table B-9 describes the coprocessor registers of the ARM966E-S processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
</tbody>
</table>
B.10  ARM10200E processor

Table B-10 describes the coprocessor registers of the ARM10200E processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: IFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: DLOCK</td>
<td>Data cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ILOCK</td>
<td>Instruction cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLBDLOCK</td>
<td>Data TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TBLILOCK</td>
<td>Instruction TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate both caches</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Register</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S0</td>
<td></td>
<td>CP = 11: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S1</td>
<td></td>
<td>CP = 11: CRn = 0, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S2</td>
<td></td>
<td>CP = 11: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S3</td>
<td></td>
<td>CP = 11: CRn = 1, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S4</td>
<td></td>
<td>CP = 11: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S5</td>
<td></td>
<td>CP = 11: CRn = 2, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S6</td>
<td></td>
<td>CP = 11: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S7</td>
<td></td>
<td>CP = 11: CRn = 3, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S8</td>
<td></td>
<td>CP = 11: CRn = 4, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S9</td>
<td></td>
<td>CP = 11: CRn = 4, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S10</td>
<td></td>
<td>CP = 11: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S11</td>
<td></td>
<td>CP = 11: CRn = 5, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S12</td>
<td></td>
<td>CP = 11: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S13</td>
<td></td>
<td>CP = 11: CRn = 6, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S14</td>
<td></td>
<td>CP = 11: CRn = 7, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S15</td>
<td></td>
<td>CP = 11: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S16</td>
<td></td>
<td>CP = 11: CRn = 8, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S17</td>
<td></td>
<td>CP = 11: CRn = 8, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
</tbody>
</table>
### Table B-10 ARM10200E (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>VFP: VFP (Single): S18</td>
<td></td>
<td>CP = 11: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S19</td>
<td></td>
<td>CP = 11: CRn = 9, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S20</td>
<td></td>
<td>CP = 11: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S21</td>
<td></td>
<td>CP = 11: CRn = 10, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S22</td>
<td></td>
<td>CP = 11: CRn = 11, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S23</td>
<td></td>
<td>CP = 11: CRn = 11, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S24</td>
<td></td>
<td>CP = 11: CRn = 12, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S25</td>
<td></td>
<td>CP = 11: CRn = 12, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S26</td>
<td></td>
<td>CP = 11: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S27</td>
<td></td>
<td>CP = 11: CRn = 13, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S28</td>
<td></td>
<td>CP = 11: CRn = 14, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S29</td>
<td></td>
<td>CP = 11: CRn = 14, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Single): S30</td>
<td></td>
<td>CP = 11: CRn = 15, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Single): S31</td>
<td></td>
<td>CP = 11: CRn = 15, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>VFP: VFP (Double): D0</td>
<td></td>
<td>CP = 11: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D1</td>
<td></td>
<td>CP = 11: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D2</td>
<td></td>
<td>CP = 11: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D3</td>
<td></td>
<td>CP = 11: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D4</td>
<td></td>
<td>CP = 11: CRn = 4, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D5</td>
<td></td>
<td>CP = 11: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D6</td>
<td></td>
<td>CP = 11: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D7</td>
<td></td>
<td>CP = 11: CRn = 7, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D8</td>
<td></td>
<td>CP = 11: CRn = 8, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D9</td>
<td></td>
<td>CP = 11: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D10</td>
<td></td>
<td>CP = 11: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Register</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VFP: VFP (Double): D11</td>
<td></td>
<td>CP = 11: CRn = 11, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D12</td>
<td></td>
<td>CP = 11: CRn = 12, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D13</td>
<td></td>
<td>CP = 11: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D14</td>
<td></td>
<td>CP = 11: CRn = 14, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>VFP: VFP (Double): D15</td>
<td></td>
<td>CP = 11: CRn = 15, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
</tbody>
</table>
### Table B-11 ARM1020E

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: IFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: DLOCK</td>
<td>Data cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ILOCK</td>
<td>Instruction cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLBDLOCK</td>
<td>Data TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLBILOCK</td>
<td>Instruction TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate both caches</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
### Table B-11 ARM1020E (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
</tbody>
</table>
Table B-12 describes the coprocessor registers of the ARM10E processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DACR</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: DFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: IFAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: DLOCK</td>
<td>Data cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: ILOCK</td>
<td>Instruction cache lockdown</td>
<td>CP = 15: CRn = 9, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: TLBDLOCK</td>
<td>Data TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: TLBILOCK</td>
<td>Instruction TLB lockdown</td>
<td>CP = 15: CRn = 10, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate</td>
<td>Invalidate both caches</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I</td>
<td>Invalidate entire I cache</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Prefetch_I</td>
<td>Prefetch I cache line</td>
<td>CP = 15: CRn = 7, CRm = 13, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D</td>
<td>Invalidate entire D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>CP15: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Address</td>
<td>Clean D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
## Table B-12 ARM10E (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Address</td>
<td>Clean and invalidate D cache single entry (by address)</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>CP15: Cache operations: Clean_D_Index</td>
<td>Clean D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: CleanInvalidate_D_Index</td>
<td>Clean and invalidate D cache single index</td>
<td>CP = 15: CRn = 7, CRm = 14, op_1 = 0, op_2 = 2</td>
</tr>
<tr>
<td>CP15: Cache operations: Drain</td>
<td>Drain write buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>CP15: Cache operations: Wait</td>
<td>Wait for interrupt</td>
<td>CP = 15: CRn = 7, CRm = 0, op_1 = 0, op_2 = 4</td>
</tr>
</tbody>
</table>
B.13  XScale processor

Table B-13 describes the coprocessor registers of the XScale processor.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumulators: ACC0</td>
<td>Accumulator 0</td>
<td>CP = 15: CRn = 15, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Interrupt Controller: INTCTL</td>
<td>Interrupt control register</td>
<td>CP = 15: CRn = 15, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Interrupt Controller: INTSRC</td>
<td>Interrupt source register</td>
<td>CP = 15: CRn = 15, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Interrupt Controller: INTSTR</td>
<td>Interrupt steer register</td>
<td>CP = 15: CRn = 15, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Performance Monitors: PMNC</td>
<td>Performance monitor control register</td>
<td>CP = 14: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Performance Monitors: CCNT</td>
<td>Clock count register</td>
<td>CP = 14: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Performance Monitors: PMN0</td>
<td>Performance count register 0</td>
<td>CP = 14: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Performance Monitors: PMN1</td>
<td>Performance count register 1</td>
<td>CP = 14: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: IBCR0</td>
<td>Instruction breakpoint and control register 0</td>
<td>CP = 15: CRn = 14, CRm = 8, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: IBCR1</td>
<td>Instruction breakpoint and control register 1</td>
<td>CP = 15: CRn = 14, CRm = 9, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: DBR0</td>
<td>Data breakpoint register 0</td>
<td>CP = 15: CRn = 14, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: DBR1</td>
<td>Data breakpoint register 1</td>
<td>CP = 15: CRn = 14, CRm = 3, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: DBCON</td>
<td>Data breakpoint controls register</td>
<td>CP = 15: CRn = 14, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: TX</td>
<td>Transmit register</td>
<td>CP = 14: CRn = 8, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: RX</td>
<td>Receive register</td>
<td>CP = 14: CRn = 9, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: DCSR</td>
<td>Debug control and status register</td>
<td>CP = 14: CRn = 10, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: CHKPT0</td>
<td>Checkpoint register 0</td>
<td>CP = 14: CRn = 12, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: CHKPT1</td>
<td>Checkpoint register 1</td>
<td>CP = 14: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Software Debug: TXRXCTRL</td>
<td>TX RX control register</td>
<td>CP = 14: CRn = 14, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Clock and Power: CCLKCFG</td>
<td>Core clock configuration register</td>
<td>CP = 14: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Clock and Power: PWRMODE</td>
<td>Power mode register</td>
<td>CP = 14: CRn = 7, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Register</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>System Control: ID</td>
<td>Chip ID</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache type</td>
<td>Cache type</td>
<td>CP = 15: CRn = 0, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Control</td>
<td>Control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Aux Control</td>
<td>Auxiliary control</td>
<td>CP = 15: CRn = 1, CRm = 0, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: TTBR</td>
<td>Translation table base register</td>
<td>CP = 15: CRn = 2, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: DAC</td>
<td>Domain access control register</td>
<td>CP = 15: CRn = 3, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: FSR</td>
<td>Fault status register</td>
<td>CP = 15: CRn = 5, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: FAR</td>
<td>Fault address register</td>
<td>CP = 15: CRn = 6, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: PID</td>
<td>Process ID register</td>
<td>CP = 15: CRn = 13, CRm = 0, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: CP_Access</td>
<td>Coprocessor access register</td>
<td>CP = 15: CRn = 15, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate</td>
<td>Invalidate I+D cache and BTB</td>
<td>CP = 15: CRn = 7, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate_I</td>
<td>Invalidate I cache and BTB</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate_I_Address</td>
<td>Invalidate I cache line (by address)</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate_D</td>
<td>Invalidate D cache</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate_D_Address</td>
<td>Invalidate D cache line</td>
<td>CP = 15: CRn = 7, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Cache operations: Clean_D</td>
<td>Clean D cache line</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Cache operations: Drain</td>
<td>Drain write (and fill) buffer</td>
<td>CP = 15: CRn = 7, CRm = 10, op_1 = 0, op_2 = 4</td>
</tr>
<tr>
<td>System Control: Cache operations: Invalidate_BTB</td>
<td>Invalidate branch target buffer</td>
<td>CP = 15: CRn = 7, CRm = 5, op_1 = 0, op_2 = 6</td>
</tr>
<tr>
<td>System Control: Cache operations: Allocate_D_Address</td>
<td>Allocate line in the D cache</td>
<td>CP = 15: CRn = 7, CRm = 2, op_1 = 0, op_2 = 5</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Register</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System Control: TLB operations: Invalidate</td>
<td>Invalidate I+D TLB</td>
<td>CP = 15: CRn = 8, CRm = 7, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: TLB operations: Invalidate_I</td>
<td>Invalidate I TLB</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: TLB operations: Invalidate_I_Address</td>
<td>Invalidate I TLB entry</td>
<td>CP = 15: CRn = 8, CRm = 5, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: TLB operations: Invalidate_D</td>
<td>Invalidate D TLB</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: TLB operations: Invalidate_D_Address</td>
<td>Invalidate D TLB entry</td>
<td>CP = 15: CRn = 8, CRm = 6, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Cache lockdown: FetchLock_I</td>
<td>Fetch and lock I cache line</td>
<td>CP = 15: CRn = 9, CRm = 1, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache lockdown: Unlock_I</td>
<td>Unlock I cache</td>
<td>CP = 15: CRn = 9, CRm = 1, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: Cache lockdown: Lock_D</td>
<td>D cache lock register</td>
<td>CP = 15: CRn = 9, CRm = 2, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: Cache lockdown: Unlock_D</td>
<td>Unlock data cache</td>
<td>CP = 15: CRn = 9, CRm = 2, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: TLB lockdown: TranslateLock_I_Address</td>
<td>Translate and lock I TLB entry</td>
<td>CP = 15: CRn = 10, CRm = 4, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: TLB lockdown: Unlock_I</td>
<td>Unlock I TLB</td>
<td>CP = 15: CRn = 10, CRm = 4, op_1 = 0, op_2 = 1</td>
</tr>
<tr>
<td>System Control: TLB lockdown: TranslateLock_D_Address</td>
<td>Translate and lock D TLB entry</td>
<td>CP = 15: CRn = 10, CRm = 8, op_1 = 0, op_2 = 0</td>
</tr>
<tr>
<td>System Control: TLB lockdown: Unlock_D</td>
<td>Unlock D TLB</td>
<td>CP = 15: CRn = 10, CRm = 8, op_1 = 0, op_2 = 1</td>
</tr>
</tbody>
</table>
Appendix C
Supplementary Display Module Formats

This appendix describes the structure and content of *Supplementary Display Module* (SDM) files that contain display format definitions. You can read SDM files in AXD with the `importformat` command. The file `armperip.xml`, can also contain these display format definitions. This appendix contains the following sections:

- *Predefined formats* on page C-2
- *User-defined formats* on page C-5.
C.1 Predefined formats

Some CLI commands in the ARM eXtended Debugger (AXD) take a display format name as an argument. Table C-1 to Table C-6 on page C-4 list the predefined display format names that are always valid in AXD.

### Table C-1 8-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>hex_8</td>
</tr>
<tr>
<td>Decimal</td>
<td>dec_8</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>udec_8</td>
</tr>
<tr>
<td>Octal</td>
<td>oct_8</td>
</tr>
<tr>
<td>Binary</td>
<td>bin_8</td>
</tr>
<tr>
<td>ASCII</td>
<td>ascii_8</td>
</tr>
<tr>
<td>Hex, no prefix</td>
<td>hex_noprefix_8</td>
</tr>
<tr>
<td>Octal, no prefix</td>
<td>oct_noprefix_8</td>
</tr>
</tbody>
</table>

### Table C-2 16-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>hex_16</td>
</tr>
<tr>
<td>Decimal</td>
<td>dec_16</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>udec_16</td>
</tr>
<tr>
<td>Octal</td>
<td>oct_16</td>
</tr>
<tr>
<td>Binary</td>
<td>bin_16</td>
</tr>
<tr>
<td>ASCII</td>
<td>ascii_16</td>
</tr>
<tr>
<td>Hex, no prefix</td>
<td>hex_noprefix_16</td>
</tr>
<tr>
<td>Octal, no prefix</td>
<td>oct_noprefix_16</td>
</tr>
</tbody>
</table>
### Table C-3 32-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>hex_32</td>
</tr>
<tr>
<td>Decimal</td>
<td>dec_32</td>
</tr>
<tr>
<td>Single</td>
<td>fp_32</td>
</tr>
<tr>
<td>Scientific single</td>
<td>fp_sci_32</td>
</tr>
<tr>
<td>PSR</td>
<td>psr</td>
</tr>
<tr>
<td>JPSR</td>
<td>jpsr</td>
</tr>
<tr>
<td>EPSR</td>
<td>epsr</td>
</tr>
<tr>
<td>FPSR</td>
<td>fpsr</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>udec_32</td>
</tr>
<tr>
<td>Octal</td>
<td>oct_32</td>
</tr>
<tr>
<td>Binary</td>
<td>bin_32</td>
</tr>
<tr>
<td>ASCII</td>
<td>ascii_32</td>
</tr>
<tr>
<td>Hex, no prefix</td>
<td>hex_noprefix_32</td>
</tr>
<tr>
<td>Octal, no prefix</td>
<td>oct_noprefix_32</td>
</tr>
</tbody>
</table>

### Table C-4 40-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>hex_40</td>
</tr>
<tr>
<td>Decimal</td>
<td>dec_40</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>udec_40</td>
</tr>
<tr>
<td>Octal</td>
<td>oct_40</td>
</tr>
<tr>
<td>Binary</td>
<td>bin_40</td>
</tr>
<tr>
<td>ASCII</td>
<td>ascii_40</td>
</tr>
<tr>
<td>Hex, no prefix</td>
<td>hex_noprefix_40</td>
</tr>
<tr>
<td>Octal, no prefix</td>
<td>oct_noprefix_40</td>
</tr>
</tbody>
</table>
Table C-5 64-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hexadecimal</td>
<td>hex_64</td>
</tr>
<tr>
<td>Decimal</td>
<td>dec_64</td>
</tr>
<tr>
<td>Double</td>
<td>fp_64</td>
</tr>
<tr>
<td>Scientific double</td>
<td>fp_sci_64</td>
</tr>
<tr>
<td>Unsigned decimal</td>
<td>udec_64</td>
</tr>
<tr>
<td>Octal</td>
<td>oct_64</td>
</tr>
<tr>
<td>Binary</td>
<td>bin_64</td>
</tr>
<tr>
<td>ASCII</td>
<td>ascii_64</td>
</tr>
<tr>
<td>Hex, no prefix</td>
<td>hex_noprefix_64</td>
</tr>
<tr>
<td>Octal, no prefix</td>
<td>oct_noprefix_64</td>
</tr>
</tbody>
</table>

Table C-6 80-bit data display formats

<table>
<thead>
<tr>
<th>Format description</th>
<th>Format name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw floating point</td>
<td>fp_sci_80</td>
</tr>
</tbody>
</table>
C.2 User-defined formats

Some CLI commands in AXD take a display format name as an argument. In addition to predefined formats, you can define your own formats in a .sdm (Supplementary Display Module) file. This is a text file, constructed as described in the following sections:

- SDM format guide
- SDM format reference on page C-8.

C.2.1 SDM format guide

Types are defined based on fundamental types, or composites of types.

Types can be parameterized, with the parameters acting as type-modifiers. All parameters are optional. All parameters are named, and parameters are passed in a named list of (PARAMETER=VALUE, ...).

Types that can be user-visible have:

- a user-visible name
- an optional classification, a user-visible text string that assists the debug controller when organising a number of types. If a classification is specified, a name must be specified.

C++ style // comments are allowed, indicating that the rest of the line is a comment.

Two commands are defined, INCLUDE and TYPEDEF. These commands must appear at the beginning of a line, with no white space in front of them.

Except in definitions contained within an RDI register description file, such as armperip.xml, you can include other register type definition files, using a #include structure:

```
INCLUDE "filename"  // This is a comment.
```

The TYPEDEF command creates new types. It takes optional parameters of CLASS and NAME. If a type has a name, then it is user-visible. If it does not have a name, then it is visible only in other type definitions. Examples of types are NUMERIC, FLAG, ENUM, COMPOSITE, and IEEE_FLOAT. See SDM format reference on page C-8 for the definitive list.

For example,

```
TYPEDEF tZFLAG FLAG (SET="Z", UNSET="z")  // This is a comment.
TYPEDEF tFIQ FLAG (SET="F", UNSET="f")   // So is this.
```
Type definitions of ENUM and COMPOSITE types require more information than only the type parameter list:

```c
TYPEDEF tMODE ENUM (WIDTH=5, DEFAULT="Reserved")
{
    "User"=0x10,
    "FIQ"=0x11,
    "IRQ"=0x12,
    "SVC"=0x13,
    "Abort"=0x17,
    "Undefined"=0x1b,
    "System"=0x1f
}
```

Duplicate definitions are allowed in enums, to account for partially decoded enums. For example, a type given a user-visible name:

```c
TYPEDEF tARMID (NAME="Chip ID", CLASS="ARM") ENUM (WIDTH=32)
{
    "ARM720T" = 0x41807200,
    "ARM740T" = 0x41807400,
    ...
}
```

In the case of composites, each atom is a FIELD or a SEPARATOR. A FIELD is defined as groups of bits:

```c
FIELD [hi:lo] {,[hi:lo] {...}} (NAME="<name>",
    TYPE=<type>({<params>, ...}),
    ACCESS="<access>")
```

SEPARATOR (NAME="String")

Atoms combine as follows, optionally grouped using braces to provide grouping as appropriate:

```c
TYPEDEF tPACKEDFLOAT(NAME="2x32bit float", CLASS="Floating Point")
COMPOSITE (WIDTH=64)
{
    FIELD [63:32] (NAME="High", TYPE=IEEE_FLOAT (WIDTH=32)),
    FIELD [31:0]  (NAME="Low",  TYPE=IEEE_FLOAT (WIDTH=32))
}
```

```c
TYPEDEF tPACKEDQ15 (NAME="2xQ-15-format", CLASS="DSP")  COMPOSITE (WIDTH=32)
{
    FIELD [31:16] (NAME="High", TYPE=QFORMAT (N=1,M=15)),
    FIELD [15:0]  (NAME="Low",  TYPE=QFORMAT (N=1,M=15))
}
```

```c
TYPEDEF tPSR (NAME="PSR", CLASS="ARM") COMPOSITE (WIDTH=32)
{
```
GROUP (NAME="Flag bits")
{
    FIELD [31] (NAME="Zero Flag", TYPE=tZFLAG, ACCESS="RW"),
    FIELD [30] (NAME="Negative Flag", TYPE=tNFLAG, ACCESS="RW"),
    FIELD [29] (NAME="Carry Flag", TYPE=tCFLAG, ACCESS="RW"),
    FIELD [28] (NAME="Overflow Flag", TYPE=tVFLAG, ACCESS="RW")
},
FIELD [27:8] (TYPE=RESERVED (WIDTH=30), ACCESS="0"),
GROUP (NAME="Mode bits")
{
    FIELD [7] (NAME="Thumb bit", TYPE=tTHUMB, ACCESS="RW"),
    FIELD [6] (NAME="IRQ bit", TYPE=tIRQ, ACCESS="RW"),
    FIELD [5] (NAME="FIQ bit", TYPE=tFIQ, ACCESS="RW"),
    SEPARATOR (TEXTNAME="_")
    FIELD [4:0] (NAME="Mode", TYPE=tMODE, ACCESS="RW")
}

The access parameter is interpreted as follows:

Table C-7 Interpretation of access parameter

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Readable</td>
</tr>
<tr>
<td>W</td>
<td>Writable</td>
</tr>
<tr>
<td>V</td>
<td>Reserved (write as read)</td>
</tr>
<tr>
<td>Z</td>
<td>Write as zero (read undefined)</td>
</tr>
<tr>
<td>0</td>
<td>Always 0</td>
</tr>
<tr>
<td>1</td>
<td>Always 1</td>
</tr>
<tr>
<td>U</td>
<td>Undefined</td>
</tr>
<tr>
<td>X</td>
<td>Not readable, but caching any written values is permitted and useful</td>
</tr>
<tr>
<td>N</td>
<td>Not cacheable (otherwise treated as cacheable)</td>
</tr>
</tbody>
</table>
C.2.2 SDM format reference

Typedef are constructed using the TYPEDEF type, described in Table C-8.

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPEDEF RDIName</td>
<td>-</td>
<td>-</td>
<td>RDIName = a unique name to define the type.</td>
</tr>
<tr>
<td>(NAME, CLASS)</td>
<td></td>
<td></td>
<td>NAME = “context name”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CLASS = “context group”.</td>
</tr>
</tbody>
</table>

Fields are constructed using the FIELD type, described in Table C-9.

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>(NAME, TYPE, ACCESS)</td>
<td></td>
<td></td>
<td>TYPE = any predefined TYPEDEF or TYPEDEF already seen in current SDM text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ACCESS = “access modifier” (default = “RW”).</td>
</tr>
</tbody>
</table>
The fundamental types are described in Table C-10.

**Table C-10 Fundamental types, with parameters and classifications**

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMERIC (WIDTH, MIN, MAX, DEFAULT, PREFIX, PREPAD, PRINTF, TOOLTIP)</td>
<td>Numeric</td>
<td>General</td>
<td>WIDTH is in bits (in any type where it is used). Required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEFAULT = “HEX”, “DEC”, “UDEC”, “OCT”, or “BIN” (default = “HEX”).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PREFIX = “Y” or “N” (default dependent on DEFAULT).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PREPAD = “Y” or “N” (default dependent on DEFAULT).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PRINTF = any valid printf string for a numeric, for example “0x%08X” (default dependent on DEFAULT). If used, PREFIX and PREPAD are ignored.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TOOLTIP = “A useful hint to the user”.</td>
</tr>
<tr>
<td>FLAG (SET, UNSET, TOOLTIP)</td>
<td>-</td>
<td>-</td>
<td>Implied WIDTH = 1, always.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SET and UNSET are usually single character strings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TOOLTIP = “A useful hint to the user”.</td>
</tr>
<tr>
<td>ENUM (WIDTH, DEFAULT, TOOLTIP)</td>
<td>-</td>
<td>-</td>
<td>WIDTH = number of bits this enum represents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DEFAULT = “String to show when value not included in enumeration (not Selectable)”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TOOLTIP = “A useful hint to the user”.</td>
</tr>
</tbody>
</table>
Table C-10 Fundamental types, with parameters and classifications (continued)

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER (WIDTH, PRINTF, TOOLTIP)</td>
<td>Character</td>
<td>General</td>
<td>Represents a WIDTH in bits, accepted values 7,8, N*8. Represents byte host-endian array of individual characters (not a nul-terminated string). \nPRINTF = any valid printf string for a character, for example &quot;&quot;%4s&quot;&quot; (default dependent on WIDTH). \nTOOLTIP = “A useful hint to the user”.</td>
</tr>
<tr>
<td>IEEE_FLOAT (WIDTH, PRINTF, TOOLTIP)</td>
<td>IEEE Float</td>
<td>Floating point</td>
<td>WIDTH = 32 or 64, for now. \nPRINTF = any valid printf string for a float, for example “%f” (default dependent on WIDTH). \nTOOLTIP = “A useful hint to the user”.</td>
</tr>
<tr>
<td>FPA_SINGLE (PRINTF, TOOLTIP)</td>
<td>FPA Single</td>
<td>Floating point</td>
<td>WIDTH = 32, always. \nPRINTF = any valid printf string for a float, for example “%f” (default dependent on WIDTH). \nTOOLTIP = “A useful hint to the user”.</td>
</tr>
<tr>
<td>FPA_DOUBLE (PRINTF, TOOLTIP)</td>
<td>FPA Double</td>
<td>Floating point</td>
<td>WIDTH = 64, always. \nPRINTF = any valid printf string for a float, for example “%f” (default dependent on WIDTH). \nTOOLTIP = “A useful hint to the user”.</td>
</tr>
</tbody>
</table>
Composite types are constructed using the composite type, described in Table C-11.

### Table C-11 Composite type

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPOSITE (WIDTH)</td>
<td>-</td>
<td>-</td>
<td>( \text{WIDTH} = \text{number of bits expected in data.} )</td>
</tr>
</tbody>
</table>

Group types are constructed using the group type, described in Table C-12 and only visible in a dialog.

### Table C-12 Group type

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>GROUP (NAME)</td>
<td>-</td>
<td>-</td>
<td>( \text{NAME} = \text{“Group box name”.} )</td>
</tr>
</tbody>
</table>
Reserved types are constructed using the Reserved type, described in Table C-13.

**Table C-13 Reserved type**

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESERVED (WIDTH, NAME, GUINAME, TEXTNAME)</td>
<td>-</td>
<td>-</td>
<td>WIDTH = number of bits expected in data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NAME = “Text to appear”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GUINAME = “Text to appear in GUI”. Overrides NAME.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TEXTNAME = “Text to appear in monitor”. Overrides NAME.</td>
</tr>
</tbody>
</table>

Separators contain no data and are constructed using the Separator type, described in Table C-14.

**Table C-14 Separator type**

<table>
<thead>
<tr>
<th>Type (param, param, ...)</th>
<th>Name</th>
<th>Classification</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEPARATOR (NAME, GUINAME, TEXTNAME)</td>
<td>-</td>
<td>-</td>
<td>NAME = “Text to appear”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If NAME = “NEWLINE” the dialog box forces a new line of controls from this point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GUINAME = “Text to appear in GUI”. Overrides NAME.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TEXTNAME = “Text to appear in monitor”. Overrides NAME.</td>
</tr>
</tbody>
</table>
Appendix D
Using the Flash Downloader

This appendix describes the Flash downloader utility provided with RealView Developer Suite. It contains the following sections:

- About the Flash downloader on page D-2
- Using the Flash downloader from AXD on page D-4
- Using the Flash downloader from armsd on page D-5
- Setting the IP address of a PID board on page D-6.
D.1 About the Flash downloader

The Flash downloader is a simple Flash utility that you can use to write a binary file to the Flash memory on an ARM Integrator board, or an ARM Development (PID) board. You can use the Flash downloader from the ARM Extended Debugger (AXD) and the ARM Symbolic Debugger (armsd).

The Flash downloader executes on the target board. When you invoke the Flash downloader from within a debugger, the debugger downloads the Flash downloader into RAM on the target board. The Flash downloader executes, and uses semihosting to fetch the code to program into Flash. The downloaded file must be in plain binary format. See the RealView Compilation Tools v2.1 Linker and Utilities Guide for information on converting an ELF format file to plain binary.

The Flash downloader requires either:
- Multi-ICE®
- Angel, running from RAM.

D.1.1 Integrator board version

The default Integrator version of the Flash downloader is supplied as a binary in install_directory\bin\flash.li. This can be used to program standard CFI-type Flash devices, for example the Intel DT28F320 and similar, as fitted to the ARM Integrator board.

Note
The Integrator version of the Flash downloader works only with the ARM Integrator board.

The ARM Integrator board cannot work in big-endian mode. A dummy flash.bi file is installed that issues a warning if you attempt to use it.

Setting the Integrator board configuration switches

The switch settings on the Integrator board select whether the default image, the boot monitor, or a user image is run on reset.

The following sequence works for downloading to most Integrator boards:

1. Set switch 1 to on.
   See the manuals provided with the Integrator board for more details on settings.
2. Turn the board power off then back on.
3. Start AXD and use the Flash downloader.

4. Set switch 1 to off.

5. Turn the board power off then back on to run the downloaded image.

If you load and run an image that does not do ROM/RAM remapping, subsequent attempts to load or run any other image fail with an undefined instruction error. Use the boot monitor in ROM on the Integrator board and a terminal emulator to clear the Flash.

D.1.2 PID board version

Big-endian and little-endian versions of the Flash downloader for the ARM Development (PID) board are supplied in:

- `install_directory\bin\flashpid.li`
- `install_directory\bin\flashpid.bi`.

To use the PID version of the little-endian Flash downloader from AXD, rename `flash.li` to `flash_Integrator.li` (or similar), and rename `flashpid.li` to `flash.li`.

To use the PID version of the big-endian Flash downloader from AXD, rename `flash.bi` to `flash_dummy.bi` (or similar), and rename `flashpid.bi` to `flash.bi`.

Note

The PID versions of the Flash downloader fail if they do not recognize the Flash memory being used. The PID versions of the Flash downloader recognize the two Flash devices supported by the ARM Development (PID) board, the ATMEL AT29C040A (4 Mbit, 8-bit) and AT29C1024 (1 Mbit, 16-bit) Flash devices.
D.2 Using the Flash downloader from AXD

Follow these steps to use the Flash downloader from AXD:

1. Select **Flash Download…** from the **File** menu. The Flash DownLoad dialog is displayed (Figure D-1).

2. Specify the input information or click **Browse** to select a binary file to download. You can either use the default block, image, and address values or enter new values:
   - If you do not enter any loader information, the downloader uses the default values:
     - **Image number**: 128
     - **Block number**: 0
     - **Image base**: 0x24000000
   - If you require different values than the defaults, enter the input information in the format:
     \[a<\text{address}> |or| b<\text{block_no}>] i<\text{image_no}> \text{pathname}
     
     For example:
     \[b5\ 15\ \text{my_image}\]

     **Note**

     If the pathname to the binary file contains spaces you must enclose the pathname in quotes.

3. Click **OK**. The Flash downloader reads the binary file and displays the download settings in the Console processor view. You can edit the settings if required.

4. Edit the settings, if required, or press Enter. The Console view displays a message when the Flash is written.
D.3 Using the Flash downloader from armsd

--- Note ---
This section applies only if you are targeting Angel or EmbeddedICE. armsd does not support Multi-ICE.

---

To use the Flash downloader from the command line (assuming that you have a serial/parallel connection) write a batch file containing this command:

```
armsd -adp -port s=1,p=1 -line 38400 -exec flash ROMname
```

where:

- **flash** Is the name of the Flash downloader. By default this is:
  
  `install_directory\bin\flash.li` for the ARM Integrator board.

--- Note ---

If you want to use the Flash downloader for the ARM Development (PID) board, you must specify the actual file name as a parameter to armsd using, for example:

```
armsd -adp -port s=1,p=1 -line 38400 -exec flashpid.li ROMname
```

---

- **ROMname** Is the name of the binary file that you want to be programmed into Flash memory.

--- Note ---

If the pathname to the binary file contains spaces you must enclose the pathname in quotes.

---

Execute the batch file to download to Flash. Enter the address to start writing from when prompted to do so.
D.4 Setting the IP address of a PID board

If you are using the Angel Ethernet Kit with an ARM Development (PID) board, you can use the Flash downloader program to override the default IP address and net mask used by Angel for Ethernet communication:

- From AXD, select the Set ethernet address button in the Flash DownLoad dialog (see Figure D-1 on page D-4).
- From armsd, pass the Flash download program the argument -e. The program prompts for the IP address and net mask.

Note
The Ethernet option is not applicable to the ARM Integrator board, and is ignored.
Appendix E
Using the ARM Profiler

This chapter describes the ARM Profiler utility provided with RealView Developer Suite. It contains the following sections:

- About the ARM profiler on page E-2
- Profiler command-line options on page E-3
- Sample output on page E-4.
E.1 About the ARM profiler

The ARM profiler, armprof, displays an execution profile of a program from a profile data file generated by an ARM debugger.

--- Note

The ARM profiler is useful only with simple images compiled to the base ATPCS standard. It does not provide useful information if, for example, you are using scatter-loading.

---

The profiler displays one of two types of execution profile depending on the amount of information present in the profile data:

- If only pc-sampling information is present, the profiler can display only a flat profile giving the percentage time spent in each function itself, excluding the time spent in any of its children.

- If function call count information is present, the profiler can display a callgraph profile that shows approximations of the time spent in each function, the time accounted for by calls to all children of each function, and the time allocated to calls from different parents.
E.2 Profiler command-line options

A number of options are available to control the format and amount of detail present in the profiler output. The command syntax is as follows:

```
```

where:

- **-parent**
  
  This option displays information about the parents of each function in the profile listing. This gives approximate information about how much time is spent in each function servicing calls from each of its parents.

- **-noparent**
  
  This option turns off the parent listing.

- **-child**
  
  This option displays information about the children of each function. The profiler displays the approximate amount of time spent by each child performing services on behalf of the parent.

- **-nochild**
  
  This option turns off the child listing.

- **-sort options**
  
  This option sorts the profile information using one of the following options:

  - `cumulative`
    
    Sorts the output by the total time spent in each function and all its children.
  
  - `self`
    
    Sorts the output by the time spent in each function (excluding the time spent in its children).
  
  - `descendants`
    
    Sorts the output by the time spent in all the children of a function but excluding time spent in the function itself.
  
  - `calls`
    
    Sorts the output by the number of calls to each function in the listing.

- **prf_file**
  
  This option specifies the file containing the profile information.

By default, child functions are listed, but not parent functions, and the output is sorted by cumulative time.

E.2.1 Example

```
armprof -parent sort.prf
```
E.3 Sample output

The profiler output is split into a number of sections, each section separated by a line. Each section gives information on a single function. In a flat profile, one with no parent or child function information, each section is a single line.

The following shows sample sections for functions called `insert_sort` and `strcmp`.

<table>
<thead>
<tr>
<th>Name</th>
<th>cum%</th>
<th>self%</th>
<th>desc%</th>
<th>calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>main</td>
<td>17.69%</td>
<td>60.06%</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td><code>insert_sort</code></td>
<td>77.76%</td>
<td>17.69%</td>
<td>60.06%</td>
<td>1</td>
</tr>
<tr>
<td><code>strcmp</code></td>
<td>60.06%</td>
<td>0.00%</td>
<td></td>
<td>243432</td>
</tr>
<tr>
<td><code>qs_string_compare</code></td>
<td>3.21%</td>
<td>0.00%</td>
<td></td>
<td>13021</td>
</tr>
<tr>
<td><code>shell_sort</code></td>
<td>3.46%</td>
<td>0.00%</td>
<td></td>
<td>14059</td>
</tr>
<tr>
<td><code>insert_sort</code></td>
<td>60.06%</td>
<td>0.00%</td>
<td></td>
<td>243432</td>
</tr>
<tr>
<td><code>strcmp</code></td>
<td>66.75%</td>
<td>66.75%</td>
<td>0.00%</td>
<td>270512</td>
</tr>
</tbody>
</table>


The items in this glossary are listed in alphabetical order, with any symbols and numerics appearing at the end.

**Action Point**  
A breakpoint or watchpoint (see *Breakpoint* and *Watchpoint*), at which a specified debugging action occurs. The default action is to stop execution. Another typical action you can specify is to record a diagnostic message in a log file and continue execution.

**ADP**  
See *Angel Debug Protocol*.

**Angel**  
Angel is a debug monitor that enables you to develop and debug applications running on ARM-based hardware. Angel can debug applications running in either *ARM state* or *Thumb state*.

**Angel Debug Protocol**  
Angel uses a debugging protocol called the *Angel Debug Protocol* (ADP) to communicate between the host system and the target system. ADP supports multiple channels and provides an error-correcting communications protocol.

**ARM eXtended Debugger**  
The *ARM eXtended Debugger* (AXD) is the latest debugger software from ARM that enables you to make use of a debug agent to examine and control the execution of software running on a debug target. AXD is supplied in both Windows and UNIX versions.
ARM state  A processor that is executing ARM (32-bit) instructions is operating in ARM state (see also Jazelle state and Thumb state).

ARM symbolic debugger  ARM Symbolic Debugger (armsd) is an interactive source-level debugger providing high-level debugging support for languages such as C, and low-level support for assembly language. It is a command-line debugger that runs on all supported platforms.

armsd  See ARM Symbolic Debugger.

ATPCS  ARM/Thumb Procedure Call Standard.

AXD  See ARM eXtended Debugger.

Big-endian  Memory organization where the least significant byte of a word is at a higher address than the most significant byte. See also Little-endian.

Breakpoint  A location in the image. If execution reaches this location, the debugger halts execution of the image. See also Watchpoint.

ByteCode  ByteCode format specifies the use of Jazelle bytecodes which are platform-independent instructions, generated by a compiler, and run on the Java Virtual Machine (JVM).

Class  A C++ class involved in the image.

Class variables/functions  Variables or functions with scope limited to the current class. (See also Local variables/functions and Global variables/functions.)

CLI  See Command-line Interface.

Command-line Interface  You can operate any ARM debugger by issuing commands in response to command-line prompts. This is the only way of operating armsd, but AXD offers a graphical user interface in addition. A command-line interface is particularly useful when you need to run the same sequence of commands repeatedly. You can store the commands in a file and submit that file to the command-line interface of the debugger.

Context  The information stored in a block of registers on entry to a subroutine, and held there until needed for restoring the information on exit from the subroutine.

Context menu  See Pop-up menu.

Control Bars  A control bar is a special window which is usually aligned along one side of a frame window. Control bars can be considered containers for other windows and controls or as a drawing area for the application.

Coprocessor  An additional processor used for certain operations. Usually used for floating-point calculations, signal processing, or memory management.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPSR</td>
<td>Current Program Status Register. See <em>Program Status Register</em>.</td>
</tr>
<tr>
<td>DCC</td>
<td>See <em>Debug Communications Channel</em>.</td>
</tr>
<tr>
<td>Debug Communications Channel</td>
<td>A debug communications channel enables data to be passed between the target and the host debugger using the JTAG port and an EmbeddedICE interface, without stopping the program flow or entering debug state.</td>
</tr>
<tr>
<td>Debugger</td>
<td>An application that monitors and controls the execution of a second application. Usually used to find errors in the application program flow.</td>
</tr>
<tr>
<td>Deprecated</td>
<td>A deprecated option or feature is one that you are strongly discouraged from using. Deprecated options and features will not be supported in future versions of the product.</td>
</tr>
<tr>
<td>DLL</td>
<td>See <em>Dynamic Linked Library</em>.</td>
</tr>
<tr>
<td>Dockable Windows</td>
<td>A dockable window is positioned and sized automatically when you open it or dock it, with any other docked windows already on the screen being resized if necessary. You can change the size of a docked window, or undock it and enable it to float free on the desktop.</td>
</tr>
<tr>
<td>Double word</td>
<td>A 64-bit unit of information. Contents are taken as being an unsigned integer unless otherwise stated.</td>
</tr>
<tr>
<td>DWARF</td>
<td>Debug With Arbitrary Record Format.</td>
</tr>
<tr>
<td>Dynamic Linked Library</td>
<td>A collection of programs, any of which can be called when needed by an executing program. A small program that helps a larger program communicate with a device such as a printer or keyboard is often packaged as a DLL.</td>
</tr>
<tr>
<td>ELF</td>
<td>Executable and Linking Format.</td>
</tr>
<tr>
<td>Enhanced Program Status Register</td>
<td>See <em>Program Status Register</em>.</td>
</tr>
<tr>
<td>EPSR</td>
<td>Enhanced Program Status Register. See <em>Program Status Register</em>.</td>
</tr>
<tr>
<td>Executable image</td>
<td>See <em>Image</em>.</td>
</tr>
<tr>
<td>File</td>
<td>A disk file somehow involved in the debuggee or debugger. This is most likely to be a source file compiled/assembled into an image. However it might also be an image file or a session file.</td>
</tr>
<tr>
<td>Flash downloader</td>
<td>The Flash downloader is used to download binary images to the Flash memory of supported ARM development boards.</td>
</tr>
<tr>
<td>Floating point</td>
<td>Convention used to represent real (as opposed to integer) numeric values. Several such conventions exist, trading storage space required against numerical precision.</td>
</tr>
</tbody>
</table>
Floating point emulator
Software that emulates the action of a hardware unit dedicated to performing arithmetic operations on floating-point values.

FP
See Floating point.

FPE
See Floating Point Emulator.

Function
A C++ method or free function.

Global variables/functions
Variables or functions with global scope within the image. (See also Class variables/functions and Local variables/functions.)

Harvard architecture
A processor architecture incorporating physically separate memories and associated buses for holding instructions and data.

Halfword
A 16-bit unit of information. Contents are taken as being an unsigned integer unless otherwise stated.

Host
A computer which provides data and other services to another computer, or a computer that has applications programs installed and available for use.

ICE
In-Circuit Emulator.

Image
A file of executable code which can be loaded into memory on a target and executed by a processor there.

Jazelle
The ARM technology for Java applications that enables Jazelle-capable processors, such as the ARM926EJ-S, to execute Java bytecode directly.

Jazelle state
A processor that is executing Jazelle bytecode (8-bit) instructions is operating in Jazelle state (see also ARM state and Thumb state).

Joint Test Action Group
Many debug and programming tools use a Joint Test Action Group (JTAG) interface port to communicate with processors. For more information see IEEE Standard, Test Access Port and Boundary-Scan Architecture specification 1149.1 (JTAG).

JPSR
Jazelle Program Status Register. See Program Status Register.

JTAG
See Joint Test Action Group.

Little-endian
Memory organization where the least significant byte of a word is at a lower address than the most significant byte. See also Big-endian.

Local variables/functions
Variables or functions with local scope. (See also Class variables/functions and Global variables/functions.)
MDI  
See Multiple Document Interface.

Memory management unit  
Hardware that controls caches and access permissions to blocks of memory, and translates virtual to physical addresses.

MMU  
See Memory Management Unit.

Multi-ICE  
Multi-processor based JTAG debug tool for embedded systems. ARM registered trademark.

Multiple Document Interface  
A feature of MS Windows enabling the simultaneous display of a number of windows.

von Neumann architecture  
A processor architecture that does not distinguish between memory that holds instructions and memory that holds data.

PID  
A platform-independent development board designed and supplied by ARM Limited.

Pop-up menu  
Also known as Context menu. A menu that is displayed temporarily, offering items relevant to your current situation. Obtainable in most RealView Developer Suite windows by right-clicking with the mouse pointer inside the window. In some windows the pop-up menu can vary according to the line the mouse pointer is on and the tabbed page that is currently selected.

Processor  
An actual processor, real or simulated running on the target. A processor always has at least one context of execution.

Processor Status Register  
See Program Status Register.

Profiling  
Accumulation of statistics during execution of a program being debugged, to measure performance or to determine critical areas of code.

Call-graph profiling provides great detail but slows execution significantly. Flat profiling provides simpler statistics with less impact on execution speed.

For both types of profiling you can specify the time interval between statistics-collecting operations.

Program image  
See Image.

Program Status Register  
Program Status Register (PSR), containing some information about the current program and some information about the current processor.

Is also referred to as Current PSR (CPSR), to emphasize the distinction between it and the Saved PSR (SPSR). The SPSR holds the value the PSR had when the current function was called, and which is restored when control is returned.
An Enhanced Program Status Register (EPSR) contains an additional bit (the Q bit, signifying saturation) used by some ARM processors, including the ARM9E.

A Jazelle Program Status Register (JPSR) contains an additional bit (the J bit, signifying Jazelle state) used by some ARM processors, including the ARM9EJ-S.

PSR

See Program Status Register.

RDI

See Remote Debug Interface.

RealView ARMulator ISS

RealView ARMulator ISS is an instruction set simulator. It is a collection of modules that simulate the instruction sets and architecture of various ARM processors.

RealView Developer Suite

A suite of applications, together with supporting documentation and examples, that enable you to write and debug applications for the ARM family of RISC processors.

Register

A processor register.

Remote A

A communications protocol used, for example, between debugger software such as ARM eXtended Debugger (AXD) and a debug agent such as Angel.

Remote Debug Interface

The Remote Debug Interface (RDI) is an ARM standard procedural interface between a debugger and the debug agent. RDI gives the debugger a uniform way to communicate with:

- a debug agent running on the host (for example, RealView ARMulator ISS)
- a debug monitor running on ARM-based hardware accessed through a communication link (for example, Angel)
- a debug agent controlling an ARM processor through hardware debug support (for example, Multi-ICE).

RVDS

See RealView Developer Suite

RVISS

See RealView ARMulator ISS.

Saved Program Status Register

See Program Status Register.

Scope

The range within which it is valid to access such items as a variable or a function. See also Class, Global and Local variables/functions.

Script

A file specifying a sequence of debugger commands that you can submit to the command-line interface using the obey command. This saves you from having to enter the commands individually, and is particularly helpful when you need to issue a sequence of commands repeatedly.
SDT

See Software Development Toolkit.

Semihosting

A mechanism whereby the target communicates I/O requests made in the application code to the host system, rather than attempting to support the I/O itself.

Source File

A file which is processed as part of the image building process. Source files are associated with images.

SPSR

Saved Program Status Register. See Program Status Register.

Stack backtracing

Examining the list of currently active subroutines in a halted executing program to help establish how current settings have arisen.

Tabbed

A GUI mechanism to overlay several pages in a single window, enabling page selection by clicking on a named tab.

Target

The target processor (real or simulated), on which the target application is running. The fundamental object in any debugging session. The basis of the debugging system. The environment in which the target software runs. It is essentially a collection of real or simulated processors.

Thumb state

A processor that is executing Thumb (16-bit) instructions is operating in Thumb state (see also ARM state and Jazelle state).

Tracing

Recording diagnostic messages in a log file, to show the frequency and order of execution of parts of the image. The text strings recorded are those that you specify when defining a breakpoint or watchpoint. See Breakpoint and Watchpoint. See also Stack backtracing.

Vector Floating Point

A standard for floating-point coprocessors where several data values can be processed by a single instruction.

VFP

See Vector Floating Point.

Views

Windows showing the data associated with a particular debugger/target object. These might consist of a single, simple GUI control such as an edit field or a more complex multi-control dialog implemented as an ActiveX.

The Processor Views menu enables you to select views associated with a specific processor, while the System Views menu enables you to select system-wide views.

Watchpoint

A location in the image that is monitored. If the value stored there changes, the debugger halts execution of the image. See also Breakpoint.

Word

A 32-bit unit of information. Contents are taken as being an unsigned integer unless otherwise stated.
Index

The items in this index are listed in alphabetical order, with symbols and numerics appearing at the end. The references given are to page numbers.

A

About this book viii
Accelerator keys 2-14
Access protection, in
   AXD expressions 4-5
Accessing
   host peripherals 1-9
   online help 1-10, 9-22
Address of DCC semihosting SWI handler 4-11
Addresses, entering 4-12
Agent, debug 1-2
Alias armsd command 9-10
Analysis of processor time 4-27
Angel 1-9
   configuring 5-92
   Debug Protocol (ADP) 2-8, 7-4
Applying for a software license 2-2
Arguments armsd command 9-11
Arguments, command-line 5-52, 7-3
ARM
   disassembly mode 5-79
   ARM ADI 1-9
   ARM Agilent Debug Interface 1-9
   ARM core 1-8
   ARM debuggers
      armsd 7-2
      AXD 2-1
      armprof E-2
      armsd 7-1
         address constants 8-6
         armsd.ini file 7-2
         backtrace 9-3
         big-endian memory 7-3
         breakpoints 8-4, 9-2
         character constants 8-6
         clock speed 7-4
         command-line arguments for
debugee 9-25
         command-line options 7-3
         communications channel 9-46
         configuring 7-2
         constants 8-6
         context of variables 8-2
         coprocessor register display 9-4
         displaydesc argument 9-15
         duration of simulation 8-7
         echoing commands 8-7
         EmbeddedICE commands 9-47
         EmbeddedICE variables 8-10
         execution options 7-4
         expressions as arguments 8-5
         flash downloader D-5
         floating point emulator 7-3
         formatting output 8-11
         getting started 8-1
         help on 7-3
         high-level language variables 8-2
         high-level languages 9-23
         initialization file 7-2
         input from named file 7-4
         internal variables 8-10
         invoking 7-3
         let command 8-11
         list of variables 8-7
         little-endian memory 7-3
         loading debug information 7-4
         low-level debugging 8-13, 9-3
Index

low-level symbols 8-13, 8-15
Multi-ICE variables 8-10
multi-statement lines 9-45
names of variables 8-2
operating system commands 9-5
output to file 7-4
overview 7-2
predefined symbols 8-14
print command 8-11
procedure names 8-4
processor type 7-3
profiling data 9-5
program line numbers 8-4
program locations 8-4
prompts 9-5, 9-6
RealView ARMulator ISS 7-4
remote debugging using ADP 7-4
search paths 7-4
setting the psr 8-15
source-level objects 8-2
starting debugee 9-3
starting debugger 7-3
statements within a line 8-4
stopping debugee 9-2
stopping debugger 9-5, 9-35
subscripts, pointers and arrays 8-6
symbols 7-4
syntax overview 7-3
variables 8-7
watchpoints 9-3
armsd commands 9-7, A-2
alias 9-5, 9-10
arguments 9-2, 9-11
backtrace 9-3, 9-11
break 9-2, 9-12
call 9-2, 9-13
ccin 9-46
ccout 9-46
comment 9-5, 9-9
compared with AXD A-2
context 9-3, 9-16
coproc 9-4, 9-13
cregdef 9-4, 9-16
cregistres 9-4, 9-16
cwrite 9-4, 9-17
examine 9-4, 9-17
find 9-4, 9-18
fregisters 9-4, 9-19
getfile 9-3, 9-21
go 9-3, 9-21
help 9-5, 9-22
in 9-3, 9-22
istep 9-3, 9-22
language 9-3, 9-23
let 8-15, 9-24
list 9-4, 9-27
listconfig 9-47
load 9-3, 9-28
loadagent 9-47
loadconfig 9-47
localvar 9-28
log 9-5, 9-30
lsym 9-4, 9-31
obey 9-5, 9-31
out 9-3, 9-32
pause 9-5, 9-6, 9-32
print 9-5, 9-33
proclear 9-5, 9-6, 9-33
proff 9-5, 9-6, 9-33
profon 9-5, 9-6, 9-34
profwrite 9-5, 9-34
putfile 9-3, 9-35
quit 9-5, 9-35
readsym 9-36
registers 9-4, 9-36
reload 9-3, 9-37
selectconfig 9-48
step 9-3, 9-39
symbols 9-40
type 9-5, 9-41
unbreak 9-3, 9-42
unwatch 9-3, 9-42
variable 9-2, 9-43
watch 9-3, 9-43
where 9-3, 9-44
while 9-45
! 9-5, 9-9
ARMulate.cnf file 2-6
Array expansion 2-10, 5-83
ASCII
format 4-19
search string 5-17
ASIC 1-8
Asm, specifying in CLI 6-9
Assembly code interleaved with C++ 5-44
Audience, intended viii

AXD
CLI window 6-2
closing down 2-5, 5-15
command-line operation 5-64, 6-2
commands 6-13
configuring 5-79
desktop 5-2
displays 2-9
execute menu 5-75
file menu 5-6
flash download 5-11
help menu 5-101
menu bar 5-2
menus 2-12, 5-2
options menu 5-79
processor views menu 5-18
search menu 5-16
starting 2-3
status bar 5-5, 5-97
system views menu 5-48
toolbars 5-3
tools 2-14
window menu 5-98
AXD CLI commands 6-13, A-2
backtrace 6-13
break 6-14
cclasses 6-16
cfunctions 6-16
classes 6-17
clear 6-17
clearbreak 6-17
clearstat 6-18
clearwatch 6-19
comment 6-19
compared with armsd A-2
context 6-20
convariables 6-21
cvariables 6-22
dbginternals 6-22
disable 6-23
echo 6-24
examine 6-24
files 6-25
fillmem 6-25
findstring 6-26
findvalue 6-27
format 6-28
functions 6-29
getfile 6-29
Index

A

go 6-29
help 6-29
images 6-30
imgproperties 6-30
importformat 6-31
let 6-31
list 6-31
listformat 6-32
load 6-32
loadbinary 6-33
loadsession 6-34
loadsymbols 6-34
log 6-34
lowlevel 6-35
memory 6-35
obey 6-36
parse 6-36
print 6-36
processors 6-37
procproperties 6-37
putfile 6-37
quitdebugger 6-38
readsyms 6-38
record 6-38
regbanks 6-38
registers 6-39
reload 6-40
run 6-40
runtopos 6-41
savebinary 6-42
savesession 6-43
setaci 6-43
setbreakprops 6-44
setimgprop 6-45
setmem 6-45
setpc 6-46
setproc 6-46
setproccprop 6-47
setreg 6-48
setsourcedir 6-49
setwatch 6-50
setwatchprops 6-51
source 6-52
sourcedir 6-53
stackentries 6-53
stackin 6-54
stackout 6-54
statistics 6-54
step 6-55

B

Backtrace
AXD view 5-29
Backtrace armsd command 9-11
Backtrace AXD command 6-13
Base classes
in AXD 4-4
Binary format 4-19
Books, related x
Book, about this viii
Break armsd command 9-12
Break AXD command 6-14
Breakpoints
deleting 5-78
identifying in CLI 6-9
in armsd 8-4, 9-2

C

Call armsd command 9-13
Call graph, profiling E-2
Cclasses AXD command 6-16
C-cycles 5-73
Cfunctions AXD command 6-16
Changing values of variables
in AXD 5-26
Class
page in Control view 5-50
Classes AXD command 6-17
Class, identifying in CLI 6-9
Clear AXD command 6-17
Clearbreak AXD command 6-17, 6-18
Clearwatch AXD command 6-19
Closing
armsd 9-35
AXD 2-5
Code, ARM/Thumb/Jazelle 5-79, 6-6
Command syntax
profiler E-3
Command-line arguments for debugee
in armsd 7-3
in AXD 5-52
Command-line arguments for debugger
armsd 7-3
Command-line operation
definitions 6-9
of armsd 9-7, A-2
of AXD 5-64, 6-2, A-2
predefined parameters 6-6
Commands
AXD and armsd compared A-2
echoing 8-7
in armsd 9-1
in AXD 6-13
that use lists 6-5
Comment AXD command 6-19
Comments
in script files 9-9
on ADS xii
on documentation xii
Comms channel 4-11, 5-37, 5-92, 5-95,
5-96, 6-10, 9-46
AXD view 5-37
Index

Concepts 1-2
Configuring
   armds debugger 7-2
   ARMulator 5-87
   AXD debugger 5-79
   debugger target 5-86
   Multi-ICE 5-92
   RealView ARMulator ISS 2-6
   Remote_A 5-92
Console
   AXD view 5-39
Constants 8-6
Context armds command 9-16
Context AXD command 6-20
Context of execution 5-77
Context of program 1-3, 6-54, 9-22, 9-32
Context, identifying in CLI 6-9
Control AXD view 5-49
Convariables AXD command 6-21
Coproc armds command 9-13
Coprocessor register
   changing contents 9-17
descriptions B-1
displaying contents 9-16
Cregdef armds command 9-16
Cregdef AXD command 6-22
Cwrite armds command 9-17
Cycle counts 5-73
C++
   interleaved with assembly code 5-44

D

Data entry formats 4-12, 4-16
Dbginternals AXD command 6-22
Debug
   agent 1-2
   comms channel SWI handler 4-11
   comms channel viewing 4-11, 5-37, 5-92, 5-95, 5-96, 6-10, 9-46
   log 5-63
   monitor 1-9
   protocol (ADP) 2-8, 7-4
   session, restoring 5-12
   symbols 5-8, 5-29
   typical setup 1-6
   Debugger internals
   AXD view 5-68
   Debuggers
   closing down 2-5, 9-35
   starting program execution 5-75, 9-21
   starting up 2-3, 7-3
   Decimal 4-12
   Decimal format 4-18
   Deleting breakpoints
   in armds 9-42
   in AXD 5-58, 5-78
   Demonstration programs 3-2
   Desktop
   AXD 5-2
   Development board 1-6
   Disassemble AXD command 5-23
   Disassemble
   AXD view 5-40
   mode 5-42, 5-79
   sequence break 5-45
   Display formats 4-16
   Displaying interleaved code 5-44
   Documentation feedback xii
   Download
   flash D-2

E

Echo AXD command 6-24
Editing breakpoints
   in AXD 5-58
EmbeddedICE 1-8
Enquiries xii
Entering addresses 4-12
E-PSR, setting, in AXD 5-20
Examine armds command 9-17
Examine AXD command 6-24
Examining
   memory 5-31
   source files 5-9, 5-16, 5-44
   variables 5-26
Examples 3-2
   breakpoint setting 3-4
   changing memory contents 3-16
   examining memory 3-14
   examining registers 3-12
   examining variables 3-8
   watchdog setting 3-6
Exceptions intercepted 5-95
Execute AXD menu 5-75
Execution
   context 5-77
   profile E-2
   starting 5-75, 9-21
   stopping 5-76
   stopping and stepping 4-2
Exiting debugger 2-5, 5-15, 9-35
Expansion of arrays 2-10, 5-83
Expressions
   as arguments 8-5
guidelines for using 4-4
   sample 4-5
   specifying 4-4
   watching, in AXD 5-57

F

Feedback
   on documentation xii
   on RVDS xii
File AXD menu 5-6
Files
   armds.ini 7-2
   ARMsate.cnf 2-6
   AXD command 6-25
   identifying, in CLI 6-9
   page in Control view 5-50
   recently-opened 5-14
   Fillmem AXD command 6-25
   Find armds command 9-18
   Findstring AXD command 6-26
   Findvalue AXD command 6-27
   Flash download
      override IP address and net mask D-6
   Flash downloader D-2
Floating point
   emulator, in armds 7-3
   emulator, in RealView ARMulator ISS 5-88
   formats 4-20
Floating-point
   returning values from armds 8-8
   vector 5-70, 8-9

Index-4
Index

Format
ASCII 4-19
AXD command 6-28
binary 4-19
decimal 4-18
display 4-16, 5-27, 5-79
floating point 4-20
for data entry 4-16
hexadecimal 4-18, 4-26
octal 4-18, 4-26
of armsd output 8-11
printf 4-19
Q-format 4-24
registers 4-21
scientific 4-20
specifying in CLI 6-9
string 4-25
submenus 4-16
U decimal 4-25
Fpregisters armsd command 9-19
Function call count, profiling E-2
Function calls to RDI 5-63
Functions
AXD command 6-29
stepping into/out of 5-76, 6-7

G
Getfile armsd command 9-21
Getfile AXD command 6-29
Glossary Glossary-1
Go armsd command 9-21
Go AXD command 6-29

H
Halfwords, reading/writing in armsd 9-25
Help armsd command 9-22
Help AXD command 6-29
Help, online 1-10, 5-101, 9-22
Hexadecimal 4-12
format 4-18, 4-26
search string 5-17
High-level languages and armsd 8-2
High-level symbols 4-10, 4-12
Host peripherals, accessing 1-9

I
I-cycles 5-73
Image
loading 5-7, 6-32, 9-28
page in Control view 5-49
reloading 5-9, 6-40, 9-37
stepping through 5-76, 6-55, 9-39
stopping execution of 5-76
Images AXD command 6-30
Images, recently-opened 5-14
Image, identifying in CLI 6-9
Imgproperties AXD command 6-30
Importformat AXD command 6-31
In armsd command 9-22
Indicators
# 6-4, 8-14, 9-7
$ 9-7
+ 6-4
- 4-10, 6-4, 9-7
^ 8-13, 9-7
| 6-4

Instr, specifying in CLI 6-10
Intended audience viii
Intercepted exceptions 5-95
Interfacing with targets 1-5
Interleaving C++ and assembly code 5-44
Internal variables 5-68, 8-7
IPvariable, specifying in CLI 6-10
Istep armsd command 9-22

J
Jazelle
disassembly mode 5-79
J-PSR, setting, in AXD 5-20
JTAG 1-8

K
Keyboard shortcuts 2-14

L
Language armsd command 9-23
Languages
high-level and armsd 8-2
Let
armsd command 8-11
AXD command 6-31
Let armsd command 9-24
License application 2-2
License-managed software 2-2
Line number 4-12
Line numbers
in programs 8-4
Line, stepping to next 5-76, 6-55
List armsd command 9-27
List AXD command 6-31
Listformat AXD command 6-32
Lists in AXD commands 6-5
Load armsd command 9-28
Load AXD command 6-32
Load session 5-12
Loadbinary AXD command 6-33
Loading
an image 5-7, 6-32, 9-28
debg symbols 5-8
memory from file 5-10
Loadsession AXD command 6-34
Loadsymbols AXD command 6-34
Localvar armsd command 9-28
Log armsd command 9-30
Log AXD command 6-34
Log messages 5-63
Logging CLI input and output 5-65
Lowlevel AXD command 6-35
Low-level debugging in armsd 8-13
Low-level symbols 4-10, 4-12
AXD view 5-35
Lsym armsd command 9-31

M
Member functions, in AXD expressions 4-5
Memory
AXD command 6-35
AXD view 5-31
loading from file 5-10
modifying 3-16
reading/writing, in armsd 9-25
reading/writing, in AXD 5-35
saving to file 5-10
viewing 3-14
word size for display in CLI 6-10
Menu bar
AXD 5-2
Menus
AXD 2-12, 5-2
AXD view-specific 2-13, 5-2
pop-up 2-13
Mode
disassembly 5-42, 5-79
stepping 5-42, 5-46
Modifying variables 5-26
Monitor, debug 1-9
Multi-ICE 1-8, 5-92

N
N-cycles 5-73

O
Obey armsd command 9-31
Obey AXD command 6-36
Octal format 4-18, 4-26
Online help 1-10, 9-22
Opening a source file 5-9
Operating system
accessing from armsd 9-9
Operators, in
AXD expressions 4-4
Options AXD menu 5-79
Out armsd command 9-32
Output AXD view 5-63
Print armsd command 8-11, 9-33
Print AXD command 6-36
Printf format 4-19
Problem solving xii
Procedure names 8-4
Procedures, tutorial 3-2
Processor time analysis 4-27
Processor Views AXD menu 5-18
Processors AXD command 6-37
Processors, identifying in CLI 6-11
Processors, simulated 1-8
Properties AXD command 6-37
Product feedback xii
Profclear armsd command 9-33
Profiler E-2
Profiling 4-27, 5-97, 9-34
interval 5-7, 5-52, 9-34
Profoffs armsd command 9-33
Profun armsd command 9-34
Profwrite armsd command 9-34
Program
context 6-54, 9-22, 9-32
demonstration 3-2
executing in armsd 9-21
line numbers 8-4
locations 8-4
reloading 5-9
stopping and stepping 4-1
Protocol, Angel Debug (ADP) 2-8, 7-4
PSR, setting
in armsd 8-15
in AXD 5-20
Publications, related x
Putfile armsd command 9-35
Putfile AXD command 6-37
R
RDI function calls 5-63
RDI (Remote Debug Interface) 1-3
Readsyms armsd command 9-36
Readsyms AXD command 6-38
RealView ARMulator ISS 1-8
configuring 5-87
floating point emulator 5-88
RealView ARMulator ISSconfiguring 2-6
Recent sessions 5-14
Recently-opened files 5-14
images 5-14
symbols files 5-14
Record AXD command 6-38
Regbanks AXD command 6-38
Regbank, identifying in CLI 6-11
Registers
adding to system view 5-21, 5-55
AXD command 6-39
AXD processor view 5-19
AXD system view 5-54
changing values of 5-20
coprocessor B-1
demonstration of viewing 3-12
formats 4-21
halt if changed 5-60
specifying in CLI 6-12
Registers armsd command 9-36
Related publications x
Reload armsd command 9-37
Reload AXD command 6-40
Reloading an image 5-9, 6-40, 9-37
Remote Debug Interface 1-3
Remote_A 1-9
configuring 5-92
Restoring a debug session 5-12
Run AXD command 6-40
Run to cursor 5-77
Running a demonstration program 3-2
Runtopos AXD command 6-41

S
Save session 5-13
Savebinary AXD command 6-42
Index

Savesession AXD command  6-43, 6-51
Saving a debug session
  Debug
    session, saving  5-13
Saving memory to file  5-10
Scope
  of variables  1-4
    specifying in CLI  6-12
S-cycles  5-73
Search AXD menu  5-16
Semihosting mode  4-11, 5-96
Session
  loading  5-12
    saving  5-13
Sessions, recent  5-14
Set watchpoint  5-78
Setaci AXD command  6-43
Setbreakprops AXD command  6-44
Setimgprop AXD command  6-45
Setmem AXD command  6-45
Setpc AXD command  6-46
Setproc AXD command  6-46
Setprocprop AXD command  6-47
Setreg AXD command  6-48
Setsourcedir AXD command  6-49
Setting up targets  2-6
Setup, typical  1-6
Setwatch AXD command  6-50
Shortcut keys  2-14
Simulation
  duration of  8-7
    of processors  1-8
Software, license-managed  2-2
Source AXD command  6-52
Source files
  examining  5-9
Source path, specifying  5-96
Sourcedir AXD command  6-53
Source...
  AXD view  5-44
stack
  broken  5-29
Stackentries AXD command  6-53
Stackin AXD command  6-54
Stackout AXD command  6-54
Starting
  armsd  7-3
  AXD  2-3
Statements within a line  8-4
Statistics  5-72
Statistics AXD command  6-54
Status bar
  in AXD  5-5, 5-97
Step armsd command  9-39
Step AXD command  6-55
Stepping
  mode  5-42, 5-46
    through an image  4-2, 6-55, 9-39
    through assembler code  4-3, 9-32, 9-39
Stepsize AXD command  6-56
Step, specifying in CLI  6-12
Stop AXD command  6-56
Stopping
  armsd  9-35
  AXD  2-5, 5-15
    execution of image  5-76
String
  format  4-25
Strings
  specifying in CLI  6-12
Structure of this book  viii
Subscripts, pointers and arrays  8-6
Symbolic debugger (armsd)  7-1
Symbols
  debug  5-8, 5-29
  files, recently-opened  5-14
  high- and low-level  4-10, 4-12
  out-of-sequence symbol  5-45
Symbols armsd command  9-40
System Views AXD menu  5-48
Target
  configuring  5-86
    interfacing with  1-5
  page in Control view  5-49
    setting up  2-6
  variables  5-70
Terminology  1-2, Glossary-1
Thumb
  breakpoint setting  5-60
  channel viewer  5-37
  disassembly mode  5-79
  Time analysis  4-27
  Toggle breakpoint  5-77
Toggle parameter, in CLI  6-12
Toggle watchpoint  5-78
Toolbar
  AXD  5-3
  Tools, AXD  2-14
Trace AXD command  6-56
Trace AXD command
  AXD  6-56
  AXD view  5-26
  changing contents of  5-26
  demonstration of viewing  3-8
  halt if changed  5-60
    in armsd  8-7
    in specific function activation  8-3
    referenced from armsd  8-2
  scope of  1-4
  target-specific  5-70
    watching, in AXD  5-23
Vector catch variable in AXD  5-95
Vector floating point (VFP)  5-70, 8-9

U
Unbreak armsd command  9-42
Unbreak AXD command  6-57
Unwatch armsd command  9-42
Unwatch AXD command  6-57
Update AXD command  6-57

V
Values, specifying in CLI  6-12
Variable armsd command  9-43
Variables
  AXD command  6-58
  AXD view  5-26
    changing contents of, in AXD  5-26
    demonstration of viewing  3-8
    halt if changed  5-60
    in armsd  8-7
    in specific function activation  8-3
    referenced from armsd  8-2
    scope of  1-4
    target-specific  5-70
      watching, in AXD  5-23
Vector catch variable in AXD  5-95
Vector floating point (VFP)  5-70, 8-9

W
Watch
  AXD command  6-59
  AXD processor view  5-23
  AXD system view  5-55
Watch armsd command  9-43
Watchpoints
Index

clearing in armsd 9-42
identifying in CLI 6-12
in AXD 3-6, 5-60, 5-78
setting 9-43
Watchpt AXD command 6-59
Where armsd command 9-44
Where AXD command 6-61
While armsd command 9-45
Who should read this book viii
Width, memory access 5-35
Window menu in AXD 5-98

Symbols
!
armsd command 9-9
# indicator 6-4, 8-14, 9-7
$ indicator 9-7
Sclock internal variable 5-70
$image_cache_enable internal variable 5-70
$rdi_log internal variable 5-69
$statistics internal variable 5-69, 8-9, 9-28
+ indicator 6-4
...... symbol 5-45
@ 4-12
@ indicator 4-10, 6-4, 9-7
^ indicator 8-13, 9-7
| armsd command 9-9
| indicator 6-4